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The future of many organizations depends on their ability to harness the power of informa-
tion technology, and good project managers continue to be in high demand. Colleges have
responded to this need by establishing courses in project management and making them
part of the information technology, management, engineering, and other curriculum. Cor-
porations are investing in continuing education to help develop effective project managers
and project teams. This text provides a much-needed framework for teaching courses in
project management, especially those that emphasize managing information technology
projects. The first five editions of this text were extremely well received by people in acade-
mia and the workplace. The Sixth Edition builds on the strengths of the previous editions
and adds new, important information and features.

It s impossible to read a newspaper, magazine, or Web page without hearing about the
impact of information technology on our society. Information is traveling faster and being
shared by more individuals than ever before. You can buy just about anything online, surf
the Web on a mobile phone, or use a wireless Internet connection at your local coffee shop.
Companies have linked their many systems together to help them fill orders on time and
better serve their customers. Software companies are continually developing new products
to help streamline our work and get better results. When technology works well, it is almost
invisible. But did it ever occur to you to ask, Who makes these complex technologies and
systems happen?

Because you re reading this text, you must have an interest in the behind-the-scenes
aspects of technology. If I ve done my job well, as you read you ll begin to see the many
innovations society is currently experiencing as the result of thousands of successful infor-
mation technology projects. In this text, you ll read about IT projects around the world that
went well, including Mittal Steel Poland s Implementation of SAP project that unified IT sys-
tems to improve business and financial processes; Dell Earth and other green computing
projects that save energy and millions of dollars; and Six Sigma projects such as the project
to improve case load management at Baptist St. Anthony s Hospital in Amarillo, Texas; the
systems infrastructure project at the Boots Company in the United Kingdom that is taking
advantage of supplier competition to cut costs and improve services; Kuala Lumpur s state-
of-the-art Integrated Transport Information System (ITIS) project; and many more. Of
course, not all projects are successful. Factors such as time, money, and unrealistic expecta-
tions, among many others, can sabotage a promising effort if it is not properly managed. In
this text, you ll also learn from the mistakes made on many projects that were not success-
ful. I have written this book in an effort to educate you, tomorrow s project managers, about
what will help make a project succeed and what can make it fail. You ll also see how pro-
jects are used in everyday media, such as television and film, and how companies use best
practices in project management. Many readers tell me how much they enjoy reading these
real-world examples in the What Went Right?, What Went Wrong?, Media Snapshot, and
Best Practice features. As practitioners know, there is no one size fits all solution to

PREFACE
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managing projects. By seeing how different organizations successfully implement project
management, you can help your organization do the same.

Although project management has been an established field for many years, managing
information technology projects requires ideas and information that go beyond standard
project management. For example, many information technology projects fail because of a
lack of user input, incomplete and changing requirements, and a lack of executive support.
This book includes suggestions on dealing with these issues. New technologies can also aid
in managing information technology projects, and examples of using software to assist in
project management are included throughout the book.

Information Technology Project Management, REVISED Sixth Edition, is still the only
textbook to apply all nine project management knowledge areas project integration, scope,
time, cost, quality, human resource, communications, risk, and procurement management
and all five process groups initiating, planning, executing, monitoring and controlling,
and closing to information technology projects. This text builds on the PMBOK® Guide,
Fourth Edition, an American National Standard, to provide a solid framework and context
for managing information technology projects. It also includes an appendix, Guide to Using
Microsoft Project 2010, which many readers find invaluable. A second appendix provides
advice on earning and maintaining Project Management Professional (PMP) certification
from the Project Management Institute (PMI) as well as information on other certification
programs, such as CompTIA s Project certification. A third appendix provides new case
studies and information on using simulation software to help readers apply their project
management skills.

Information Technology Project Management, REVISED Sixth Edition, provides practi-
cal lessons in project management for students and practitioners alike. By weaving together
theory and practice, this text presents an understandable, integrated view of the many con-
cepts, skills, tools, and techniques involved in information technology project management.
The comprehensive design of the text provides a strong foundation for students and
practitioners in project management.

New to the REVISED Sixth Edition
Building on the success of the previous editions, Information Technology Project Manage-
ment, REVISED Sixth Edition, introduces a uniquely effective combination of features. The
main changes made to the REVISED Sixth Edition only involve Appendix A. We know that
faculty cannot update texts every single year, so this revision only provides you the option
of teaching your students with the latest edition of Microsoft Project, Project 2010. The Beta
release has been out for several months, and the final product should be available in
summer 2010.

Appendix A has been thoroughly updated based on Microsoft Project 2010. There are
many updates in Project 2010. In addition to adopting the Ribbon interface, Project 2010
provides a manual scheduling option, a simple Timeline feature, and a Team Planner view
to easily assign people to tasks and reduce overallocations.

The main changes between the Sixth Edition and the Fifth Edition include the
following:

Several changes were made to synchronize the Sixth Edition with the PMBOK®

Guide, Fourth Edition, which PMI published in December 2008. Several

xviii Information Technology Project Management
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processes have changed, a few have been deleted, and a few have been added.
For example, project scope management now includes a process for collecting
requirements, which produces requirements documentation, a requirements
management plan, and a requirements traceability matrix as outputs. This text
describes this and other new processes and provides more details and examples
of their outputs.
Appendix C, Additional Running Cases, provides two new cases and informa-
tion about using Fissure s simulation software. One of the new cases focuses
on green computing projects, and the other involves finding or creating video
clips related to project management. There is also a running case at the end
of each knowledge area chapter, and the old cases from the Fifth Edition text
are available on the new companion (premium) Web site. Several additional
exercises are also provided at the end of chapters.
A new Jeopardy-like game is provided on the companion (premium) Web site
to help students study important concepts from each chapter in a fun and
engaging way.
A new companion (premium) Web site for the Sixth Edition (www.cengage.
com/mis/schwalbe) provides you with access to informative links from the end
notes, lecture notes, interactive quizzes, templates, additional running cases,
suggested readings, podcasts, the new Jeopardy-like game, and many other
items to enhance your learning.

A C C E S S I N G T H E C O M P A N I O N ( P R E M I U M ) W E B S I T E

To access the companion (premium) Web site, open a Web browser and go to www.cengage.
com/login. Locate your companion (premium) access card in the front of each new book
purchase, and click Create My Account to begin the registration process. If you ve pur-
chased a used book, please search for Information Technology Project Management,
Sixth Edition at www.CengageBrain.com where you can purchase instant access.

Updated examples are provided throughout the text. You ll notice several new
examples in the Sixth Edition that explain recent events in managing real infor-
mation technology projects. Several of the What Went Right?, What Went
Wrong?, Media Snapshot, and Best Practice examples have been updated to
keep you up-to-date. Additional examples and results of new studies are also
included throughout the text, with appropriate citations.
User feedback is incorporated. Based on feedback from reviewers, students,
instructors, practitioners, and translators (this book has been translated into
Chinese, Japanese, Russian, and Czech), you ll see several additional changes
to help clarify information.

Approach
Many people have been practicing some form of project management with little or no formal
study in this area. New books and articles are being written each year as we discover more
about the field of project management, and project management software continues to
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advance. Because the project management field and the technology industry change rapidly,
you cannot assume that what worked even a few years ago is still the best approach today.
This text provides up-to-date information on how good project management and effective
use of software can help you manage projects, especially information technology projects.
Five distinct features of this text include its relationship to the Project Management Body
of Knowledge, its detailed guide for using Microsoft Project 2010, its value in preparing for
Project Management Professional and other certification exams, its inclusion of running
case studies and online templates, and its companion (premium) Web site. You can also
purchase a special bundling of this text that includes simulation software by Fissure, or
you can order the Fissure simulation separately.

Based on the PMBOK® Guide, Fourth Edition

The Project Management Institute (PMI) created the Guide to the Project Management Body
of Knowledge (the PMBOK® Guide) as a framework and starting point for understanding
project management. It includes an introduction to project management, brief descriptions
of all nine project management knowledge areas, and a glossary of terms. The PMBOK®

Guide is, however, just that a guide. This text uses the PMBOK® Guide, Fourth Edition-
like (December 2008) as a foundation, but goes beyond it by providing more details,
highlighting additional topics, and providing a real-world context for project manage-
ment. Information Technology Project Management, Sixth Edition, explains project man-
agement specifically as it applies to managing information technology projects in the
twenty-first century. It includes several unique features to bring you the excitement of this
dynamic field (for more information on features, see the section entitled Pedagogical
Features ).

Contains a Detailed Guide on How to Use Microsoft Project 2010

Software has advanced tremendously in recent years, and it is important for project man-
agers and their teams to use software to help manage information technology projects. Each
copy of Information Technology Project Management, REVISED Sixth Edition, includes a
detailed guide in Appendix A on using the leading project management software on the
market Microsoft Project 2010. Examples using Project and other software tools are
integrated throughout the text, not as an afterthought. Appendix A, Guide to Using Microsoft
Project 2010, teaches you in a systematic way to use this powerful software to help in
project scope, time, cost, human resource, and communications management.

Resource for PMP and Other Certification Exams

Professional certification is an important factor in recognizing and ensuring quality in a pro-
fession. PMI provides certification as a Project Management Professional (PMP), and this
text is an excellent resource for studying for the certification exam. This text will also help you
pass other certification exams, such as CompTIA s Project exam. Having experience working
on projects does not mean you can easily pass the PMP or other certification exams.

I like to tell my students a story about taking a driver s license test after moving to Min-
nesota. I had been driving very safely and without accidents for over 16 years, so I thought
I could just walk in and take the test. I was impressed by the sophisticated computer system
used to administer the test. The questions were displayed on a large touch-screen monitor,
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often along with an image or video to illustrate different traffic signs or driving situations. I
became concerned when I found I had no idea how to answer several questions, and I was
perplexed when the test seemed to stop and a message displayed saying, Please see the
person at the service counter. This was a polite way of saying I had failed the test! After
controlling my embarrassment, I picked up one of the Minnesota driving test brochures,
studied it for an hour or two that night, and successfully passed the test the next day.

The point of this story is that it is important to study information from the organization
that creates the test and not be overconfident that your experience is enough. Because this
text is based on PMI s PMBOK® Guide, Fourth Edition, it provides a valuable reference for
studying for PMP certification. It is also an excellent reference for CompTIA s Project exam.
I have earned both of those certifications and kept them in mind when writing this text.

Provides Exercises, Running Cases, Templates, Sample Documents,
and Optional Simulation Software

Based on feedback from readers, the Sixth Edition continues to provide challenging exer-
cises and running cases to help students apply concepts in each chapter. There are over
50 templates, examples of real project documents, and optional simulation software devel-
oped by Fissure, a PMI Registered Education Provider, that you can use to actively practice
your skills in managing a project. All of these features help the subject matter come alive
and have more meaning.

Includes a Companion (Premium) Web site

A companion (premium) Web site provides you with a one-stop location to access informa-
tive links and tools to enhance your learning. Similar to other companion (premium) Web
sites provided by Course Technology, this site will be a valuable resource as you view lec-
ture notes, templates, interactive quizzes, podcasts, student files for Project 2010, important
articles, references, and more. You can also link to the author s site to see real class syllabi,
samples of student projects, and other helpful links.

Organization and Content
Information Technology Project Management, REVISED Sixth Edition, is organized into
three main sections to provide a framework for project management, a detailed description
of each project management knowledge area, and three appendices to provide practical
information for applying project management. The first three chapters form the first
section, which introduces the project management framework and sets the stage for
the remaining chapters.

Chapters 4 through 12 form the second section of the text, which describes each of the
project management knowledge areas project integration, scope, time, cost, quality,
human resource, communications, risk, and procurement management in the context of
information technology projects. An entire chapter is dedicated to each knowledge area.
Each knowledge area chapter includes sections that map to their major processes as
described in the PMBOK® Guide, Fourth Edition. For example, the chapter on project quali-
ty management includes sections on planning quality, performing quality assurance, and
performing quality control. Additional sections highlight other important concepts related
to each knowledge area, such as Six Sigma, testing, maturity models, and using software to
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assist in project quality management. Each chapter also includes detailed examples of key
project management tools and techniques as applied to information technology projects. For
example, the chapter on project integration management includes samples of various proj-
ect-selection documents, such as net present value analyses, ROI calculations, payback
analyses, and weighted scoring models. The project scope management chapter includes a
sample project charter, a project scope statement, and several work breakdown structures
for information technology projects.

Appendices A through C form the third section of the text, which provides practical
information to help you apply project management skills on real or practice projects. By fol-
lowing the detailed, step-by-step guide in Appendix A, which includes more than 60 screen
shots, you will learn how to use Project 2010. Appendix B summarizes what you need to
know to earn PMP or other certifications related to project management. Appendix C pro-
vides additional running cases and information on using simulation software to help you
practice your new skills.

Pedagogical Features
Several pedagogical features are included in this text to enhance presentation of the materi-
als so that you can more easily understand the concepts and apply them. Throughout the
text, emphasis is placed on applying concepts to current, real-world information technology
project management.

Learning Objectives, Chapter Summaries, Discussion Questions, Exercises,
Quick Quizzes, Running Cases, and Companion (Premium) Web site

Learning Objectives, Chapter Summaries, Quick Quizzes, Discussion Questions, Exercises,
Running Cases, and the companion (premium) Web site are designed to function as inte-
grated study tools. Learning Objectives reflect what you should be able to accomplish after
completing each chapter. Chapter Summaries highlight key concepts you should master.
The Discussion Questions help guide critical thinking about those key concepts. Quick
Quizzes test knowledge of essential chapter concepts and include an answer key. Exercises
provide opportunities to practice important techniques, as do the Running Cases. The
companion (premium) Web site provides several study aids, such as podcasts, the new
Jeopardy-like game, and interactive quizzes for each chapter, which are different from
the Quick Quizzes in the text.

Opening Case and Case Wrap-Up

To set the stage, each chapter begins with an opening case related to the material presented
in that chapter. These real-life case scenarios (most based on the author s experiences)
spark student interest and introduce important concepts in a real-world context. As project
management concepts and techniques are discussed, they are applied to the opening case
and other similar scenarios. Each chapter then closes with a case wrap-up with some end-
ing successfully and some, realistically, failing to further illustrate the real world of project
management.

What Went Right? and What Went Wrong?

Failures, as much as successes, can be valuable learning experiences. Each chapter of the
text includes one or more examples of real information technology projects that went right
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as well as examples of projects that went wrong. These examples further illustrate the
importance of mastering key concepts in each chapter.

Media Snapshot

The world is full of projects. Several televisions shows, movies, newspapers, Web sites, and
other media highlight project results, good and bad. Relating project management concepts
to all types of projects highlighted in the media will help you understand and see the impor-
tance of this growing field. Why not get people excited about studying project management
by showing them how to recognize project management concepts in popular television
shows, movies, or other media?

Best Practice

Every chapter includes an example of a best practice related to topics in that chapter. For
example, Chapter 1 describes best practices written by Robert Butrick, author of The Project
Workout, from the Ultimate Business Library s Best Practice book. He suggests that organi-
zations ensure their projects are driven by their strategy and engage project stakeholders.

Key Terms

The fields of information technology and project management both include many unique
terms that are vital to creating a workable language when the two fields are combined. Key
terms are displayed in bold face and are defined the first time they appear. Definitions of
key terms are provided in alphabetical order at the end of each chapter and in a glossary
at the end of the text.

Application Software

Learning becomes much more dynamic with hands-on practice using the top project man-
agement software tool in the industry, Microsoft Project 2010, as well as other tools, such
as spreadsheet software and the Internet. Each chapter offers you many opportunities to get
hands-on experience and build new software skills. This text is written from the point of
view that reading about something only gets you so far to really understand project man-
agement, you have to do it for yourself. In addition to the exercises and running cases found
at the end of each chapter and in Appendix C, several challenging exercises are provided
at the end of Appendix A, Guide to Using Microsoft Project 2010.

S U P P L E M E N T S

The following supplemental materials are available when this text is used in a classroom
setting. All of the teaching tools available with this text are provided to the instructor on a
single CD-ROM.

Electronic Instructor s Manual The Instructor s Manual that accompanies this
textbook includes additional instructional material to assist in class prepara-
tion, including suggestions for lecture topics and additional discussion
questions.
ExamView® This textbook is accompanied by ExamView, a powerful testing
software package that allows instructors to create and administer printed,
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computer (LAN-based), and Internet exams. ExamView includes hundreds of
questions that correspond to the topics covered in this text, enabling students
to generate detailed study guides that include page references for further
review. The computer-based and Internet testing components allow students
to take exams at their computers, and also save the instructor time by grading
each exam automatically.
PowerPoint Presentations This text comes with Microsoft PowerPoint slides for
each chapter. These are included as a teaching aid for classroom presentation,
to make available to students on the network for chapter review, or to be
printed for classroom distribution. Instructors can add their own slides for
additional topics they introduce to the class.
Solution Files Solutions to end-of-chapter questions can be found on the
Instructor Resource CD-ROM and may also be found on the Course Technology
Web site at www.cengage.com/mis/schwalbe. The solutions are password-
protected.
Distance Learning Course Technology is proud to present online courses in
WebCT and Blackboard, to provide the most complete and dynamic learning
experience possible. When you add online content to one of your courses,
you re adding a lot: self tests, links, glossaries, and, most of all, a gateway to the
twenty-first century s most important information resource. We hope you will
make the most of your course, both online and offline. For more information
on how to bring distance learning to your course, contact your Course
Technology sales representative.

A C K N O W L E D G M E N T S

I never would have taken on this project writing this book, the first, second, third, fourth,
fifth, and sixth edition without the help of many people. I thank the staff at Course Tech-
nology for their dedication and hard work in helping me produce this book and in doing
such an excellent job of marketing it. Kate Mason (formerly Hennessy), Deb Kaufmann, Mat-
thew Hutchinson, Patrick Franzen, and many more people did a great job in planning and
executing all of the work involved in producing this book.

I thank my many colleagues and experts in the field who contributed information to this
book. David Jones, Rachel Hollstadt, Cliff Sprague, Michael Branch, Barb Most, Jodi Curtis,
Rita Mulcahy, Karen Boucher, Bill Munroe, Tess Galati, Joan Knutson, Neal Whitten, Brenda
Taylor, Quentin Fleming, Jesse Freese, Nick Matteucci, Nick Erndt, Dragan Milosevic, Bob
Borlink, Arvid Lee, Kathy Christenson, Peeter Kivestu, and many other people who provided
excellent materials included in the Sixth Edition of this book. I really enjoy the network of
project managers, authors, and consultants in this field who are very passionate about
improving the theory and practice of project management.

I also thank my students and colleagues at Augsburg College and the University of Min-
nesota for providing feedback on the earlier editions of this book. I received many valuable
comments from them on ways to improve the text and structure of my courses. I learn
something new about project management and teaching all the time by interacting with
students, faculty, and staff.
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I also thank faculty reviewers for providing excellent feedback for me in writing this edi-
tion: Brian Ameling, Limestone College; Michel Avital, University of Amsterdam; Al Funda-
burk, Bloomsburg University; Suleyman Guleyupoglu, University of Phoenix; Aurore
Kamssu, Tennessee State University; Angela Lemons, North Carolina A&T State University;
Alan L. Matthews, Travecca Nazarene University; Thyra Nelson, Macon State College; Samir
Shah, Pennsylvania State University York; and Andrew Urbaczewski, University of Michi-
gan-Dearborn. I also wish to thank the many reviewers of the earlier editions of this text. I
also thank the many other instructors and readers who have contacted me directly with
praise as well as suggestions for improving this text. I really appreciate the feedback and
do my best to incorporate as much as I can.

Most of all, I am grateful to my family. Without their support, I never could have written
this book. My wonderful husband, Dan, has always supported me in my career, and he helps
me keep up-to-date with software development since he is a lead architect for ComSquared
Systems, Inc. Our three children, Anne, Bobby, and Scott, actually think it s cool that their
mom writes books and speaks at conferences. They also see me managing projects all the
time. Anne, now 25, teases me for being the only quilter she knows who treats each quilt as
a project. (Maybe that s why I get so many done!) Our children all understand the main rea-
son why I write I have a passion for educating future leaders of the world, including them.

As always, I am eager to receive your feedback on this book. Please send comments to
me at schwalbe@augsburg.edu.

Kathy Schwalbe, Ph.D., PMP
Professor, Department of Business Administration
Augsburg College
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I N T R O D U C T I O N

This appendix provides a concise guide to using Microsoft Office Project Professional 2010
(often referred to as Project 2010) to assist in performing project management functions.
The Office Project 2010 family includes several different products:

Project Standard 2010, a non-Web-based, stand-alone program for individuals who
manage projects independently, similar to earlier versions of Project Standard.
Project Professional 2010, which is basically Project Standard 2010 plus the
ability to connect to Project Server 2010, if available. (Note: This guide does
not include information on connecting to Project Server 2010.)
Project Server 2010, built on SharePoint Server 2010, delivers flexible work
management solutions across organizations, departments, and teams. Organiza-
tions should develop and apply many standards, templates, codes, and procedures
before using Project Server 2010 to make the best use of its capabilities.

Project Cost Management A.42

Fixed and Variable Cost Estimates A.43

Assigning Resources to Tasks A.45

Baseline Plan, Actual Costs, and Actual Times A.51

Earned Value Management A.57

Project Human Resource Management A.60

Resource Calendars A.60

Resource Histograms A.61

Resource Leveling A.63

Using the New Team Planner Feature* A.65

Project Communications Management A.66

Common Reports and Views A.66

Using Templates and Inserting Hyperlinks and Comments A.68

Discussion Questions A.71

Exercises A.71

Exercise A-1: Homework Assignments A.72

Exercise A-2: Web Site Development A.73

Exercise A-3: Software Training Program A.74

Exercise A-4: Project Tracking Database A.76

Exercise A-5: Real Project Application A.78

A.2
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Each version of Project 2010 can help users manage different aspects of all nine project
management knowledge areas. (Consult Microsoft s Web site for more details on all of the
versions of Project 2010.) Most users, however, focus on using Project 2010 to assist with
scope, time, cost, human resource, and communications management. This guide uses
these project management knowledge areas as the context for learning how to use Project
2010. The basic order of steps in this appendix follows best practices in project manage-
ment. That is, you should first determine the scope of a project, then the time, and then the
resource and cost information. You can then set a baseline and enter actuals to track and
communicate performance information.

Hundreds of project management software products are available today, but Microsoft
Project is the clear market leader among midrange applications. Before you can use Project
2010 or any project management software effectively, you must understand the fundamen-
tal concepts of project management, such as creating work breakdown structures, linking
tasks, entering duration estimates, and so on. See the Suggested Readings on the companion
Web site (www.cengage.com/mis/schwalbe) for recommendations on other resources to
help you gain an even deeper understanding of Project 2010.

New Features of Project 2010*
Project 2010 is not just a run-of-the-mill update. Microsoft really listened to users and has
revised Project to meet user needs. Learning some of the new features might seem like a
chore, but it is well worth the effort.

If you are familiar with Project 2007, it may be helpful to review some of the new fea-
tures in Project 2010.

Improved user interface: Project 2010 now includes the ribbon interface
instead of using the traditional menus and toolbars similar to Office 2003. Com-
mands are organized in logical groups under tabs, such as File, Task, Resource,
Project, View, and Format. The File tab takes you to the new Backstage feature,
a one-stop graphical destination for opening, saving, and printing your files. You
can also now right-click different items, like a table cell or chart, to bring up
commonly used commands quickly.
New viewing options: Project 2010 includes several new views. A timeline view
shows you a concise overview of the entire project schedule. You can easily add
tasks to the timeline, print it, or paste it into an e-mail. The new team planner
view lets you quickly see what your team members are working on, and you
can move tasks from one person to another using this view. For example, if a
resource is overallocated, you can drag a task to another resource to remove
the overallocation. You can also add new columns quickly and use the new
Zoom Slider at the lower right of the screen to zoom your schedule in and out.
Also, the tab for viewing and printing reports is easier to navigate with more
options for visual reports.
Manual scheduling: Unlike previous versions of Project where tasks were auto-
matically scheduled, Project 2010 uses manual schedule as its default. In past
versions of Project, summary tasks were automatically calculated based on
their subtasks. Resources were also adjusted automatically. With Project

*From Schwalbe s An Introduction to Project Management, Third Edition, 2010.
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2010, this is no longer the case. For example, you might want to enter dura-
tions for summary tasks and then fill in the detailed information for their sub-
tasks later. When you open a new file, Project reminds you that new tasks are
manually scheduled and lets you easily switch to automatic scheduling, if
desired. You can also use the new compare versions to see Gantt bars to more
clearly see how one version of a project differs from another version.
Improved collaboration: Project 2010 can provide an interface with the most
popular portals used in the industry. Project now uses SharePoint instead of
Project Web Access for collaboration. Project Server 2010 also provides inte-
gration with Microsoft Exchange 2010 to enable team members to manage and
report on tasks directly from Microsoft Outlook. Remember that Project Stan-
dard does not include these collaboration features. You must have Project Pro-
fessional and Project Server to use the enterprise features of Project.

Before You Begin
This appendix assumes you are using Project 2010 with Windows 7, Vista, or XP and are famil-
iar with other Windows-based applications. You can download a free trial of Project 2010 from
Microsoft s Web site. Additionally, students and faculty can purchase software at deep dis-
counts from several sources, including www.journeyed.com. Check your work by reviewing
the many screen shots included in the steps or by using the solution files that are available
for download from the companion Web site for this text or from your instructor.

H E L P

You need to be running Windows 7, Vista, or XP as your operating system to use Project
2010. If you have any technical difficulties, contact Microsoft s Support Services at www.
microsoft.com. To complete the hands-on activities in the appendix, you will need to copy
a set of files from the companion Web site for this text (www.cengage.com/mis/schwalbe)
to your computer. You can also download the files from the author s Web site (www.
kathyschwalbe.com) under Book FAQs.

This appendix uses a fictitious information technology project the Project Tracking Data-
base project to illustrate how to use the software. The goal of this project is to create a
database to keep track of all the projects a company is working on. Each section of the
appendix includes hands-on activities for you to perform. When you begin each set of steps,
make sure you are using the correct file. Before you begin your work you should have the
finance.mpp, resource.mpp, and kickoffmeeting.doc files.

In addition, you will create the following files from scratch as you work through the steps:

scope.mpp
time.mpp
tracking.mpp
baseline.mpp
level.mpp
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Now that you understand project management concepts and the basic project manage-
ment terminology, you will learn how to start Project 2010, review the Help facility and a
template file, and begin to plan the Project Tracking Database project.

O V E R V I E W O F P R O J E C T 2 0 1 0

The first step to mastering Project 2010 is to become familiar with the Help facility, major
screen elements, views, and filters. This section describes each of these features.

Starting Project 2010 and Using the Help Feature
To start Project 2010:

1. Open Project 2010. Click the Start button on the taskbar, point to All Programs in
Windows XP or Programs in Windows 7 or Vista, point to or click Microsoft Office,
and then click Microsoft Office Project 2010. Alternatively, a shortcut or icon might
be available on the desktop; in this case, double-click the icon to start the software.

2. Maximize Project 2010. If the Project 2010 window does not fill the entire
screen as shown in Figure A-1, click the Maximize button in the upper-right
corner of the window.

H E L P

All screen shots were taken using Windows XP, so your screen may look slightly different.
Focus on the Project 2010 main screen.

Quick Access
toolbar

Ribbon

Tabs Gantt Chart view

Timeline

Manual/
automatic
scheduling

FIGURE A-1 Project 2010 main screen
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Project 2010 is now running and ready to use. Look at some of the elements of the Project
2010 screen. The default view is the Gantt Chart view under the Task tab, which shows
tasks and other information in the Entry table as well as a calendar display. You can also use
the Quick Access toolbar and tabs as in other Windows applications. Notice the new Time-
line and Manual scheduling features on the main screen. You can access other views by
clicking the View button on the far left of the Ribbon as shown in Figure A-2.

Notice that when Project 2010 starts, it opens a new file named Project1, as shown in
the title bar. If you open a second file, the name will be Project2, and so on, until you save
and rename the file.

You can access other information to help you learn how to use Project 2010 under the
Help menu. Figure A-3 shows the Help menu options available by clicking Help on the far
right side of the Ribbon or by pressing F1.

Click to access
other views

FIGURE A-2 Accessing other views
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Microsoft realizes that Project 2010 can take some time to learn and provides a number
of resources on its Web site. Microsoft s Web site for Project 2010 (www.microsoft.com/
project) provides files for users to download, case studies, articles, and other useful materi-
als. Also see the Suggested Readings under Appendix A on the companion Web site for
this text.

Main Screen Elements
The Project 2010 default main screen is called the Gantt Chart view. At the top of the main
screen, the Ribbon is similar to other Microsoft Windows 2007 and 2010 programs. Project
2010 does have Ribbon interface, while Project 2007 did not. The order and appearance of
buttons on the Ribbon may vary, depending on the features you are using and how the Rib-
bon is customized.

Figure A-4 shows the main screen elements of Project 2010. On the left side of the
screen below the Ribbon is the Entry table. The Gantt chart calendar display appears on the
right of the split bar, which separates the Entry table and the Gantt chart. The column to
the left of the Task Name column is the Indicators column. The Indicators column displays
indicators or symbols related to items associated with each task, such as task notes or
hyperlinks to other files.

FIGURE A-3 Project 2010 Help menu options
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T I P

Many features in Project 2010 are similar to ones in other Windows programs. For example,
to collapse or expand tasks, click the appropriate symbols to the left of the task name. To
access shortcut items, right-click in either the Entry table area or the Gantt chart. Many of the
Entry table operations in Project 2010 are very similar to operations in Excel. For example,
to adjust a column width, click and drag or double-click between the column heading titles.

If you select another view and want to return to the Gantt Chart view, click the Gantt Chart
button on the Ribbon under the Tasks tab or the appropriate button under the Task views
section under the View tab. If the Entry table on the left appears to be different, select the
Tables button under the Data section from the View tab.

Notice the split bar that separates the Entry table from the Gantt chart. When you move
the mouse over the split bar, your cursor changes to the resize pointer. Clicking and drag-
ging the split bar to the right reveals other task information in the Entry table, including the
Duration, Start date, Finish date, Predecessors, and Resource Names columns.

Next, you will open a template file to explore more screen elements. Project 2010
comes with several template files, and you can also access templates from Microsoft Office
Online or other Web sites. To open template files on your computer, you normally click New
under the File tab. A list of available templates displays, as shown in Figure A-5. For the fol-
lowing steps you will open a template file you downloaded from the companion Web site.
It will not display under the list of available templates because it is a template from an older
version of Project.

Indicators
column Entry table

Gantt chart
calendar display

Split bar

FIGURE A-4 Project 2010 main screen elements
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H E L P

To access template files on your computer, you must do a full or custom install of Project
2010.

To open a template file and adjust Project 2010 screen elements:

1. Open a template file. Click the Open button under the File tab, browse
to find the file named finance.mpp that you copied from the companion Web
site, or author s Web site for this text, and then double-click the filename to
open the file. This file provides a template for a project to implement a new
finance and accounting system in a corporate environment.

T I P

The finance.mpp file is identical to the template named Finance and Accounting System
Implementation that comes with Project 2007.

2. View the Note. Move your mouse over the Notes icon in the Indicators column
and read its contents. It is a good idea to provide a short note describing the
purpose of project files. (You ll learn how to add notes in the Communications
section of this guide.) Your screen should resemble Figure A-6.

FIGURE A-5 Opening a template file
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3. Adjust the timescale. Click the Zoom Out icon on the Zoom Slider bar
on the lower right of your screen twice to adjust the timescale so that you see the
entire bar at the top of the Gantt chart. Notice that this project started on January 1,
2007, and ended in early April 2007. The first line in the Entry table displays the file-
name, and the bar in the Gantt chart next to that line shows the time line for the entire
project.

4. Select Outline Level 1 to display WBS level 2 tasks. Under the View tab, click
the Outline button s list arrow, and then click Outline Level 1, as shown in
Figure A-7. Notice that only the outline level 1 items or WBS level 2 items dis-
play in the Entry table after you select Outline Level 1. The black bars on the
Gantt chart represent the summary tasks. Note that according to the Project
Management Institute (PMI), the entire project is normally referred to as WBS
level 1, and the next highest level is called level 2. This view of the file also
shows two milestone tasks in rows 1 and 137 indicating when a new Accounting
and Finance system was chosen and when the project was completed. Recall
that the black diamond symbol on a Gantt chart shows milestones.

Task Name column

Milestone

Summary tasksOutline list arrow

FIGURE A-7 Viewing summary tasks

Notes
icon

Zoom Slider

FIGURE A-6 The finance.mpp file

A.10

Appendix A

      Copyright 2011 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). 

Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Licensed to:



5. Adjust the Task Name column. Move the split bar to the right, if needed, to
reveal the entire Task Name column. Move your cursor over the right-column
gridline in the Task Name column heading until you see the resize pointer,
and then double-click the left mouse button to resize the column width
automatically.

6. Move the split bar to reveal more Entry table columns. Move the split bar to the right
to reveal the Resource Names column. Your screen should resemble Figure A-8.

7. Expand a task. Click the expand symbol to the left of Task 112, Package
Deployment, to see its subtasks. Click the collapse symbol to hide its subtasks.

Project 2010 Views
Project 2010 provides many ways to display project information. These displays are called
views. The views under the View tab include: Gantt Chart, Task Usage, Network Diagram,
Calendar, Resource Usage, and Resource Sheet. The Resource Form and Resource Graph
views are available under Other Views, and even more views are available under More
Views, such as the Tracking Gantt and Leveling Gantt. These different views allow you to
examine project information in different ways, which helps you analyze and understand
what is happening on your project.

The View tab also provides access to different tables that display information in a varie-
ty of ways. Some tables that you can access from the View tab include Schedule, Cost,
Tracking, and Earned Value. Some Project 2010 views, such as the Gantt Chart view, pre-
sent a broad look at the entire project, whereas others, such as the Form views, focus on spe-
cific pieces of information about each task. Three main categories of views are available:

Graphical: A chart or graphical representation of data using bars, boxes, lines,
and images.
Task Sheet or Table: A spreadsheet-like representation of data in which each
task appears as a new row and each piece of information about the task is
represented by a column. Different tables are applied to a task sheet to display
different kinds of information.
Form: A specific view of information for one task. Forms are used to focus on
the details of one task.

Table A-1 describes some of the predesigned views within each category that Project
2010 provides to help you display the project or task information that you need.

Collapse symbol

Expand symbol

Move split bar
to reveal more
columns

FIGURE A-8 Adjusting screen elements
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Next, you will use the same file (finance.mpp) to access and explore some of the views
available in Project 2010.

To access and explore different views:

1. Show all subtasks. Click the Outline button on the Ribbon under the View
tab, and then click All Subtasks. Under Task Name click Task 0, finance.

TABLE A-1 Common Project 2010 views

Category
of View

View Name Description of View

Graphical Gantt Chart Standard format for displaying project schedule
information that lists project tasks and their
corresponding start and finish dates in a calendar
format. Shows each task as a horizontal bar
with the length and position corresponding to
the timescale at the top of the Gantt chart.

Network
Diagram

Schematic display of the logical relationships or
sequencing of project activities. Presents each
task as a box with linking lines between tasks to
show sequencing. Critical tasks appear in red.

Task Sheet or
Table

Entry Table Default table view showing columns for Task Name
and Duration. By revealing more of the Entry table,
you can enter start and end dates, predecessors,
and resource names.

Schedule Table Displays columns for Task Name, Start, Finish,
Late Start, Late Finish, Free Slack, and Total Slack.

Cost Table Displays columns for Task Name, Fixed Cost,
Fixed Cost Accrual, Total Cost, Baseline,
Variance, Actual, and Remaining.

Tracking Table Displays columns for Task Name, Actual Start,
Actual Finish, % Complete, Physical % Complete,
Actual Duration, Remaining Duration, Actual Cost,
and Actual Work.

Earned Value Displays columns for Task Name, PV, EV, AC, SV,
CV, EAC, BAC, and VAC. See the earned value
section of this text for descriptions of these
acronyms.

Form Task Form Displays detailed information about a single task
in one window.

Resource Form Displays detailed information about a single
resource in one window.
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2. Explore the Network Diagram view. Click the Network Diagram button on
the Ribbon, and then move the Zoom Slider all the way to the left to
see more of the diagram. Your screen should resemble Figure A-9.

3. Explore the Calendar view. Click the Calendar button on the Ribbon. Your
screen should resemble Figure A-10.

FIGURE A-9 Network Diagram view of finance file

FIGURE A-10 Calendar view of finance file
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4. Examine columns in the Entry table. Click the Gantt Chart button on the
Ribbon, and observe the information provided in each column of the Entry
table.

5. Examine the Table: Schedule view. Click the Tables button under the Data
section of the View tab, and then click Schedule . Notice that the columns
to the left of the Gantt chart now display more detailed schedule information.
Also notice that all of the text in the Task Name column is not visible. You can
widen the column by moving the mouse to the right of the Task Name column
and double-clicking the resize pointer. You can also move the split bar to the
right to reveal more columns.

6. Right-click the Select All button to access different table views. Move your
mouse to the Select All button to the left of the Task Name column symbol, and
then right-click with your mouse. A shortcut menu to different table views dis-
plays, as shown in Figure A-11. Experiment with other table views and then
return to the Table: Entry view.

7. Explore the Reports feature. Click the Project tab, and then click the Reports
button. The Reports dialog box displays, as shown in Figure A-12.

Select All button Schedule table view

FIGURE A-11 Changing table views
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8. View the Project Summary report. Double-click Overview from the Reports
dialog box, and then double-click Project Summary in the Overview Reports
dialog box. Notice that Project 2010 switches to the Backstage (File tab) to
make it easy for you to print or share your report, as shown in Figure A-13.

9. Examine reports and return to the Task tab. Move the mouse to the right side
of the screen to examine the report more closely. Notice that the insertion point
now resembles a magnifying glass. Click inside the report to zoom in or zoom out.
Click the Project tab again, and then experiment with viewing other reports. You will
use several reports and other views later. Click the Task tab when you are finished.

Project 2010 Filters
Project 2010 uses an underlying relational database to filter, sort, store, and display infor-
mation. Filtering project information is very useful. For example, if a project includes
hundreds of tasks, you might want to view only summary or milestone tasks to get an

FIGURE A-13 Previewing a report in the Backstage

FIGURE A-12 Reports dialog box
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overview of the project. To get this type of overview of a project, select the Milestones or
Summary Tasks filter from the Filter list. If you are concerned about the schedule, you can
select a filter that shows only tasks on the critical path. Other filters include Completed
Tasks, Late/Overbudget Tasks, and Date Range, which displays tasks based on dates you
provide. As shown earlier, you can also click the Show button on the toolbar to display dif-
ferent levels in the WBS quickly. For example, Outline Level 1 shows the highest-level items
in the WBS, Outline Level 2 shows the next level of detail in the WBS, and so on.

To explore Project 2010 filters:

1. Apply a filter to see only milestone tasks. From the Table: Entry view in the
finance.mpp file, click the View tab, and then click the Filter list arrow , as
shown in Figure A-14.

2. Filter to show specific tasks. Click Milestones in the list of filters, and move
the split bar to the left to see all the milestones on the Gantt chart. Your screen
should resemble Figure A-15. The black diamond symbol represents a mile-
stone, a significant event on a project.

Filter list arrow

FIGURE A-14 Using a filter

Milestones
lter applied

Only milestones and
summary tasks display

FIGURE A-15 Milestone tasks filter for Project 2010 finance file
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3. Show summary tasks. Click the Filter list arrow, scroll down until you see
Summary Tasks, and then click Summary Tasks. Now only the summary tasks
appear in the WBS. Experiment with other outline levels and filters.

4. Close the file. When you are finished reviewing the finance.mpp file, click Close
from the File menu or click the Close button . A dialog box appears asking if
you want to save changes. Click No.

5. Exit Project 2010. Select Exit from the File menu or click the Close button for
Project 2010.

Now that you are familiar with the Project 2010 main screen elements, views, and fil-
ters, you will learn how to use Project 2010 to assist in project scope management by creat-
ing a new project file, developing a WBS, and setting a baseline.

P R O J E C T S C O P E M A N A G E M E N T

Project scope management involves defining the work to perform to carry out the project.
To use Project 2010, you must first determine the scope of the project. To begin determin-
ing the project s scope, create a new file with the project name and start date. Develop a list
of tasks that need to be done to carry out the project. This list of tasks becomes the work
breakdown structure (WBS). If you intend to track actual project information against the
initial plan, you must set a baseline. In this section, you will learn how to create a new proj-
ect file, develop a WBS, and set a baseline to help plan and manage the Project Tracking
Database project. To start, you will enter the scope-related information.

T I P

In this section, you will go through several steps to create the scope.mpp Project 2010 file.
If you want to download the completed file to check your work or continue to the next sec-
tion, a copy of scope.mpp is available on the companion Web site for this text, from the
author s Web site, or from your instructor. Try to complete an entire section of this appendix
(project scope management, project time management, and so on) in one sitting to create
the complete file. Also, be sure to save the scope.mpp file you create in a different folder
than the one you download, and then compare the two files.

Creating a New Project File
To create a new project file:

1. Create a blank project. Open Project 2010. A blank project file automatically
opens when you start Project 2010. The default filenames are Project1,
Project2, and so on. If Project 2010 is already open and you want to open
a new file, click the File tab, click New, and select Blank Project.

2. Open the Project Information dialog box. Click the Project tab, and then click
Project Information to display the Project Information dialog box, as shown in
Figure A-16. The Project Information dialog box enables you to set dates for the
project, select the calendar to use, and view project statistics. The project start
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date will default to today s date. Note that in Figure A-16 the file was created
on 3/31/10 and a Start date of 2/1/11 was entered. (See the following Help box
for information about changing date formats).

3. Enter the project start date. In the Start date text box, enter 2/1/11. Setting
your project start date to 2/1/11 will ensure that your work matches the results
that appear in this appendix. Leave the Finish date, Current date, and other
information at the default settings. Click OK.

H E L P

This appendix uses American date formats. For example, 2/1/11 represents February 1,
2011. Be sure to enter dates in this format for these steps. However, you can change the date
format by selecting Options from the File tab. Click the date format you want to use in the
Date Format box under the General settings. You can also customize the Ribbon, change
default currencies in the display, and so on under Project Options.

4. Access advanced project properties. Click the File tab, and then click Info.
Click Project Information on the right side of the screen to access Advanced
Properties, as shown in Figure A-17.

Start date
text box

FIGURE A-16 Project Information dialog box
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5. Enter advanced project information. Type Project Tracking Database in the
Title text box, type Terry Dunlay in the Author text box, as shown in Figure A-18,
and then click OK. You may have some default information entered in the Proj-
ect Properties dialog box, such as your company s name. Click the Task tab
so you can see the Entry table and Gantt Chart view. Keep this file open for the
next set of steps.

FIGURE A-18 Project Properties dialog box

Advanced Properties

FIGURE A-17 Accessing advanced project properties
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Developing a Work Breakdown Structure
Before using Project 2010, you must develop a work breakdown structure (WBS) for your
project. Developing a good WBS takes time, but it will make entering tasks into the Entry
table easier if you develop the WBS first. It is also a good idea to establish milestones before
entering tasks in Project 2010. You will use the information in Table A-2 to enter tasks for
the Project Tracking Database project. Be aware that this example is much shorter and sim-
pler than most WBSs.

To develop a WBS and enter milestones for the Project Tracking Database project:

1. Enter task names. Enter the 20 tasks in Table A-2 into the Task Name column
in the order shown. Do not worry about durations or any other information at
this time. Type the name of each task into the Task Name column of the Entry
table, beginning with the first row. Press Enter or the down arrow key on your
keyboard to move to the next row.

H E L P

If you accidentally skip a task, highlight the task row, right-click, and select Insert Task. To
edit a task entry, click the text for that task, and either type over the old text or edit the
existing text.

TABLE A-2 Project Tracking Database tasks

Order Task Name

1 Initiating

2 Kickoff meeting

3 Develop project charter

4 Charter signed

5 Planning

6 Develop project plans

7 Review project plans

8 Project plans approved

9 Executing

10 Analysis

11 Design

12 Implementation

13 System implemented

(continued on next page)

A.20

Appendix A

      Copyright 2011 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). 

Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Licensed to:



T I P

Entering tasks into Project 2010 and editing the information is similar to entering and edit-
ing data in an Excel spreadsheet. You can also easily copy and paste text from Excel or Word
into Project, such as the list of tasks.

2. Move the split bar to reveal more columns. If necessary, move the split bar to
the right to reveal the entire Task Name and Duration columns.

3. Adjust the Task Name column width as needed. To make all the text display
in the Task Name column, move the mouse over the right-column gridline in
the Task Name column heading until you see the resize pointer, and then click
the left mouse button and drag the line to the right to make the column wider,
or double-click to adjust the column width automatically.

This WBS separates tasks according to the project management process groups of initi-
ating, planning, executing, controlling, and closing. These tasks will be the level 2 items in
the WBS for this project. Remember that the whole project is considered level 1. It is a good
idea to include all of these process groups because there are important tasks that must be
done under each of them. Recall that the WBS should include all of the work required for
the project. In the Project Tracking Database WBS, the tasks will be purposefully left at a
high WBS level (level 3). You will create these levels, or the WBS hierarchy, next when you
create summary tasks. For a real project, you would usually break the WBS into even more
levels to provide more details to describe all the work involved in the project. For example,
analysis tasks for a database project might be broken down further to include preparing
entity relationship diagrams for the database and developing guidelines for the user inter-
face. Design tasks might be broken down to include preparing prototypes, incorporating
user feedback, entering data, and testing the database. Implementation tasks might include
more levels, such as installing new hardware or software, training the users, fully document-
ing the system, and so on.

TABLE A-2 Project Tracking Database tasks (continued)

Order Task Name

14 Controlling

15 Report performance

16 Control changes

17 Closing

18 Prepare final project report

19 Present final project

20 Project completed
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Creating Summary Tasks

After entering the WBS tasks listed in Table A-2 into the Entry table, the next step is to show
the WBS levels by creating summary tasks. The summary tasks in this example are Tasks
1 (initiating), 5 (planning), 9 (executing), 14 (controlling), and 17 (closing). You create sum-
mary tasks by highlighting and indenting their respective subtasks.

To create the summary tasks:

1. Select lower level or subtasks. Highlight Tasks 2 through 4 by clicking the cell
for Task 2 and dragging the mouse through the cells to Task 4.

2. Indent subtasks. Click the Indent task button on the Ribbon under the
Schedule group of the Task tab (or press Alt + Shift + right arrow) so your
screen resembles Figure A-19. After the subtasks (Tasks 2 through 4) are
indented, notice that Task 1 automatically becomes boldface, which indicates
that it is a summary task. A collapse symbol appears to the left of the new sum-
mary task name. Clicking the collapse symbol will collapse the summary
task and hide the subtasks beneath it. When subtasks are hidden, an expand
symbol appears to the left of the summary task name. Clicking the expand
symbol will expand the summary task. Also, notice that the symbol for the sum-
mary task on the Gantt chart appears as a black line with arrows indicating the
start and end dates.

3. Create other summary tasks and subtasks. Create subtasks and summary
tasks for Tasks 5, 9, 14, and 17 by following the same steps. Indent Tasks 6
through 8 to make Task 5 a summary task. Indent Tasks 10 through 13 to
make Task 9 a summary task. Indent Tasks 15 through 16 to make Task 14 a
summary task. Indent Tasks 18 through 20 to make Task 17 a summary task.
Widen the Task Name column to see all of your text, as needed.

Summary
task symbol

Expand
or collapse
symbols by
summary
tasks

Indent task

FIGURE A-19 Indenting tasks to create the WBS hierarchy
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To change a task from a summary task to a subtask or to change its level up one in the WBS,
you can outdent the task instead of indenting it. To outdent the task, click the cell of the
task or tasks you want to change, and then click the Outdent Task button on the Ribbon
(the button just to the left of the Indent Task button). You can also press Alt + Shift + Right
Arrow to indent tasks and Alt Shift Left Arrow to outdent tasks. Remember, the tasks in Proj-
ect 2010 should be entered in an appropriate WBS format with several levels in the
hierarchy.

Numbering Tasks

Depending on how Project 2010 is set up on your computer, you may or may not see num-
bers associated with tasks as you enter and indent them.

To display automatic numbering of tasks using the standard tabular numbering system
for a WBS:

1. Show outline numbers. Click the Format tab, and then click the Outline Num-
ber checkbox under the Show/Hide group. Project 2010 adds the appropriate
WBS numbering to the task names.

2. Show project summary task. Click the Project Summary checkbox just below
the Outline Number checkbox. Notice that a new task has been added under
row 0.

3. Adjust the file. Widen the Task Name column and move the split bar so only
that column displays. Your file should resemble Figure A-20.

Project
Summary
task

Outline
numbers
show WBS
hierarchy

Outline Number and Project
Summary Task check boxes

FIGURE A-20 Adding Outline Numbers and Project Summary Task
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Saving Project Files with or without a Baseline
An important part of project management is tracking performance against a baseline, or
approved plan. Project 2010 does not prompt you to save a file with or without a baseline
each time you save it, as some previous versions did. The default is to save without a base-
line. It is important to wait until you are ready to save your file with a baseline because Proj-
ect 2010 will show changes against a baseline. Because you are still developing your
project file for the Project Tracking Database project, you want to save the file without a
baseline. Later in this appendix, you will save the file with a baseline by selecting Tools,
Tracking, and then Set Baseline. You will then enter actual information to compare planned
and actual performance data.

To save a file without a baseline:

1. Save your file. Click the File tab and then click Save, or click the Save button
on the Quick Access toolbar.

2. Enter a filename. In the Save As dialog box, type scope in the File name text
box. Browse to the location in which you want to save the file, and then click
Save. Your Project 2010 file should look like Figure A-20, but with the file name
showing as scope instead of Project1.

H E L P

If you want to download the Project 2010 file scope.mpp to check your work or continue
to the next section, a copy is available on the companion Web site for this text, the author s
Web site, and from your instructor. If you downloaded the scope.mpp file that comes with
this text, you can save your file with a different name or in a different location to avoid over-
writing that file. Keep this in mind for other files you save as well.

Now that you have finished entering all 20 tasks, created the summary tasks and subtasks,
set the options to show the standard WBS tabular numbering system, and saved your file,
you will learn how to use the Project 2010 time management features.

P R O J E C T T I M E M A N A G E M E N T

Many people use Project 2010 for its time management features. The first step in using these
features, after inputting the WBS for the project, is to enter durations for tasks or specific
dates when tasks will occur. Inserting durations or specific dates will automatically update
the Gantt chart. To use Project 2010 to adjust schedules automatically and to do critical
path analysis, you must also enter task dependencies. After entering durations and task
dependencies, you can view the network diagram and critical path information. This section
describes how to use each of these time management features. It also explains the difference
between the new manual and automatic scheduling features of Project 2010.

Manual and Automatic Scheduling
If you have used earlier versions of Project, you probably noticed that when you entered a
task, it was automatically assigned a duration of one day, and Start and Finish dates were
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also automatically entered. This is still the case in Project 2010 if you use automatic sched-
uling for a task. If you use manual scheduling, no durations or dates are automatically
entered. The other big change with manual scheduling is that summary task durations are
not automatically calculated based on their subtasks when they are set up as manually
scheduled tasks. Figure A-21 illustrates these differences. Notice that the Manual subtask 1
had no information entered for its duration, start, or finish dates. Also note that the duration
for Manual summary task 1 is not dependent on the durations of its subtasks. For the
Automatic summary task, its duration is dependent on its summary tasks, and informa-
tion is entered for all of the durations, start, and end dates. You can switch between auto-
matic and manual scheduling for tasks in the same file, as desired, by changing the
Task Mode.

When you move your mouse over the Task Mode column (shown in the far left in Figure
A-21) Project 2010 displays the following information:

A task can be Manually Scheduled or Automatically Scheduled.
Manually Scheduled tasks have user-defined Start, Finish, and Duration values.
Project will never change their dates, but may warn you if there are potential
issues with the entered values.
Automatically Scheduled tasks have Start, Finish, and Duration values calculated
by Project based on dependencies, constraints, calendars, and other factors.

Project Help provides the following example of using both manual and automatic sched-
uling. You set up a preliminary project plan that s still in the proposal stage. You have a
vague idea of major milestone dates but not much detail on other dates in various phases
of the project. You build tasks and milestones using the Manually Scheduled task mode. The
proposal is accepted and the tasks and deliverable dates become more defined. You contin-
ue to manually schedule those tasks and dates for a while, but as certain phases become
well-defined, you decide to switch the tasks in those phases to the Automatically Scheduled
task mode. By letting Project 2010 handle the complexities of scheduling, you can focus
your attention on those phases that are still under development.

Entering Task Durations
When you enter a task, Project 2010 assumes it is manually scheduled, so no duration is
automatically entered. If you switch to the automatic scheduling mode, Project 2010 assigns
those tasks a default duration of one day, followed by a question mark. To change the
default duration, type a task s estimated duration in the Duration column. If you are unsure
of an estimate and want to review it again later, enter a question mark after it. For example,
you could enter 5d? for a task with an estimated duration of five days that you want to
review later. You can then use the Tasks With Estimated Durations filter to see quickly the
tasks for which you need to review duration estimates.

FIGURE A-21 Manual versus automatic scheduling
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To indicate the length of a task s duration, you must type both a number and an appro-
priate duration symbol. If you type only a number, Project 2010 automatically enters days
as the duration unit. Duration unit symbols include:

d = days (default)
w = weeks
m = minutes
h = hours
mo or mon = months
ed = elapsed days
ew = elapsed weeks

For example, to enter one week for a task duration, type 1w in the Duration column. (You
can also type wk, wks, week, or weeks, instead of just w.) To enter two days for a task dura-
tion, type 2d in the Duration column. The default unit is days, so if you enter 2 for the dura-
tion, it will be entered as 2 days. You can also enter elapsed times in the Duration column.
For example, 2ed means two elapsed days, and 2ew means two elapsed weeks. You would use
an elapsed duration for a task like Allow paint to dry. The paint will dry in exactly the same
amount of time regardless of whether it is a workday, a weekend, or a holiday.

T I P

If the Duration column is not visible, drag the split bar to the right until the Duration column
is in view.

Entering time estimates or durations might seem like a straightforward process. However,
you must follow a few important procedures:

To mark a task as a milestone, enter 0 for the duration. You can also mark tasks
that have a non-zero duration as milestones by checking the Mark task as
milestone option in the Task Information dialog box on the Advanced tab. You
simply double-click a task to access this dialog box. The milestone symbol for
those tasks will appear at their start date.
You can enter the exact start and finish dates for activities instead of entering
durations in the automatic scheduling mode. To enter start and finish dates, move
the split bar to the right to reveal the Start and Finish columns. You normally only
enter start and finish dates in this mode when those dates are certain.
If you want task dates to adjust according to any other task dates, do not enter
exact start and finish dates. Instead, enter durations and then establish depen-
dencies to related tasks.
To enter recurring tasks, such as weekly meetings, select Recurring Task from
the Task button under the Task tab, Insert group. Enter the task name, the
duration, and when the task occurs. Project 2010 will automatically insert
appropriate subtasks based on the length of the project and the number of tasks
required for the recurring task.
Project 2010 uses a default calendar with standard workdays and hours. Remem-
ber to change the default calendar if needed, as described later in this appendix.

A.26

Appendix A

      Copyright 2011 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). 

Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Licensed to:



Next, you will set task durations in the Project Tracking Database file (scope.mpp) that
you created and saved in the previous section. If you did not create the file named scope.
mpp, you can download it from the companion Web site for this text. You will create a new
recurring task and enter its duration, and then you will enter other task durations. First,
create a new recurring task called Status Reports above Task 15, Report performance.

To create a new recurring task:

1. Insert a recurring task above Task 15, Report performance. Open scope.mpp,
if necessary, and then click Report performance (Task 15) in the Task Name
column to select that task. Click the Tasks tab, if needed, and click the Tasks
button drop-down box under Insert group, and then click Recurring Task. The
Recurring Task Information dialog box opens.

2. Enter task and duration information for the recurring task. Type Status
Reports as the task title in the Task Name text box. Type 1h in the Duration
text box. Select the Weekly radio button under Recurrence pattern. Make sure
that 1 is entered in the Recur every list box. Select the Wednesday check box.
In the Range of recurrence section, type 2/1/11 in the Start text box, click the
End by radio button, and then type 6/15/11 in the End by text box. Click the
End by list arrow to see the calendar, as shown in Figure A-22. You can use the
calendar to enter the Start and End by dates. The new recurring task will
appear above Task 15, Report performance, when you are finished.

T I P

You can also enter a number of occurrences instead of an End by Date for a recurring task. You
might need to adjust the End by date after you enter all of your task durations and dependencies.
Remember, the date on your computer determines the date listed as Today in the calendar.

FIGURE A-22 Recurring Task Information dialog box
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3. View the new summary task and its subtasks. Click OK. Project 2010 inserts
a new Status Reports subtask in the Task Name column. Expand the new sub-
task by clicking the expand symbol to the left of Status Reports. To collapse
the recurring task, click the collapse symbol .

4. Adjust the columns shown and timescale. Move the split bar so that the entire
Finish column displays. Click the Zoom Out button (minus sign on the Zoom
Slider in the lower right of your screen) three times (or as many as needed)
to display the entire Gantt chart on your screen. Notice that the recurring task
appears on the appropriate dates on the Gantt chart, as shown in Figure A-23.

Use the information in Table A-3 to enter durations for the other tasks for the Project
Tracking Database project using automatic scheduling. The Project 2010 row number is
shown to the left of each task name in the table. Remember, you already entered a duration
for the recurring task. Also, remember that you should not enter durations for summary
tasks. When entering tasks in automatic scheduling mode, durations for summary tasks are
automatically calculated to match the durations and dependencies of subtasks, as described
further in the next section, Establishing Task Dependencies.

Recurring
task

Manual Scheduling mode Zoom Slider

Auto Schedule

FIGURE A-23 A recurring task
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To enter task durations for the other tasks:

1. Turn on automatic scheduling and enter the duration for Task 2. Click row
2 and drag down through row 41 to select all of those tasks. Click the Auto
Schedule button on the Ribbon under the Task group. Click the Duration col-
umn for row 2, Kickoff meeting, type 2h, and then press Enter.

T I P

You can also change the scheduling mode for individual tasks by changing that icon in the
Indicator column. For this file, we want all of the tasks to be automatically scheduled. If you
know that at the start, you can click the icon on the lower left of the screen to make all new
tasks automatically scheduled.

TABLE A-3 Durations for Project Tracking Database tasks

Task Number/Row Task Name Duration

2 Kickoff meeting 2h

3 Develop project charter 10d

4 Charter signed 0

6 Develop project plans 3w

7 Review project plans 4mo

8 Project plans approved 0

10 Analysis 1mo

11 Design 2mo

12 Implementation 1mo

13 System implemented 0

36 Report performance 6mo

37 Control changes 6mo

39 Prepare final project report 2w

40 Present final project 1w

41 Project completed 0
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2. Enter the duration for Task 3. In the Duration column for row 3, Develop proj-
ect charter, type 10d, and then press Enter. You can also just type 10, since d
or days is the default duration.

3. Enter remaining task durations. Continue to enter the durations using the
information in Table A-3. Be careful not to make entries in the wrong row.
Remember that the summary tasks are automatically entered, as is the recur-
ring task.

4. Save your file and name it. Click the File tab, and then click Save As. Enter
time as the filename, and then save the file to the desired location on your com-
puter or network. Your file should resemble Figure A-24. Remember that you
can use the Zoom Slider to adjust the timescale as needed. Notice that all of the
tasks still begin on February 1. This will change in the next section when we
add task dependencies. Keep this file open for the next set of steps.

Establishing Task Dependencies
To use Project 2010 to adjust schedules automatically and to do critical path analysis, you
must determine the dependencies or relationships among tasks. Project 2010 provides three
methods for creating task dependencies: using the Link Tasks button, using the Predeces-
sors column of the Entry table or the Predecessors tab in the Task Information dialog box,
or clicking and dragging the Gantt chart symbols for tasks with dependencies.

To create dependencies using the Link Tasks button , highlight tasks that are related
and then click the Link Tasks button on the toolbar. For example, to create a finish-to-start
dependency between Task 1 and Task 2, click any cell in row 1, drag down to row 2, and
then click the Link Tasks button. The default type of link is finish-to-start. In the Project
Tracking Database example, all the tasks use this default relationship. You will learn about
other types of dependencies later in this appendix.

FIGURE A-24 Time file with durations entered
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Selecting tasks is similar to selecting cells in Excel. To select adjacent tasks, click and drag
the mouse. You can also click the first task, hold down the Shift key, and then click the last
task. To select nonadjacent tasks, hold down the Control (Ctrl) key as you click tasks in
order of their dependencies.

When you use the Predecessors column of the Entry table to create dependencies, you
must manually enter the information. To create dependencies manually, type the task row
number of the preceding task in the Predecessors column of the Entry table. For example,
Task 3 in Table A-3 has Task 2 as a predecessor, which can be entered in the Predecessors
column, meaning that Task 3 cannot start until Task 2 is finished. To see the Predecessors
column of the Entry table, move the split bar to the right. You can also double-click the task,
click the Predecessors tab in the Task Information dialog box, and enter the predecessors
there. (This is more work than just typing it in the Predecessor column.)

You can also create task dependencies by clicking the Gantt chart symbol for a task and
then dragging to the Gantt chart symbol for a task that succeeds it. For example, you could
click the Milestone symbol for Task 4, hold down the left mouse button, and drag to
the Task Bar symbol for Task 6 to create a dependency, as shown in the Gantt chart in
Figure A-25. After entering a dependency, it shows up in the predecessors column and as
a line with an arrow connecting the dependent tasks on the Gantt chart.

Next, you will use information from Figure A-26 to enter the predecessors for tasks as
indicated. You will create some dependencies by manually typing the predecessors in the
Predecessors column, some by using the Link Tasks button, some by using the Gantt chart
symbols, and the remaining dependencies by using whichever method you prefer.

Gantt chart
symbolsLink Tasks

Predecessors
column

FIGURE A-25 Creating task dependencies
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To link tasks or establish dependencies for the Project Tracking Database project:

1. Display the Predecessors column in the Entry table. Move the split bar to the
right to reveal the full Predecessors column in the time.mpp file. Widen the
Task Name or other columns, if needed.

2. Highlight the cell where you want to enter a predecessor, and then type the
task number for the preceding task. Click the Predecessors cell for Task 3,
type 2, and press Enter. Notice that as you enter task dependencies, the Gantt
chart changes to reflect the new schedule.

3. Enter predecessors for Task 4. Click the Predecessors cell for Task 4, type 3,
and press Enter.

4. Establish dependencies using the Link Tasks button. To link Tasks 10 through
13, click the task name for Task 10, Analysis, and drag down through Task
13, System Implemented. Then, click the Link Tasks button on the Ribbon
under the Schedule group of the Task tab.

5. Create a dependency using Gantt chart symbols. Click the Milestone symbol
for Task 4 on the Gantt chart, hold down the left mouse button, and drag

to the Task Bar symbol for Task 6.
6. Enter remaining dependencies. Link the other tasks by either manually enter-

ing the predecessors into the Predecessors column, by using the Link Tasks
button, or by clicking and dragging the Gantt chart symbols. Note the visual
change highlighting feature that displays as you enter dependencies. You can
view the dependencies in Figure A-26. For example, Task 8 has Task 6 as a pre-
decessor, Task 10 has Task 8 as a predecessor, Task 39 has 13, Task 40 has
39, and Task 41 has 40 as a predecessor. If you have entered all data correctly,
the project should end on 7/19/11, or July 19, 2011.

7. Adjust screen elements. Move the position of the timescale and adjust columns
as needed so your screen resembles Figure A-26. Double-check your screen to
make sure you entered the dependencies correctly.

8. Preview and save your file. Click the File tab, and then select Print to pre-
view your file in the Backstage, as shown in Figure A-27. If you need to make
changes to the file before printing, click the Task tab to make changes, and
then save your file again by clicking the Save button on the Quick Access

FIGURE A-26 Project Tracking Database file with durations and dependencies entered
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toolbar. If you desire, print your file by clicking the Print button in the Back-
stage (or File tab). Keep the file open for the next set of steps.

Changing Task Dependency Types and Adding Lead or Lag Time
A task dependency or relationship describes how a task is related to the start or finish of
another task. Project 2010 allows for four task dependencies: finish-to-start (FS), start-to-
start (SS), finish-to-finish (FF), and start-to-finish (SF). By using these dependencies effec-
tively, you can modify the critical path and shorten your project schedule. The most com-
mon type of dependency is finish-to-start (FS). All of the dependencies in the Project
Tracking Database example are FS dependencies. However, sometimes you need to estab-
lish other types of dependencies. This section describes how to change task dependency
types. It also explains how to add lead or lag times between tasks. You will shorten the dura-
tion of the Project Tracking Database project by adding lead time between some tasks.

To change a dependency type, open the Task Information dialog box for that task by
double-clicking the task name. On the Predecessors tab of the Task Information dialog box,
select a new dependency type from the Type column list arrow.

The Predecessors tab also allows you to add lead or lag time to a dependency. You can
enter both lead and lag time using the Lag column on the Predecessors tab. Lead time
reflects an overlap between tasks that have a dependency. For example, if Task B can start
when its predecessor, Task A, is half-finished, you can specify a finish-to-start dependency
with a lead time of 50% for the successor task. Enter lead times as negative numbers. In this
example, enter 50% in the first cell of the Lag column. Adding lead times is also called fast
tracking and is one way to compress a project s schedule.

File tab shows the Backstage view of les

FIGURE A-27 Project Tracking Database file in the Backstage
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Lag time is the opposite of lead time; it is a time gap or delay between tasks that have
a dependency. If you need a two-day delay between the finish of Task C and the start of
Task D, establish a finish-to-start dependency between Tasks C and D and specify a two-day
lag time. Enter lag time as a positive value. In this example, type 2d in the Lag column.

In the Project Tracking Database example, notice that work on design tasks does not
begin until all the work on the analysis tasks has been completed (see Rows 10 and 11), and
work on implementation tasks does not begin until all the work on the design tasks has been
completed (see Rows 11 and 12). In reality, it is rare to wait until all of the analysis work
is complete before starting any design work, or to wait until all of the design work is finished
before starting any implementation work. It is also a good idea to add some additional time,
or a buffer, before crucial milestones, such as a system being implemented. To create a
more realistic schedule, add lead times to the design and implementation tasks and lag time
before the system implemented milestone.

To add lead and lag times:

1. Open the Task Information dialog box for Task 11, Design. In the Task Name
column, double-click the text for Task 11, Design. The Task Information dialog
box opens. Click the Predecessors tab.

2. Enter lead time for Task 11. Type -10% in the Lag column, as shown in
Figure A-28. Click OK. You could also type a value such as -5d to indicate a
five-day overlap. In the resulting Gantt chart, notice that the bar for this task
has moved slightly to the left. Also, notice that the project completion date has
moved.

3. Enter lead time for Task 12. Double-click the text for Task 12, Implementa-
tion, type -3d in the Lag column, and click OK. Notice that the project end date
has again changed.

FIGURE A-28 Adding lead or lag time to task dependencies
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4. Enter lag time for Task 13. Double-click the text for Task 13, System Imple-
mented, type 5d in the Lag column for this task, and click OK. Move the split
bar to the right, if necessary, to reveal the Predecessors column. Also adjust the
timescale using the Zoom Slider, if needed, to see all of the Gantt chart sym-
bols. When you are finished, your screen should resemble Figure A-29. Notice
the slight overlap in the taskbars for Task 10 and the short gap between the
taskbars for Tasks 11, 12, and 13. Also notice the changes in the Predecessors
column for tasks 11 and 12. The project completion date should be 7/19 after
these changes are made.

T I P

You can enter or modify lead or lag times directly in the Predecessors column of the Entry
table. Notice how the predecessors appear for Tasks 11, 12, and 13. For example, the Prede-
cessors column for Task 11 shows 10FS-10%. This notation means that Task 11 has a fin-
ish-to-start (FS) dependency with Task 10 and a 10% lead. You can enter lead or lag times
to task dependencies directly into the Predecessors column of the Entry table by using this
same format: task row number, followed by type of dependency, followed by the amount of
lead or lag.

5. Add tasks to the Timeline. Under Task Name, click Charter Signed, the task
name for Task 4. Click the Add to Timeline button under the Properties group
of the Task tab, as shown in Figure A-30. Notice that this task is now added to
the Timeline. Add the other milestones, Tasks 8, 13, and 41 to the Timeline.
The new Timeline feature makes it display high level schedule information. For
example, you might want to just show the timeline to senior management as
part of a presentation instead of a full Gantt chart. You can right-click the
Timeline and select Copy Timeline (or click the Copy Timeline button under
the Format tab) to easily copy it into an e-mail or presentation.

Slight overlap
due to lead time

Slight gap due
to lag time

FIGURE A-29 Schedule for Project Tracking Database file with lead and lag times
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6. Save your file. Click the Save button on the Quick Access toolbar. Keep this
file open for the next set of steps.

Gantt Charts
Project 2010 shows a Gantt chart as the default view to the right of the Entry table. Gantt
charts show the timescale for a project and all of its activities. In Project 2010, dependen-
cies between tasks are shown on the Gantt chart by the arrows between tasks. Many Gantt
charts, however, do not show any dependencies. Instead, as you might recall, network dia-
grams or PERT charts are used to show task dependencies. This section explains important
information about Gantt charts and describes how to make critical path information more
visible in the Gantt Chart view.

You must follow a few important procedures when working with Gantt charts:

To adjust the timescale, click the Zoom Out button or the Zoom In button on
the Zoom Slider . Clicking these buttons automatically makes the dates
on the Gantt chart show more or less information. For example, if the timescale
for the Gantt chart is showing months and you click the Zoom Out button, the
timescale will adjust to show quarters. Clicking Zoom Out again will display the
timescale in years. Similarly, each time you click the Zoom In button, the time-
scale changes to display more detailed time information from years to quar-
ters, quarters to months, and months to weeks.
You can also adjust the timescale and access more formatting options by clicking
on the Gantt chart and selecting the Format tab. For example, by checking the
Critical Task checkbox, critical tasks will display in red on the Gantt chart.
You can view a tracking Gantt chart by setting a baseline for your entire project
or for selected tasks and then entering actual durations for tasks. The Tracking

Task added to Timeline Add to Timeline

FIGURE A-30 Adding tasks to the Timeline
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Gantt view displays two taskbars, one above the other, for each task. One task-
bar shows planned or baseline start and finish dates, and the other taskbar
shows actual start and finish dates. You will find a sample Tracking Gantt chart
later in this appendix, after you enter actual information for the Project Track-
ing Database project.

Because you have already created task dependencies, you can now find the critical path
for the Project Tracking Database project. You can view the critical tasks by changing the
color of those items on the Gantt chart. Tasks on the critical path will automatically be red
in the Network Diagram view, as described in the following section.

To make the Gantt chart symbols for the critical path tasks appear in red:

1. Format the Gantt chart for critical tasks. Click the Format tab, and then click the
Critical Tasks check box under the Bar Styles group. The symbols for critical tasks
display in red on the Gantt chart. Your screen should resemble Figure A-31.

2. Format the text color for critical tasks. Click the Text Styles button under the
Format group. Click the Item to Change list arrow, and then select Critical
Tasks. Click the Color list arrow, and then select a different color, such as red,
as shown in Figure A-32. Click OK to accept the changes.

Text Styles Critical tasks display in redCritical Tasks checkbox

FIGURE A-31 Formatting the Gantt chart
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3. Save your file. Click Save on the Quick Access toolbar to save your file. It
should resemble Figure A-33. Keep this file open for the next set of steps.

Network Diagrams
The network diagrams in Project 2010 use the precedence diagramming method, with tasks
displayed in rectangular boxes and relationships shown by lines connecting the boxes. In
the Network Diagram view, tasks on the critical path are automatically shown in red.

To view the network diagram for the Project Tracking Database project:

1. View the network diagram. Click the View tab, and then click the Network
Diagram button under the Task Views group.

Select
Critical
Tasks

Select
Color

FIGURE A-32 Formatting text for critical tasks

Text and Gantt chart symbols for critical tasks, such as Tasks 2 and 3, 
should display in red on your computer.

FIGURE A-33 Formatted Gantt chart
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2. Adjust the Network Diagram view. To see more tasks in the Network Diagram
view, move the Zoom Out button on the Zoom Slider. Figure A-34 shows
several of the tasks in the Project Tracking Database network diagram. Note
that milestone tasks, such as Charter signed, appear as pointed rectangular
boxes, while other tasks appear as rectangles. Tasks on the critical path auto-
matically appear in red, while noncritical tasks appear in blue. Each task in the
network diagram also shows information such as the start and finish dates, task
ID, and duration. Move your mouse over the Charter signed box to see it in a
larger view. A dashed line on a network diagram represents a page break. You
often need to change some of the default settings for the Network Diagram view
before printing it.

3. Change the format/layout of the network diagram. Click the Format tab, and
then click the Layout button under the Format group. The Layout dialog box dis-
plays, as shown in Figure A-35. Note that you can change several layout options
for the network diagram, such as manually positioning boxes, changing the link
style, changing colors, and so on. Click OK to close the Layout dialog box.

FIGURE A-34 Network Diagram view

A.39

Guide to Using Microsoft Project 2010

      Copyright 2011 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). 

Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Licensed to:



4. Return to Gantt Chart view. Click the View tab, and then click the Gantt Chart
button under the Task Views group. Keep this file open for the next set of
steps.

T I P

Some users prefer to create or modify files in Network Diagram view instead of Gantt Chart
view. To add a new task or node in Network Diagram view, select the Task tab and then click
the Task button under the Insert group. Double-click the new node to add a task name and
other information. Create finish-to-start dependencies between tasks in Network Diagram
view by clicking the preceding node and dragging to the succeeding node. To modify the type
of dependency and add lead or lag time, double-click the arrow between the dependent
nodes.

Critical Path Analysis
The critical path is the path through the network diagram with the least amount of slack;
it represents the shortest possible time to complete the project. If a task on the critical path
takes longer than planned, the project schedule will slip unless time is reduced on a task lat-
er on the critical path. Sometimes you can shift resources between tasks to help keep a proj-
ect on schedule. Project 2010 has several views and reports to help analyze critical path
information.

Two particularly useful features are the Schedule table view and the Critical Tasks
report. The Schedule table view shows the early and late start dates for each task, the early

FIGURE A-35 Changing the network diagram layout
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and late finish dates for each task, and the free and total slack for each task. This informa-
tion shows how flexible the schedule is and helps in making schedule compression deci-
sions. The Critical Tasks report lists only tasks that are on the critical path for the project.
If meeting schedule deadlines is essential for a project, project managers will want to moni-
tor tasks on the critical path closely.

To access the Schedule table view and view the Critical Tasks report for a file:

1. View the Schedule table. Right-click the Select All button to the left of the Task
Name column heading and select Schedule. The Schedule table replaces the
Entry table to the left of the Gantt chart.

2. Reveal all columns in the Schedule table. Move the split bar to the right until
you see the entire Schedule table. Your screen should resemble Figure A-36.
This view shows the start and finish (meaning the early start and early finish)
and late start and late finish dates for each task, as well as free and total slack.
Right-click the Select All button and select Entry to return to the Entry table
view.

3. Open the Reports dialog box. Click the Project tab, and then click the Reports
button under the Reports group. Double-click Overview to open the Overview
Reports dialog box. Your screen should resemble Figure A-37.

Select All button

FIGURE A-36 Schedule table view
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4. Display the Critical Tasks report. Double-click Critical Tasks. A Critical Tasks
report as of today s date is displayed. You can click Page Setup in the Backstage
to adjust settings before printing.

5. Close the report and save your file. When you are finished examining the Criti-
cal Tasks report, click the Task tab. Save your file again by clicking Save on
the Quick Access toolbar. Close Project 2010 if you are not continuing to the
next section.

H E L P

If you want to download the Project 2010 file time.mpp to check your work or continue to
the next section, a copy is available on the companion Web site for this text, the author s
Web site, or from your instructor.

Now that you have entered task durations, established task dependencies, and reviewed the
network diagram and critical path information, you are ready to explore some of the Project
2010 cost management features.

P R O J E C T C O S T M A N A G E M E N T

Many people do not use Project 2010 for cost management. Most organizations have more
established cost management software products and procedures in place, and many people
simply do not know how to use the cost features of Project 2010. However, the cost features
of Project 2010 make it possible to integrate total project information more easily. This sec-
tion offers brief instructions for entering fixed and variable cost estimates and actual cost
and time information after establishing a baseline plan. It also explains how to use Project
2010 for earned value management. More details on these features are available in Project
2010 Help, online tutorials, or other texts.

T I P

To complete the steps in this section, you need to use the Project 2010 file resource.mpp
mentioned earlier. You can download it from the companion Web site for this text or from
the author s Web site under Book FAQs.

FIGURE A-37 Accessing the Critical Tasks report
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Fixed and Variable Cost Estimates
The first step to using the cost features of Project 2010 is entering cost-related information.
You enter costs as fixed or variable based on per-use material costs or variable based on the
type and amount of resources used. Costs related to personnel are often a significant part
of project costs.

Entering Fixed Costs in the Cost Table

The Cost table allows you to enter fixed costs related to each task. To access the Cost table,
right-click the Select All button in the Entry table and select Cost. You can also assign a per-use
cost to a resource that represents materials or supplies and use it as a base for calculating the
total materials or supplies cost of a task. See Project 2010 Help for details on this feature.

Entering Human Resource Costs

Human resources represent a major part of the costs on many projects. By defining and then
assigning human resources and their related costs to tasks in Project 2010, you can calcu-
late human resource costs, track how people are used, identify potential resource shortages
that could force you to miss deadlines, and identify underutilized resources. It is often possi-
ble to shorten a project s schedule by reassigning underutilized resources. This section
focuses on entering human resource costs and assigning resources to tasks. The following
section describes other features of Project 2010 related to human resource management.

Several methods are available for entering resource information in Project 2010. One
of the easiest is to enter basic resource information in the Resource Sheet, accessible from
the View tab. The Resource Sheet allows you to enter the resource name, initials, resource
group, maximum units, standard rate, overtime rate, cost/use, accrual method, base calen-
dar, and code. Entering data into the Resource Sheet is similar to entering data into an Excel
spreadsheet, and you can easily sort items by selecting Sort from the Project menu. In addi-
tion, you can use the Filter list on the Formatting toolbar to filter resources. Once you have
established resources in the Resource Sheet, you can assign those resources to tasks in the
Entry table with the list arrow that appears when you click a cell in the Resource Names col-
umn. The Resource Names column is the last column of the Entry table. You can also use
other methods for assigning resources, as described in the following steps.

Next, you will use the Project 2010 file time.mpp, which you saved in the preceding sec-
tion, to assign resources to tasks. (If you did not save your file, download it from the com-
panion Web site or from the author s Web site.) Assume that there are four people
working on the Project Tracking database project and that the only costs for this project are
for these human resources. Kathy is the project manager; John is the business analyst; Mary
is the database analyst; and Chris is an intern or trainee.

To enter basic information about each person into the Resource Sheet:

1. Display the Resource Sheet view. Open your Project 2010 file time.mpp, if nec-
essary. Click the View tab, and then click the Resource Sheet button under
the Resource Views group.

2. Enter resource information. Enter the information from Table A-4 into the
Resource Sheet. Type the information as shown and press the Tab key to move
to the next field. Notice that you are putting abbreviated job titles in the Initials
column: PM stands for project manager; BA, business analyst; DA, database
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analyst; and IN, intern. When you type the standard and overtime rates, you
can just type 50, and Project 2010 will automatically enter $50.00/hr. The stan-
dard and overtime rates entered are based on hourly rates. You can also enter
annual salaries by typing the annual salary number followed by /y for per
year. Leave the default values for the other columns in the Resource Sheet
as they are. Your screen should resemble Figure A-38 when you are finished
entering the resource data.

T I P

If you know that some people will be available for a project only part time, enter their per-
centage of availability in the Max Units column of the Resource Sheet. Project 2010 will then
automatically assign those people based on their maximum units. For example, if someone
can work only 25% of their time on a project throughout most of the project, enter 25% in the
Max Units column for that person. When you enter that person as a resource for a task, his
or her default number of hours will be 25% of a standard eight-hour workday, or two hours
per day.

Adjusting Resource Costs

To make a resource cost adjustment, such as a raise, double-click the person s name in the
Resource Name column, select the Costs tab in the Resource Information dialog box, and
then enter the effective date and raise percentage. You can also adjust other resource cost
information, such as standard and overtime rates.

FIGURE A-38 Resource Sheet view with resource data entered

TABLE A-4 Project Tracking Database resource data

Resource Name Initials Group Stand.
Rate

Ovt.
Rate

Kathy PM 1 $50.00/h $60.00/h

John BA 1 $40.00/h $50.00/h

Mary DA 1 $40.00/h $50.00/h

Chris IN 1 $20.00/h $25.00/h
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To give the project manager a 10% raise starting 4/1/11:

1. Open the Resource Information dialog box. In Resource Sheet view, double-
click Kathy in the Resource Name column. The Resource Information dialog
box opens.

2. Enter an effective date for a raise. Select the Costs tab, and then select tab A,
if needed. Type 4/1/11 in the second cell in the Effective Date column and press
Enter. Alternately, click the list arrow in the second cell and use the calendar
that appears to enter the effective date, April 1, 2011.

3. Enter the raise percentage. Type 10% in the second cell for the Standard Rate
column, and then press Enter. The Resource Information screen should resem-
ble Figure A-39. Notice that Project 2010 calculated the 10% raise to be $55.00
per hour. Click OK.

Assigning Resources to Tasks
For Project 2010 to calculate resource costs, you must assign the appropriate resources to
tasks in your WBS. There are several methods for assigning resources. The Resources col-
umn in the Entry table allows you to select resources using a list. You can use other methods
to assign resources, such as the Assign Resources button or the split window, which is the
recommended approach to have the most control over how resources are assigned because
Project 2010 makes several assumptions about resource assignments that might change
your schedule or costs. Next, you will use these three methods for assigning resources to the
Project Tracking Database project.

Assigning Resources Using the Entry Table

To assign resources using the Entry table:

1. Select the task to which you want to assign resources. Click the Gantt Chart
button on the View tab, and right-click the Select All button and click Entry
to return to the Entry table, if needed.

2. Reveal the Resource Names column of the Entry table. Move the split bar to
the right to reveal the entire Resource Names column in the Entry table.

FIGURE A-39 Adjusting resource costs

A.45

Guide to Using Microsoft Project 2010

      Copyright 2011 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). 

Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Licensed to:



3. Select a resource from the Resource Names column. In the Resource Names
column, click the cell associated with Task 2, Kickoff meeting. Click the cell s
list arrow, and then click the checkboxes next to John and Kathy to assign
them to Task 2, as shown in Figure A-40. Notice that the resource choices are
based on information that you entered in the Resource Sheet. If you had not
entered any resources, you would not have a list arrow or any choices to select.
Click in another cell to see the entered resources in the Resource column and
on the Task 2 Gantt chart symbol.

4. Clear the resource assignment. Click the Undo button on the Quick Access
toolbar to remove the resource assignments.

Assigning Resources Using the Resource Tab

To assign resources using the Resource tab:

1. Select the task to which you want to assign resources. In the second row of the
Task Name column, click Kickoff meeting, the task name for Task 2.

2. Open the Assign Resources dialog box. Click the Resource tab, and then click
the Assign Resources button in the Assignments group. The Assign Resources
dialog box, as shown in Figure A-41, displays.

FIGURE A-40 Assigning resources using the Resource column

FIGURE A-41 Assign Resources dialog box
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3. Assign Kathy to Task 2. Click Kathy in the Resource Name column of the
Assign Resources dialog box, and then click Assign. Notice that the duration
estimate for Task 2 remains at 2 hours, and Kathy s name appears on the Gantt
chart by the bar for Task 2.

4. Assign John to Task 2. Click John in the Resource Name column of the Assign
Resources dialog box, and then click Assign. Click Close in the Assign
Resources dialog box. Notice that the duration for Task 2 remains at 2 hours,
but an Exclamation point appears in the Indicator column for Task 2, as shown
in Figure A-42. The default selection is to Increase total work because the task
requires more person-hours. Keep duration constant. That is what you want,
so click that option, and the indicator symbol disappears. This feature is a big
change from previous versions of Microsoft Project, which automatically
reduced the duration when more resources were added.

T I P

Project 2010 includes a multiple-level undo feature, so you can click the Undo button on the
Quick Access toolbar several times to undo several steps in your file.

Assigning Resources Using the Split Window

Even though using the Assign Resources button seems simple, it is often better to use a split
when assigning resources. When you assign resources using the split view, you have more
control over how you enter information and can visually see the cost table and Gantt chart
changes in the top window as you assign each resource in the bottom window.

To assign both Kathy and John to attend the two-hour kickoff meeting using the split
window:

1. Open the Cost table view. Right-click the Select All button, and then click Cost
to reveal the Cost table. Notice that Task 2 shows a cost of $180 after assigning
Kathy and John to it.

2. Split the window to reveal more information. Click the Details button under
the Properties group of the Resource tab. The Gantt Chart view is displayed at the
top of the screen and a resource form is displayed at the bottom of the screen.

3. Assign Kathy to Task 3. Select Task 3, Develop project charter in the top win-
dow, and then click the Assign Resources button, select Kathy, and Close the

FIGURE A-42 Indicator column options
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dialog box. Notice the changes in both windows, as shown in Figure A-43. By
default, resources are assigned to work full-time on tasks, so 80 hours, or two
weeks of full-time work, are entered for Kathy, and a cost of $4,000 is entered
in the cost table. However, you only want to enter 40 hours for this task but
leave its duration at two weeks.

4. Make Task 3 a manually scheduled task and change Kathy s hours to 80. With
Task 3 selected, click the Task tab, and then click the Manually Schedule but-
ton under the Task group. In the bottom window, click the cell for the Work col-
umn in the bottom window for Task 2, and type 40h instead of 80h. Press OK.
Notice that the cost for Task 2 changed from $4,000 to $2,000, but the duration
for the task remained the same. If you left the task as automatically scheduled,
its duration would have been shortened. You could assign all of the resources
and then change the hours for one person at a time using the split screen.

5. Close the file and do not save it. Close the file, but do not save the changes you
made. Other resource information has been entered for you in the Project
2010 file named resource.mpp.

H E L P

A copy of the Project 2010 file resource.mpp is available on the companion Web site for this
text, from the author s Web site under Book FAQs, or from your instructor. You must use
this file to continue the steps in the next section.

As you can see, you must be careful when assigning resources and scheduling tasks. Project
2010 assumes that the durations of automatically scheduled tasks are not fixed, but are effort
driven, and this assumption can create some problems when you are assigning resources.

FIGURE A-43 Split screen for entering resource information
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Viewing Project Cost Information

Once you enter resource information, Project 2010 automatically calculates resource costs
for the project. There are several ways to view project cost information. You can view the
Cost table to see cost information, or you can run various cost reports. Next, you will view
cost information for the Project Tracking Database project.

To view cost information:

1. Open resource.mpp. Download resource.mpp from the companion Web site
or the author s site. Open the file.

2. Open the Cost table. Right-click the Select All button, and then click Cost. The
Cost table displays various cost information. Your screen should resemble Fig-
ure A-44. Note that by assigning resources, costs have been automatically cal-
culated for tasks. You could also enter fixed costs for tasks by simply typing
them into the appropriate cell in the cost table.

3. Open the Cost Reports dialog box. Click the Project tab, and then click
Reports. Double-click Costs to display the Cost Reports dialog box.

4. Set the time units for the report. Click Cash Flow, if necessary, and then click
Edit. The Crosstab Report dialog box is displayed. Click the Column list arrow
to see other options, but leave it at months, as shown in Figure A-45. Some-
times you need to edit default settings to make reports meet user needs. Click OK.

FIGURE A-44 Cost table for the resource file
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5. View the Cash Flow report. Click Select in the Cost Reports dialog box. A Cash
Flow report for the Project Tracking Database project appears in the Backstage,
as shown in Figure A-46. Notice how it displays by WBS by month. Click the
Project tab to close the report and return to the Gantt Chart view.

6. View the Project Summary report. Click the Reports button again, double-click
Overview, and then double-click Project Summary. A Project Summary report
for the Project Tracking Database project is displayed, listing information such
as project baseline start and finish dates; actual start and finish dates; summa-
ries of duration, work hours, and costs; as well as variance information.
Because you have not yet saved the file as a baseline, much of this information
is blank in the report. The Project Summary report provides a high-level

FIGURE A-45 Crosstab Report dialog box

FIGURE A-46 Cash Flow report
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overview of a project. Click the Project tab to close the report after reviewing
it. Experiment with other reports, as desired. Keep this file open for the next set
of steps.

T I P

You can edit many of the report formats in Project 2010. Instead of double-clicking the
report, select the desired report, and then click Edit.

The total estimated cost for this project, based on the information entered, should be
$48,944.80, as shown in the Cash Flow and Project Summary reports. In the next section,
you will save this data as a baseline plan and enter actual information.

Baseline Plan, Actual Costs, and Actual Times
Once you complete the initial process of creating a plan entering tasks, establishing depen-
dencies, assigning costs, and so on you are ready to set a baseline plan. By comparing the
information in your baseline plan to an updated plan during the course of the project, you can
identify and solve problems. After the project ends, you can use the baseline and actual infor-
mation to plan similar, future projects more accurately. To use Project 2010 to help control
projects, you must establish a baseline plan, enter actual costs, and enter actual durations.

Establishing a Baseline Plan

An important part of project management is setting a baseline plan. If you plan to compare
actual information such as durations and costs, you must first save the Project 2010 file as a
baseline. Before setting a baseline, you must complete the baseline plan by entering time, cost,
and human resources information. Be careful not to set a baseline until you have completed
the baseline plan. If you do save a baseline before completing the baseline plan, Project 2010
allows you to save up to ten baselines. You can then clear unwanted baseline plans.

Even though you can clear a baseline plan or save multiple baselines, it is a good idea
to save a separate, backup file of the original baseline for your project. Enter actuals and
save that information in the main file, but always keep a backup baseline file without
actuals. Keeping separate baseline and actual files will allow you to return to the original file
in case you ever need to use it again.

To rename resource.mpp and then save it as a baseline plan in Project 2010:

1. Save resource.mpp as a new file named baseline.mpp. Click the File tab, and
then click Save As. Type baseline as the filename, and then click Save. You can
also download the baseline.mpp file from the Web site.

2. Open the Save Baseline dialog box and save as a baseline. Click the Project tab, click
the Set Baseline button under the Schedule group, and click Set Baseline. Click the
Baseline list arrow to reveal multiple baselines, as shown in Figure A-47. Notice that
you can save up to ten baselines, and you can change the options if you do not want
to save the Entire project. Also notice that after you set the baseline, the cost numbers
in the Baseline column are updated. Keep the default settings, and click OK.
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T I P

There are several options in the Save Baseline dialog box, as shown in Figure A-47. You can
save the file as an interim plan if you anticipate several versions of the plan. You can also
select the entire project or selected tasks when saving a baseline or interim plan. As men-
tioned above, you can save up to ten baselines with Project 2010.

Entering Actual Costs and Times

After you set the baseline plan, you can track information on each of the tasks as the project
progresses. You can also adjust planned task information for tasks still in the future. The
Tracking table displays tracking information, and the Ribbon provides icons to help you
enter this information. Figure A-48 describes each Tracking button.

FIGURE A-47 Set Baseline dialog box
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To practice entering actual information, enter just a few changes to the baseline.
Assume that Tasks 1 through 8 were completed as planned, but that Task 10 took longer
than planned. First you need to change the tasks to be automatically scheduled so the actual
information, such as a critical task taking longer than planned, automatically adjusts any
dependent tasks.

To enter actual information for tasks:

1. Return to the Task tab and make the tasks automatically scheduled. Click
the Task tab, where the tracking buttons are located. Click the task name for
Task 2, drag down through the task name for Task 41, and then click the Auto
Schedule button under the Tasks group.

2. Display the Tracking table. Right-click the Select All button, and then click
Tracking to see more tracking-related information as you enter actual data.
Widen the Task Name column to see all of the text, and then move the split bar
to reveal all the columns in the Tracking table. Make other adjustments as
needed so your screen resembles Figure A-49.

Button Name Description

0% Complete Marks the selected tasks as 0% complete.

25% Complete Marks the selected tasks as 25% complete.

50% Complete Marks the selected tasks as 50% complete.

75% Complete Marks the selected tasks as 75% complete.

100% Complete Marks the selected tasks as 100% complete.

Mark on Track Marks the selected tasks so that they are on schedule.
Set the status date on the Project tab to control what
date is used in this calculation.

Update Tasks Shows the Update Tasks dialog box. You can update
information for the selected tasks, such as mark
percent complete, set actual or remaining duration,
modify actual start and finish dates, and create notes.

FIGURE A-48 Tracking buttons
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3. Set the Status Date. Click the Project tab, and then click the Status Date but-
ton under the Status Group. Type 4/15/11, and then click OK. It is important
to set the status date to make the tracking features work properly.

4. Mark Tasks 1 though 8 as 100% complete. Click the Task tab. Click the Task
Name for Task 1, Initiating, and drag down through Task 8 to highlight the first
eight tasks. Click the 100% Complete button under the Schedule group on
the Ribbon. The columns with dates, durations, and cost information should
now contain data instead of the default values, such as NA or 0. The % Comp
column should display 100%. Adjust column widths if needed. Your screen
should resemble Figure A-50. Note that you could also use the Mark on Track
button to get the same results.

FIGURE A-49 Tracking table
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5. Enter actual completion dates for Task 10. Click the Task Name for Task 10,
Analysis, and then click the Mark on Track drop-down, and select Update
Tasks. The Update Tasks dialog box opens. For Task 10, enter the Actual Start
date as 3/10/11 and the Actual Finish date as 4/15/11, as shown in Figure A-51.
Click OK. Notice how the information in the tracking sheet has changed and that
the project completion date has moved from 7/19 to 7/29 because Task 10 was
a critical task.

6. View the Variance table. Right-click the Select All button, and then select Vari-
ance to display the Variance table. Adjust column widths, move the split bar,
and adjust the Zoom Slider as needed so your screen resembles Figure A-52.
Notice that there is now a finish variance of 8.05 days.

100% complete

FIGURE A-50 Tracking table information

FIGURE A-51 Update Tasks dialog box
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7. Review changes using the Tracking Gantt chart. Click the Gantt chart drop-
down under the View group of the Task tab, and then click Tracking Gantt.
Move the split bar to the left to reveal more of the Gantt chart, and adjust the
Zoom slider and other screen elements until your screen resembles Figure A-53.
Notice that the Gantt chart bars for completed tasks have changed. There are
also a few new symbols, such as white diamonds, representing slipped milestones,
for Tasks 13 and 41. Because the Analysis task preceded others on the critical
path, such as Design, Implementation, and so on, they were delayed in starting. A
good project manager would take corrective action to make up for this lost time
or renegotiate the completion date.

8. Review the cost table and enter actual costs. Right-click the Select All button,
and then select Cost to display the Cost table. Move the split bar to the right,
if needed, to display all of the columns. Notice that the Actual costs for tasks
1 through 8 are the same as the Baseline costs because they were entered as

Slipped milestones

FIGURE A-53 Tracking Gantt chart

FIGURE A-52 Variance table
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100% complete. Also notice that the Actual cost for task 10, which took longer
than planned, seems very high. Project 2010 makes several assumptions in cal-
culating costs. In this case, we want to enter our own Actual cost. First click
Task 10 and make it manually scheduled by clicking the Task tab and then
clicking the Manually Schedule button under the Schedule group. Type
10,000 in the Actual column for task 10, Analysis. Notice the changes in the
Cost table, as shown in Figure A-54.

9. Save your file as a new file named tracking.mpp. Click the File tab, and then
click Save As. Name the file tracking, and then click Save.

After you have entered some actuals, you can also review earned value information, as
described in the next section.

Earned Value Management
Earned value management is an important project management technique for measuring
project performance. Because you have entered actual information for some of the tasks in
the Project Tracking Database project, you can now view earned value information in Proj-
ect 2010. You can also view an earned value report using the visual reports feature.

To view earned value information:

1. View the Earned Value table. Using the tracking.mpp file, right-click the Select
All button, and then select More Tables. The More Tables dialog box opens.
Double-click Earned Value.

2. Display all the Earned Value table columns. Move the split bar to the right to
reveal all of the columns, as shown in Figure A-55. Note that the Earned Value
table includes columns for each earned value acronym, such as SV, CV, and
so on, as explained in this text. Also note that the EAC (Estimate at Comple-
tion) is higher than the BAC (Budget at Completion) starting with Task 9,

FIGURE A-54 Updated Cost table
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where the task took longer than planned to complete. Task 0, which represents
the entire project, shows a CV of $2,050.30 and a SV of $6,544.40. Remember
that not all of the actual information has been entered yet.

3. View the earned value chart. Click the Project tab, and then click the Visual
Reports button under the Reports group to open the Visual Reports dialog box.
Click Earned Value Over Time Report, as shown in Figure A-56. Notice the
sample of the selected report on the right side of the dialog box. If you have
Excel, click View to see the resulting report as Project 2010 automatically cre-
ates Excel data and a chart based on your current file. Close Excel without sav-
ing the file, and then click the Close button of the Visual Reports dialog box.

FIGURE A-55 Earned Value table
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H E L P

To take full advantage of the visual reports features, you must have specific software
installed on your computer. You may also need to adjust data, such as displaying weeks or
months versus quarters, to get the reports to display as desired.

4. Save and close the file. Click the Save button on the Quick Access toolbar,
and then close the tracking.mpp file. You can also exit Project 2010 and take
a break, if desired.

H E L P

If you want to download the Project 2010 files baseline.mpp and tracking.mpp to check your
work or continue to the next section, a copy is available on the companion Web site, the
author s Web site, or from your instructor.

Now that you have entered and analyzed various project cost information, you will examine
some of the human resource management features of Project 2010.

FIGURE A-56 Visual Reports dialog box
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P R O J E C T H U M A N R E S O U R C E M A N A G E M E N T

In the project cost management section, you learned how to enter resource information into
Project 2010 and how to assign resources to tasks. Two other helpful human resource fea-
tures include resource calendars and histograms. In addition, it is important to know how
to use Project 2010 to assist in resource leveling. You will also explore the new Team Plan-
ner feature, which can also help to level resources.

Resource Calendars
When you created the Project Tracking Database file, you used the standard Project 2010
calendar. This calendar assumes that standard working hours are Monday through Friday,
from 8:00 a.m. to 5:00 p.m., with an hour for lunch starting at noon. Rather than using this
standard calendar, you can create a different calendar that takes into account each project s
unique requirements. You can create a new calendar by using the Tasks pane or by chang-
ing the working time under the Tools menu.

To create a new base calendar:

1. Open a new file and access the Change Working Time dialog box. After open-
ing a blank file in Project 2010, click the Project tab, and then click the Change
Working Time button under the Properties group. The Change Working Time
dialog box opens, as shown in Figure A-57.

FIGURE A-57 Change Working Time dialog box
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2. Name the new base calendar. In the Change Working Time dialog box, click
Create New Calendar. The Create New Base Calendar dialog box opens. Click
the Create new base calendar radio button, type Mine as the name of the new
calendar in the Name text box, and then click OK. Click the Options button,
and then make desired changes, such as changing the month when the fiscal
year starts. Click OK to close the Change Working Time dialog box.

You can use this new calendar for the whole project, or you can assign it to specific
resources on the project.

To assign the new calendar to the whole project:

1. Open the Project Information dialog box. Click the Project tab, and then click
the Change Working Time button. The Project Information dialog box opens.

2. Select a new calendar. Click the Calendar list arrow to display a list of avail-
able calendars. Select your new calendar named Mine from this list, and then
click OK.

To assign a specific calendar to a specific resource:

1. Assign a new calendar. Click the View tab, and then click the Resource Sheet
button under the Resource Views group. Type Me in the Resource Name col-
umn, and press Enter.

2. Select the calendar. Click the Base Calendar cell for that resource name. If the
Base Calendar column is not visible, click the horizontal scroll bar to view more
columns. Click the Base Calendar list arrow to display the options, and then
select Mine, if needed.

3. Block off vacation time. Double-click the resource name Me to display the
Resource Information dialog box, and then click the Change Working Time
button, located on the General tab in the Resource Information dialog box. You
can block off vacation time for people by selecting the appropriate days on the
calendar and marking them as nonworking days. Click OK to accept your
changes, and then click OK to close the Resource Information dialog box.

4. Close the file without saving it. Click the Close icon, and click No when you
are prompted to save the file.

Resource Histograms
A resource histogram is a type of chart that shows the number of resources assigned to a
project over time. A histogram by individual shows whether a person is over- or underallo-
cated during certain periods. The Resource Graph helps you see which resources are overal-
located, by how much, and when. It also shows you the percentage of capacity each
resource is scheduled to work, so you can reallocate resources, if necessary, to meet the
needs of the project.

To view resource histograms for the Project Tracking Database project:

1. View the Resource Graph. Open the baseline.mpp file, and click the View tab,
if necessary. Click the Other Views button under the Resource Views group,
and then click the Resource Graph button . A histogram for Chris appears,
as shown in Figure A-58. The screen is divided into two sections: the left pane
displays a person s name and the right pane displays a resource histogram for
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that person. You may need to click the right scroll bar to get the histogram to
appear on your screen. Notice that Kathy is overallocated slightly in the month
of June, because the column for that month goes above the 100% line.

2. View the other resources histograms. Click the left scroll arrow at the bottom
of the resource name pane on the left side of the screen. The resource histo-
gram for the next person appears. View the resource histograms for all four
people, and then go back Kathy s. Click the Zoom In button several times
until the information is displayed in days. Move the scroll bar until you see the
information for the first day of the project, as shown in Figure A-59.

Click to access other resource graphs Move scroll bar and adjust timescale as needed

FIGURE A-58 Resource Graph view

Overallocation

FIGURE A-59 Resource Graph showing an overallocation
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Notice that Kathy s histogram has a partially red bar on the first day of the project. This
red portion of the bar means that she has been overallocated that day. The percentages at
the bottom of each bar show the percentage each resource is assigned to work. For example,
Kathy is scheduled to work 107% of her available time the first day, and 62% of her available
time the next several days. You can use the Resource Usage view to see more details on the
overallocation.

To see more details about an overallocated resource using the Resource Usage view:

1. Display the Resource Usage view. Click the Resource Usage button under
the Resource Views group on the Ribbon.

2. Adjust the information displayed. On the right side of the screen, click the
scroll arrows to display the hours Kathy is assigned to work each day. Widen
the Resource Name column and make other adjustments as needed so your
screen resembles Figure A-60.

3. Examine overallocation information. Notice in the Resource Usage view (Figure
A-60) that Kathy is only scheduled to work 5.57h on the first day of the project.
Although Kathy is not scheduled to work more than eight hours on that day, some
of the tasks were entered as hours, and Project 2010 assumes those hours start as
soon as possible, thus causing the scheduling conflict. Also notice that Mary is overal-
located. Next, you will remove the overallocations by using resource leveling.

Resource Leveling
Resource leveling is a technique for resolving resource conflicts by delaying tasks. Resource
leveling also creates a smoother distribution of resource usage. You can find detailed infor-
mation on resource leveling in the Help facility.

FIGURE A-60 Resource Usage view
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To use resource leveling:

1. View Kathy s Resource Graph again. Click the Resource Graph button under
the View tab to view Kathy s histogram again. Make adjustments as needed to
see the graph for the first day of the project. Remember that just Kathy and
Mary showed overallocations.

2. Open the Resource Leveling dialog box. Click the Resource tab, and then click
Leveling Options. The Level Resources dialog box opens, as shown in Figure A-61.

3. Level using the Hour by Hour option. Change the basis for leveling from Day
by Day to Hour by Hour, click the Level All button, keep the other default
options in the Level Now dialog box. Notice that Kathy s overallocation disap-
pears. Click the scroll arrow in the resource name pane to reveal information
about other resources to see that their overallocations are gone as well.

Change to
Hour by Hour

FIGURE A-61 Resource Leveling dialog box
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T I P

If you want to undo the leveling, immediately click the Undo button on the Standard toolbar.
Alternatively, you can return to the Resource Leveling dialog box, and click the Clear Level-
ing button.

4. Save the file as level.mpp. Click the File tab, click Save As, type level as the
filename, and then click Save. Close the file and Project 2010.

H E L P

If you want to download the Project 2010 file level.mpp to check your work or continue to
the next section, a copy is available on the companion Web site, the author s Web site, or
from your instructor.

Consult the Project 2010 Help feature and use the keyword level for more information
on resource leveling. Also, when setting options for this feature, be careful that the software
adjusts resources only when it should. For example, the end date for a project might be
pushed back if you set the leveling options not to level only within available slack. In this
case, the project manager might prefer to ask his or her team to work a little overtime to
remain on schedule.

Using the New Team Planner Feature*

Another way to assign resources and reduce overallocations is by using the new Team Planner
feature. Assume you have two people assigned to work on a project, Brian and Cindy, as shown
in Figure A-62. Notice that Brian is assigned to work on both Task 1 and Task 2 full-time the first
week. Therefore, Brian is overallocated. Cindy is scheduled to work on Task 3 full-time the sec-
ond week, and Task 4, also scheduled for the second week, is not assigned yet.

You can click the Team Planner view under the View tab to see a screen similar to the
top section of Figure A-63. Notice that Brian has both Tasks 1 and 2 assigned to him at the
same time. These tasks and Brian s name display in red to show the overallocation. Cindy is
assigned Task 3 the following week, and Task 4 is unassigned. By simply clicking and dragging
Task 4 straight up so it is under Brian in Week 2 and dragging Task 2 straight down so it is
under Cindy in Week 1, you can reassign those tasks and remove Brian s overallocation, as
shown in the bottom section of Figure A-63. Many people will appreciate the simplicity of this
new feature!

Overallocated

FIGURE A-62 Overallocated resource

*From Schwalbe s An Introduction to Project Management, Third Edition, 2010.
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Now that you have learned how to change resource calendars, view resource histo-
grams, and level resources, you are ready to learn how to use Project 2010 to assist in proj-
ect communications management.

P R O J E C T C O M M U N I C A T I O N S M A N A G E M E N T

Project 2010 can help you generate, collect, disseminate, store, and report project informa-
tion. There are many different tables, views, reports, and formatting features to aid in proj-
ect communications, as you have seen in the previous sections. This section highlights
some common reports and views. It also describes how to use templates and insert hyper-
links from Project 2010 into other project documents and how to use Project 2010 in a
workgroup setting.

Common Reports and Views
To use Project 2010 to enhance project communications, it is important to know when to
use the many different ways to collect, view, and display project information. Table A-5 pro-
vides a brief summary of Project 2010 features and their functions, which will help you
understand when to use which feature. Examples of most of these features are provided as
figures in this appendix.

You can see from Table A-5 that many different reports are available in Project 2010.
The overview reports provide summary information that top management might want to
see, such as a project summary or a report of milestone tasks. Current activities reports help
project managers stay abreast of and control project activities. The reports of unstarted
tasks and slipping tasks alert project managers to problem areas. Cost reports provide infor-
mation related to the cash flow for the project, budget information, overbudget items, and
earned value management.

Before moving tasks in the Team Planner View:

After moving tasks in the Team Planner View:

FIGURE A-63 Adjusting resource assignments using the Team Planner feature
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TABLE A-5 Functions of Project 2010 Features

Feature Function

Gantt Chart view, Entry table Enter basic task information

Network Diagram view View task dependencies and critical
path graphically

Schedule table View schedule information in a
tabular form

Cost table Enter fixed costs or view cost
information

Resource Sheet view Enter resource information

Resource Information and
Gantt Chart split view

Assign resources to tasks

Team Planner Help remove resource overallocations

Set Baseline Save project baseline plan

Earned Value table View earned value information

Resource Graph View resource allocation

Resource Usage View detailed resource usage

Resource Leveling Level resources

Overview Reports View project summary, top-level tasks,
critical tasks, milestones, working days

Current Activities Reports View unstarted tasks, tasks starting soon,
tasks in progress, completed tasks,
should-have-started tasks, slipping tasks

Cost Reports View cash flow, budget, overbudget tasks,
overbudget resources, earned value

Assignment Reports View who does what, who does what when,
to-do list, overallocated resources

Workload Reports View task usage, resource usage

Custom Reports Allow customization of each type of report

Insert Hyperlink Insert hyperlinks to other files or
Web sites
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Assignment reports help the entire project team by providing different views of who is
doing what on a project. You can see who is overallocated by running the Overallocated
Resources report or by viewing the two workload reports. You can also create custom
reports based on any project information you have entered into Project 2010.

Using Templates and Inserting Hyperlinks and Comments
This text provides examples of many templates that you can use to improve project commu-
nications. Because it is often difficult to create good project files, many organizations keep
a repository of template or sample files. As shown earlier in this appendix, Project 2010
includes several template files, and you can also access several templates online. You must
load the template files when installing Project 2010 or access templates via the Internet.

To access the Project 2010 templates:

1. Access Project 2010 templates. Start Project 2010, if necessary, click the
File tab, and then click New to display the Available Templates, as shown in
Figure A-64.

2. Access templates from Office.com. Click the Schedules icon in the Office.com
Templates section at the bottom of the screen, as shown in Figure A-65. A list
of templates available at the time appears. Experiment with finding and using
various template files in Project 2010.

FIGURE A-64 Opening templates
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Using templates can help you prepare your project files, but be careful to address the
unique needs of your project and organization. For example, even though the Home Move
template file can provide guidance in preparing a Project 2010 file for a specific home move
project, you need to tailor the file for your particular situation and schedule. You can also
create your own Project 2010 templates by saving your file as a template using the Save
As option from the File menu. Simply change the Save As Type option to Template. Project
2010 then gives the file an .mpt extension (Microsoft Project Template) to identify the file
as a template.

In addition to using templates for Project 2010 files, it is helpful to use templates for
other project documents and insert hyperlinks to them from Project 2010. For example,
your organization might have templates for meeting agendas, project charters, status
reports, and project management plans. See the companion Web site for examples of other
template files. Next, you will create hyperlinks to some template files created in other
applications.

To insert a hyperlink within a Project 2010 file:

1. Display the Entry table. Open the baseline.mpp file. The Entry table and Gantt
Chart view should display.

2. Select the task in which you want to insert a hyperlink. Under Task Name,
click Kickoff meeting, the task name for Task 2.

3. Open the Insert Hyperlink dialog box. Right-click the task name, and then click
Hyperlink. The Insert Hyperlink dialog box opens, as shown in Figure A-66.

FIGURE A-65 Schedules templates from Office.com
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4. Enter the filename of the hyperlink file. Click the Browse for File button to
browse for the kickoffmeeting.doc file you downloaded earlier. Double-click
kickoffmeeting.doc, and then click OK.

5. Review the Indicators column. A Hyperlink icon appears in the Indicators
column to the left of the Task Name for Task 2, next to the Overallocation icon.
Move your mouse over the hyperlink icon until the mouse pointer changes to
the Hand symbol to reveal the name of the hyperlinked file.

Clicking the Hyperlink button in the Indicators column or right-clicking, pointing to
Hyperlink, and selecting Open will automatically open the hyperlinked file. Using hyperlinks
is a good way to keep all project documents organized.

It is also a good idea to insert notes or comments into Project 2010 files to provide more
information on specific tasks.

To insert a note for Task 4:

1. Open the Task Information dialog box for Task 4. Under Task Name, double-
click Charter signed, the task name for Task 4. Click the Notes tab.

2. Enter your note text. Type The charter was developed as a joint effort. in the
Notes text box, as shown in Figure A-67.

Browse for File

FIGURE A-66 Insert Hyperlink dialog box
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3. See the resulting Notes icon. Click OK to enter the note. The Notes icon
appears in the Indicators column next to Task 4.

4. Open the note. Double-click the Notes icon in the Indicators column for Task
4 to view the note, and then click OK.

5. Close the file without saving it. Click Close, and then click No when you are
prompted to save the file.

As you can see, Project 2010 is a very powerful tool. If used properly, it can greatly help
users successfully manage projects.

FIGURE A-67 Task Information dialog box Notes tab
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D I S C U S S I O N Q U E S T I O N S

1. What are some new features of Project 2010, and how do they differ from previous versions
of Microsoft Project?

2. How do you use Project 2010 to create a WBS hierarchy?

3. Summarize how you use Project 2010 to assist in time management. How do you enter dura-
tions, link tasks, and view critical path information?

4. How can Project 2010 assist you in project cost management? What table view would you
use to enter fixed costs? How do you enter resources and assign them to tasks? How can
you view earned value information?

5. Briefly describe how to change resource calendars, view resource histograms, and level
resources. How can you use the new Team Planner feature?

6. Summarize ways to communicate information with Project 2010. How do you link to other
files from within your Project 2010 file? How can you find and use templates?

E X E R C I S E S

The more you practice using the features of Project 2010, the more quickly you will master the
application and use it to manage projects. This section includes an exercise that you can do as
a series of two homework assignments to make sure you understand the steps and concepts in
this appendix. There are also exercises based on three examples of information technology pro-
jects that could benefit from using Project 2010 to assist in project scope, time, cost, human
resource, and communications management. This section also includes an exercise you can use
to apply Project 2010 on a real project. Simpler exercises that use Project 2010 are at the end
of several chapters in this text.

Exercise A-1: Homework Assignments
You can go through this appendix as a series of homework assignments. The following two
assignments are used by the author of this text in her classes. Instructors can easily change which
items to print out or modify instructions to make this assignment more unique.

HW1: Project 2010, Part 1 (100 points, 25 points for each item)

See points for each item listed below. Note that you can download a free trial of Project 2010 from
www.microsoft.com or use the PCs at school. Remember that you must be running Windows 7,
Vista, or XP. Read and follow the hands-on instructions in this Guide to Using Project 2010. Read
the first several pages of the appendix, do all the steps starting under the Overview of Project
2010 heading, and stop after you finish the steps right before the heading called Baseline Plan,
Actual Costs, and Actual Times. The files mentioned are on the companion Web site and the
author s site (www.kathyschwalbe.com under Book FAQs on the left). In the section on Project
Scope Management, Table A-2 lists the first task as Initiating. After the word Initiating, enter your
first and last name (e.g., Initiating Kathy Schwalbe). Continue doing all of the steps, and print out
only the items described below.

A.72

Appendix A

      Copyright 2011 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). 

Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Licensed to:



1. Your formatted Gantt chart, Figure A-33. Be sure it fits on one page before printing
and that all the columns shown are visible.

2. The Schedule Table view, Figure A-36.
3. The Split screen view for entering resource information, Figure A-43. Note: Press the

print screen key (PrtScrn [or PrtScrn and Fn] on your keyboard) and paste it into
Word to print because it does not print out as shown from within Project 2010.

4. Create a new Project file that shows the WBS for a generic project. Make the main
categories project management, concept, development, implementation, and close-
out. Include at least four tasks and one milestone under each of these main catego-
ries. Enter 0 for the duration of the milestones, but do not enter any durations for the
other tasks. Be sure to indent tasks and show the outline numbers before printing out
the Gantt Chart view on one page.

HW2: Project 2010, Part 2 (100 points, 25 points for each item)

Do all the steps starting under the Baseline Plan, Actual Costs, and Actual Times heading through
the end of the appendix. Remember to type your first and last name after the first task, Initiating.

1. Print out the Tracking Gantt Chart view, Figure A-53.
2. Print out the Resource Graph view showing an overallocation, Figure A-59.
3. Create your own file using the information in Figures A-62 and 63 to experiment with

the Team Planner. Print out screen shots of both figures by copying and pasting
them into a word processing software.

4. Write a one- to two-page, single-spaced paper summarizing what you think about
Microsoft Project. What do you like and dislike about it? Do you think it would be use-
ful for managing all projects, or just some? Which ones?

Exercise A-2: Web Site Development
A nonprofit organization would like you to lead a Web site development project. The organization
has Internet access that includes space on a Web server, but no experience developing Web
sites. In addition to creating its Web site, the organization would like you to train two people on its
staff to do simple Web page updates. The Web site should include the following information, as
a minimum: description of the organization (mission, history, and recent events), list of services,
and contact information. The organization wants the Web site to include graphics (photographs
and other images) and have an attractive, easy-to-use layout.

1. Project Scope Management
Create a WBS for this project and enter the tasks in Project 2010. Create milestones
and summary tasks. Assume that the main WBS categories and some of the project
management tasks are similar to tasks from the Project Tracking Database project.
Some of the specific analysis, design, and implementation tasks will be to:
a. Collect information on the organization in hardcopy and digital form (brochures,

reports, organization charts, photographs, and so on).
b. Research Web sites of similar organizations.
c. Collect detailed information about the customer s design preferences and

access to space on a Web server.
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d. Develop a template for the customer to review (background color for all pages,
position of navigation buttons, layout of text and images, typography, including
basic text font and display type, and so on).

e. Create a site map or hierarchy chart showing the flow of Web pages.
f. Digitize the photographs and find other images for the Web pages; digitize hard-

copy text.
g. Create the individual Web pages for the site.
h. Test the pages and the site.
i. Implement the Web site on the customer s Web server.
j. Get customer feedback.

k. Incorporate changes.
l. Create training materials for the customer on how to update the Web pages.

m. Train the customer s staff on updating the Web pages.
2. Project Time Management

a. Enter realistic durations for each task, and then link the tasks as appropriate.
Be sure that all tasks are linked (in some fashion) to the start and end of the proj-
ect. Assume that you have four months to complete the entire project. Hint: Use
the Project Tracking Database as an example.

b. Print the Gantt Chart view and Network Diagram view for the project.
c. Print the Schedule table to see key dates and slack times for each task.

3. Project Cost Management
a. Assume that you have three people working on the project and each of them

would charge $20 per hour. Enter this information in the Resource Sheet.
b. Estimate that each person will spend an average of about five hours per week

for the four-month period. Assign resources to the tasks, and try to make the final
cost in line with this estimate.

c. Print the budget report for your project.
4. Project Human Resource Management

a. Assume that one project team member will be unavailable (due to vacation) for
two weeks in the middle of the project. Make adjustments to accommodate this
vacation so that the schedule does not slip and the costs do not change. Docu-
ment the changes from the original plan and the new plan.

b. Use the Resource Usage view to see each person s work each month. Print a
copy of the Resource Usage view.

5. Project Communications Management
a. Adjust the timescale on your Gantt chart to enable the chart to fit on one page.

Then paste a copy of the Gantt chart in PowerPoint. You can use your Print
Screen button to copy the image and paste it into PowerPoint. Also add key
milestones to the Timeline and copy it into a second PowerPoint slide. Copy and
print out both slides in PowerPoint on the page.

b. Print a To-do List report for each team member.
c. Create a Who Does What Report and print it out.

Exercise A-3: Software Training Program
ABC Company has 50,000 employees and wants to increase employee productivity by setting
up an internal software applications training program. The training program will teach
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employees how to use Microsoft software programs such as Vista, Word 2010, Excel 2010,
PowerPoint 2010, Access 2010, and Project 2010. Courses will be offered in the evenings and
on Saturdays and taught by qualified volunteer employees. Instructors will be paid $40 per
hour. In the past, employees were sent to courses offered by local vendors during company
time. In contrast, this internal training program should save the company money on training
as well as make people more productive. The Human Resources department will manage the
program, and any employee can take the courses. Employees will receive a certificate for com-
pleting courses, and a copy will be put in their personnel files. The company is not sure which
vendor s off-the-shelf training materials to use. The company needs to set up a training class-
room, survey employees on desired courses, find qualified volunteer instructors, and start offer-
ing courses. The company wants to offer the first courses within six months. One person
from Human Resources is assigned full time to manage this project, and top management has
pledged its support.

1. Project Scope Management
Create a WBS for this project and enter the tasks in Project 2010. Create milestones
and summary tasks. Assume that some of the project management tasks you need
to do are similar to tasks from the Project Tracking Database example. Some of the
tasks specific to this project will be to:
a. Review off-the-shelf training materials from three major vendors and decide

which materials to use.
b. Negotiate a contract with the selected vendor for its materials.
c. Develop communications information about this new training program. Dissemi-

nate the information via department meetings, e-mail, the company s intranet,
and flyers to all employees.

d. Create a survey to determine the number and type of courses needed and
employees preferred times for taking courses.

e. Administer the survey.
f. Solicit qualified volunteers to teach the courses.

g. Review resumes, interview candidates for teaching the courses, and develop a
list of preferred instructors.

h. Coordinate with the Facilities department to build two classrooms with 20 per-
sonal computers each, a teacher station, and an overhead projection system
(assume that Facilities will manage this part of the project).

i. Schedule courses.
j. Develop a fair system for signing up for classes.

k. Develop a course evaluation form to assess the usefulness of each course and
the instructor s teaching ability.

l. Offer classes.
2. Project Time Management

a. Enter realistic durations for each task and then link appropriate tasks. Be sure
that all tasks are linked in some fashion to the start and end of the project. Use
the Project Tracking Database as an example. Assume that you have six months
to complete the entire project.

b. Print the Gantt Chart view and Network Diagram view for the project.
c. Print the Schedule table to see key dates and slack times for each task.
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3. Project Cost Management
a. Assume that you have four people from various departments available part time

to support the full-time Human Resources person, Terry, on the project. Assume
that Terry s hourly rate is $40. Two people from the Information Technology
department will each spend up to 25% of their time supporting the project. Their
hourly rate is $50. One person from the Marketing department is available 25%
of the time at $40 per hour, and one person from Corporate is available 30% of
the time at $35 per hour. Enter this information about time and hourly wages into
the Resource Sheet. Assume that the cost to build the two classrooms will be
$100,000, and enter it as a fixed cost.

b. Using your best judgment, assign resources to the tasks.
c. View the Resource Graphs for each person. If anyone is overallocated, make

adjustments.
d. Print the budget report for the project.

4. Project Human Resource Management.
a. Assume that the Marketing person will be unavailable for one week, two months

into the project, and for another week, four months into the project. Make adjust-
ments to accommodate this unavailability so the schedule does not slip and
costs do not change. Document the changes from the original plan and the new
plan.

b. Add to each resource a 5% raise that starts three months into the project. Print
a new budget report.

c. Use the Resource Usage view to see each person s work each month. Print a
copy.

5. Project Communications Management
a. Adjust the timescale on your Gantt chart to enable the chart to fit on one page.

Then paste a copy of the Gantt chart in PowerPoint. You can use your Print
Screen button to copy the image and paste it into PowerPoint. Also add key
milestones to the Timeline and copy it into a second PowerPoint slide. Copy and
print out both slides in PowerPoint on one page.

b. Print a To-do List report for each team member.
c. Review some of the other reports, and print out one that you think would help

in managing the project.

Exercise A-4: Project Tracking Database
Expand the Project Tracking Database example. Assume that XYZ Company wants to create a
history of project information, and the Project Tracking Database example is the best format for
this type of history. The company wants to track information on 20 past and current projects and
wants the database to be able to handle 100 projects total. The company wants to track the follow-
ing project information:

Project name
Sponsor name
Sponsor department
Type of project
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Project description
Project manager
Team members
Date project was proposed
Date project was approved or denied
Initial cost estimate
Initial time estimate
Dates of milestones (e.g., project approval, funding approval, project completion)
Actual cost
Actual time
Location of project files

1. Project Scope Management
Open scope.mpp and add more detail to Executing tasks, using the information in
Table A-6.

TABLE A-6 Company XYZ Project Tracking Database executing tasks

Analysis Tasks Design Tasks Implementation
Tasks

Collect list of 20 projects Gather detailed
requirements for desired
outputs from the database

Enter project data

Gather information
on projects

Create fully attributed,
normalized data model

Test database

Define draft requirements Create list of edit rules
for fields, determine
default values, develop
queries, and determine
formats for reports

Make adjustments,
as needed

Create entity relationship
diagram for database

Develop list of queries
required for database

Conduct user
testing

Create sample entry screen Review design information
with customer

Make adjustments
based on user testing

Create sample report Make adjustments to
design based on
customer feedback

Create online Help,
user manual, and
other documentation

Develop simple prototype
of database

Create full table structure
in database prototype

Train users on
the system

(continued)
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2. Project Time Management
a. Enter realistic durations for each task, and then link appropriate tasks. Make the

additional tasks fit the time estimate: 20 days for analysis tasks, 30 days for
design tasks, and 20 days for implementation tasks. Assume that all of the exe-
cuting tasks have a total duration of 70 days. Do not overlap analysis, design,
and implementation tasks.

b. Print the Gantt Chart view and Network Diagram view for the project.
c. Print the Schedule table to see key dates and slack times for each task.

3. Project Cost Management
a. Use the resource and cost information provided in resource.mpp.
b. Assign resources to the new tasks. Try to make the final cost about the same

as that shown in the Project Tracking Database example: about $50,000.
c. Print the budget report for the project.

4. Project Human Resources Management
a. Two months after the project begins, give everyone on the team a 10% raise.

Document the increase in costs that these raises cause.
b. Use the Resource Usage view to see each person s work each month. Print a

copy of the Resource Usage view.
5. Project Communications Management

a. Adjust the timescale on your Gantt chart to enable the chart to fit on one page.
Then paste a copy of the Gantt chart in PowerPoint. You can use your Print
Screen button to copy the image and paste it into PowerPoint. Also add key
milestones to the Timeline and copy it into a second PowerPoint slide. Copy and
print out both slides in PowerPoint on one page.

b. Print a Top-Level Tasks report.
c. Review some of the other reports, and print out one that you think would help

in managing the project.

TABLE A-6 Company XYZ Project Tracking Database executing tasks (continued)

Analysis Tasks Design Tasks Implementation
Tasks

Review prototype with
customer

Create data input screens

Make adjustments based
on customer feedback

Write queries

Create reports

Create main screen

Review new prototype
with customer
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Exercise A-5: Real Project Application
If you are doing a group project as part of your class or for a project at work, use Project 2010 to
create a detailed file describing the work you plan to do. Enter a sufficient WBS, estimate task
durations, link tasks, enter milestones, enter resources and costs, assign resources, and so on.
Save your file as a baseline and track your progress. View earned value information when you are
halfway through the project or course. Continue tracking your progress until the project or course
is finished. Print your Gantt chart, Resource Sheet, Project Summary report, and relevant informa-
tion. Write a two- to three-page report describing your experience. What did you learn about Proj-
ect 2010 from this exercise? What did you learn about managing a project? How do you think
Project 2010 helps in managing a project? You may also want to interview people who use Project
2010 for their experiences and suggestions.
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A P P E N D I X B
ADVICE FOR THE
PROJECT MANAGEMENT
PROFESSIONAL (PMP)
EXAM AND RELATED
CERTIFICATIONS

I N T R O D U C T I O N T O P R O J E C T M A N A G E M E N T
C E R T I F I C A T I O N P R O G R A M S

This appendix provides information on project management certification programs and
offers advice for earning certifications. It briefly describes various certification programs
and provides detailed information on PMI s PMP and CompTIA s Project certifications, the
structure and content of these exams, suggestions on preparing for the exams, tips for taking
the exams, sample questions, and information on related certifications.

W H A T I S P M P C E R T I F I C A T I O N ?

The Project Management Institute (PMI) offers certification as a Project Management Pro-
fessional (PMP). As mentioned in Chapter 1, the number of people earning PMP certification
grew rapidly in the past ten years. There are PMPs in more than 120 countries throughout
the world. Detailed information about PMP certification, the PMP Certification Handbook,
and an online application is available from PMI s Web site (www.pmi.org) under Career
Development. The following information is quoted from PMI s Web site:

The Project Management Institute (PMI®) is the world s leading association for
the project management profession. It administers a globally recognized, rigor-
ous, education, and/or professional experience and examination-based profes-
sional credentialing program that maintains an ISO 9001 certification in
Quality Management Systems. To get the latest information, please visit the
breaking news section.
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Earning a professional credential through PMI means that one has:

Demonstrated the appropriate education and/or professional experience;
Passed a rigorous examination;
Agreed to abide by a professional code of conduct;
Committed to maintaining their active credential through meeting continuing
certification requirements.

PMI professional credentials available to members of the Institute and non-
members alike are widely recognized and accepted throughout the world as
evidence of a proven level of education, knowledge and experience in project
management. 1

Many companies and organizations are recommending or even requiring PMP certification
for their project managers. A February 2003 newsletter reported that Microsoft chose PMI s
PMP Certification Program as the certification of choice for its Microsoft Services Operation.
Microsoft chose the PMP certification because of its global recognition and proven record
in professional development for project managers.2 CertCities.com ranked the PMP as No.
4 in their ten hottest certifications for 2006. It made a strong showing this year, rising from
its debut stop at No. 10 last year, thanks in part to even stronger buzz for this industry-
neutral title within the IT community. 3

Certification Magazine published its annual review of how certification affects salaries
of information technology professionals. This industry-wide study uses real-world numbers
to show how education and experience affect a person s bottom-line salary. During a down
market, people might ask why they should seek additional technical certifications. Accord-
ing to Gary Gabelhouse of Certification Magazine, Perhaps it is best expressed in two
words: job security. In boom times, one constantly reviews the rate of growth in salary as a
key personal-success measurement. However, in down times, job security is paramount. 4

The October 2004 issue of PM Network included an article entitled The Rise of PMP,
which provided several examples of companies and countries that have made concerted efforts
to increase their number of PMPs. Hewlett-Packard had only six registered PMPs in 1997, but
by August 2004, it had more than 1,500 and was adding 500 per year. Although most PMPs are
in the United States (51,498) and Canada (7,444), the PMP credential is growing in popularity
in several countries, such as Japan (6,001), China (4,472), and India (2,281). Thomas Walenta,
PMP, a senior project manager for IBM Germany, said, The PMP credential lends portability
to a career plan. It has significantly shaped careers in the IT industry, with global companies
creating career models for project managers based on PMI certification requirements. 5

As of January 2009, PMI also offers certifications as a Certified Associate in Project
Management (CAPM), a PMI-Scheduling Professional (PMI-SP), a PMI-Risk Management
Professional (PMI-RMP), and a Program Management Professional (PgMP). PMI developed
the CAPM certification as a stepping-stone to PMP certification. Candidates for the CAPM
certification must also meet specific education and experience requirements and pass an
exam. As you can imagine, the requirements are not as rigorous as they are for the PMP
exam. You might want to consider getting the CAPM, or just wait until you have enough
experience to earn the more popular PMP certification. PMI reported only 6,729 active
CAPMs by the end of December 2008 and 318,289 active PMPs.6 As described on the follow-
ing page, you need 4,500 hours of project experience or a minimum of three years if you
have a bachelor s degree to qualify for PMP certification.
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What Are the Requirements for Earning and Maintaining
PMP Certification?
You can now apply to take the PMP exam online. You can also fill out the application forms
and mail them in with a check, if desired. Before you apply to take the exam, you must meet
the following four requirements:

1. Have experience working in the field of project management. When you apply
to take the exam, you enter the role you played in leading and directing project
tasks on one or several projects and how many hours you worked in each of the
five project management process groups for each project. Roles include:

Project contributor
Supervisor
Manager
Project leader
Project manager
Educator
Consultant
Administrator
Other

Note that you do not have to have experience as a project manager to take the
PMP exam any of these roles will suffice. PMP certification requires all appli-
cants with a bachelor s degree to have a minimum of three years of unique,
nonoverlapping project management experience where at least 4,500 hours are
spent leading and directing project tasks. Applicants without a bachelor s
degree are required to have a minimum of five years of unique, non-overlapping
project management experience where at least 7,500 hours were spent leading
and directing project tasks. In both cases, the experience must be accrued
within eight years of the date of application. You must fill out a simple form
online (or by paper, if you choose not to apply online) listing the title of a proj-
ect or projects you worked on; the start and end date for when you worked on
the project(s); your role on the project; the number of hours you spent in lead-
ing and directing tasks related to the initiating, planning, executing, controlling,
and closing processes; and a summary of the project tasks that you led and
directed on the project. You must list some hours in each of the five process
groups, but not for each project, if you worked on multiple projects. PMI staff
will review your qualifications and let you know if you are qualified to take the
PMP exam. You cannot take the exam without this experience qualification.

2. Document at least 35 contact hours of project management education. A con-
tact hour is defined as one hour of participation in an educational activity.
There is no time frame for this requirement. A university or college, a training
company or independent consultant, a PMI chapter, a PMI Registered Educa-
tion Provider (REP), a company-sponsored program, or a distance-learning
company can provide the education. The hours must include content on proj-
ect quality, scope, time, cost, human resources, communications, risk, pro-
curement, and integration management. You must list the course title,
institution, date, and number of hours for each course. For example, if you took
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a principles of management course at a university 20 years ago, you could list
that on the education form along with a one- or two-day PMP exam preparation
class.

3. Agree to the PMP certificant and candidate agreement and release statement.
This form certifies that application information is accurate and complete and
that candidates will conduct themselves in accordance with the Code of Ethics
and Professional Conduct, professional development requirements, and other
PMI certification program policies and procedures. You can simply check a box
saying you agree to this information when applying online. Note that PMI ran-
domly audits 10 15 percent of applications, so be prepared to provide more
detailed information as requested if audited, such as college transcripts, signa-
tures of supervisors or managers to verify experience, etc.

4. Pay the appropriate exam fee. As of January 2009, the PMP certification fee was
$405 for PMI members and $555 for non-members. The re-examination fee (if
you don t pass the exam) is $275 for PMI members and $375 for non-members.
The annual individual PMI membership fee is $129 (including the $10 applica-
tion fee). Note that students, or anyone enrolled in a degree-granting program
at an accredited, or globally equivalent, college or university, can join PMI at
the student member rate of only $40 (including the $10 application fee). If you
want to earn your PMP certification, it makes sense to join PMI, not only for the
financial savings, but also for other benefits. Consult PMI s Web site for mem-
bership information.

The last step in earning PMP certification is passing the exam! After PMI sends you an
eligibility letter to take the PMP exam, you can sign up to take it at several different testing
sites. You must take the exam within one year of receiving your eligibility letter. The eligibil-
ity letter will include complete details for scheduling your exam. As of January 2009, the
PMP exam consisted of 200 four-option multiple-choice questions, and 25 of those questions
are considered pretest questions that do not affect your score. The pretest questions are
randomly placed throughout the exam and are used to test the validity of future examina-
tion questions. Although you cannot use any study aids during the exam, you can bring a
nonprogrammable calculator to assist in performing calculations required to answer some
of the questions. You are also given two blank pieces of paper, so you can write down formu-
las or other information when you enter the exam room, but you cannot bring in any notes
or other materials. The questions on each test are randomly selected from a large test bank,
so each person taking the exam receives different questions. The exam is preceded by a
15-minute computer tutorial to familiarize you with the mechanics of taking the exam. Test
takers have four hours to take this computerized exam, and a passing score is 60.5 percent,
or at least 106 correct answers out of the 175 scored questions, as of January 2009. PMI
reviews and revises the exam annually. Be sure you consult PMI s Web site for any notices
about changes to the PMP exam. For example, the passing percentage was changed several
times to achieve PMI s goal of having around 75 percent of people pass the exam. PMI uses
the Modified Angoff Technique, a certification industry practice standard, to determine the
passing score.

PMI offers a professional development program for maintaining the PMP certification.
To maintain your PMP status, you must earn at least 60 Professional Development Units
within three years, pay a recertification fee every three years when you renew your
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certification ($60 as of January 2009), and agree to continue to adhere to PMI s Code of
Ethics and Professional Conduct. The Continuing Certification Requirements Handbook,
available from PMI s Web site, provides more details on maintaining your PMP status.

What Is the Structure and Content of the PMP Exam?
The PMP exam is based on information from the entire project management body of knowl-
edge as well as the area of professional responsibility. Essentially, the exam reviews con-
cepts and terminology in PMI s PMBOK® Guide, and texts such as this one will help to
reinforce your understanding of key topics in project management. Table B-1 shows the
approximate breakdown of questions on the PMP exam by process group as of January
2009. Candidates should review updated exam information on PMI s Web site to make sure
they are using the latest information. Remember that this text is based on the PMBOK®
Guide, Fourth Edition. The PMP exam will be based on the fourth edition starting July 1,
2009. There were not that many changes from the Third Edition, but make sure you study
the correct edition for your exam. PMI also provides sample exam questions from their site
as well. See a link to this site and other sites with free sample questions on the companion
Web site.

Study Table 3-1 from Chapter 3 of this text to understand the relationships among proj-
ect management process groups, activities, and knowledge areas. Table 3-1 briefly outlines
which activities are performed during each of the project management process groups and
what is involved in each of the knowledge areas. It is also important to understand what
each of the project management activities includes. Several questions on the certification
exam require an understanding of this framework for project management, and many ques-
tions require an understanding of the various tools and techniques described in the
PMBOK® Guide, Fourth Edition and this text.

The PMP exam includes three basic types of questions:

1. Conceptual questions test your understanding of key terms and concepts in
project management. For example, you should know basic definitions such as
what a project is, what project management is, and what key activities are
included in project scope management.

TABLE B-1 Breakdown of questions on the PMP exam by process groups

Process Group Percent of Questions on
PMP Exam

Number of Questions on
PMP Exam (out of 200)

Initiating 11 22

Planning 23 46

Executing 27 54

Monitoring and Controlling 21 42

Closing 9 18

Professional Responsibility 9 18
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2. Application questions test your ability to apply techniques to specific pro-
blems. For example, a question might provide information for constructing a
network diagram and ask you to find the critical path or determine how much
slack is available on another path. You might be given cost and schedule infor-
mation and be asked to find the schedule or cost performance index by apply-
ing earned value formulas.

3. Evaluative questions provide situations or scenarios for you to analyze, and
your response will indicate how you would handle them. For example, a project
might have many problems. A question might ask what you would do in that sit-
uation, given the information provided. Remember that all questions are multi-
ple-choice, so you must select the best answer from the options provided.

How Should You Prepare for the PMP Exam?
To prepare for the PMP exam, it is important to understand your learning and testing style,
and to use whatever resources and study techniques work best for you. Below are some
important questions to consider:

Are you a good test taker? Some people are very good at studying and do well
on multiple-choice exams, but others are not. If you have not taken a long mul-
tiple-choice test in a while, it may take you longer to prepare for the exam than
others.
How confident do you need to be before taking the exam? To pass the exam,
you need to answer only 60.5 percent of the questions correctly. Your PMP cer-
tificate will not display your final score, so it does not matter if you get 61,
70, 80, 90, or even 100 percent correct.
How much information do you need to review before taking the exam? The
PMBOK® Guide, Fourth Edition and this text should be enough content infor-
mation, but many people want to review even more information before taking
the PMP exam. Several companies sell books, sample tests, CD-ROMs, and
audiotapes, or provide courses designed to help people pass the PMP exam.
There s even a PMP Certification for Dummies book available with a CD-ROM
of sample questions. See the Suggested Readings section of the companion Web
site for a list of suggested resources, many at no cost at all, such as www.
pmstudy.com and www.bestsamplequestions.com.
How much time and money do you want to spend studying for the PMP exam?
Some people with little free time or money to spend on extra courses or materi-
als would rather just take the PMP exam with little preparation; this will tell
them what they need to study further if they don t pass on their first attempt.
Even though there is a reexamination fee of $275 (for PMI members), this cost
is generally less than what you would have to pay for most exam preparation
courses. Spend the time and money you need to feel confident enough to pass
the exam, but don t overextend yourself.
Do you know PMI s language? Even if you think you know about project man-
agement, studying the material in the PMBOK® Guide, Fourth Edition before
taking the exam will help you. Volunteer PMPs created the exam, and they
often refer to information from the PMBOK® Guide, Fourth Edition when
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writing questions. Many outstanding project managers might fail the exam if
they don t use PMI s terminology or processes in their jobs.
Do you really understand the triple constraint of project management? Many
questions on the PMP exam are based on the scope, time, and cost knowledge
areas. You should be familiar with project charters, WBSs, network diagrams,
critical path analysis, cost estimates, earned value, and so on before you take
the exam.
Do you want to meet other people in the field of project management as you
study for your PMP exam? Several chapters of PMI offer PMP exam review
courses. These courses are often a good way to network with other local project
managers or soon to be project managers. Many other organizations provide
online and instructor-led courses in PMP preparation where you can also meet
people in the field. Several organizations also provide their own in-house study
groups as a means to network as well as pass the PMP exam.
Do you need extra support, peer pressure, or incentives to pass the PMP
exam? Having some support and positive peer pressure might help to ensure
that you actually take and pass the exam in a timely manner. If you don t want
to be part of a study group, even just telling a friend, colleague, or loved one
that you have set a goal to pass the PMP exam by a certain date might provide
motivation to actually do it. You could also reward yourself after you pass the
exam.
How much are you willing to invest in getting PMP certification? If you have
the time and money, you could take one of the immersion courses several com-
panies offer, like Cheetah Learning, Velociteach, Project Management Training
Institute, or mScholar. These courses generally last four to five days and cost
from $2,000 to $3,000. The company offering the course will have you come
to class with your qualification to take the PMP exam already completed, and
you actually take the PMP exam on the fourth or fifth day of the class. If you
don t pass, many training companies will let you take the class again at no addi-
tional cost. If you don t have any extra money to spend, you can find several
free resources (see the companion Web site) and join or form your own study
group, or just go take the exam and see how you do. However, try not to over
study for the exam; if you know the material well and are passing practice
exams, trust yourself and your skills. If you need to take it a second time to
pass, just do so.

Ten Tips for Taking the PMP Exam
1. The PMP exam is computer based and begins with a short tutorial on how to

use the testing software. The software makes it easy to mark questions you
want to review later, so learning how to mark questions is helpful. Using this
feature can give you a feel for how well you are doing on the test. It is a good
idea to go through every question somewhat quickly and mark those questions
on which you want to spend more time. If you mark 79 questions or less (the
total number you can miss to get 60.5 percent on all 200 questions), you should
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pass the exam. Remember that 25 of the questions are not scored, and you
need 60.5 percent correct on the 175 scored questions.

2. The time allotted for the exam is four hours, and each multiple-choice question
has four answer choices. You should have plenty of time to complete the exam.
Use the first two to three hours to go through all of the questions. Do not spend
too much time on any one question. As you work, mark each question that you
would like to return to for further consideration. Then use the remaining time
to check the questions you are not sure of. If you re a morning person, schedule
your exam in the morning. If you work better after lunch, schedule an after-
noon exam. Make sure you are alert and well rested when you go in to take the
exam.

3. Some people believe it is better to change answers you are unsure about. If you
think that a different answer is better, after reading the question again, then
change your answer. Don t get hung up on any questions. Move on and focus
on answering the questions you can answer correctly.

4. Do not try to read more into the questions than what is stated. There are no
trick questions, but some may be poorly worded or just bad questions. Remem-
ber that they were written by volunteers and are part of a huge test bank. Most
of the questions are relatively short, and there are only four options from which
to choose the answer.

5. To increase your chances of getting the right answer, first eliminate obviously
wrong options, and then choose among the remaining options. Take the time
to read all of the options before selecting an answer. Remember, you have to
pick the best answer available.

6. Some questions require doing calculations such as earned value management.
It is worthwhile to memorize the earned value formulas to make answering
these questions easier. You may use a nonprogrammable calculator while tak-
ing the exam, so be sure to bring one to make performing calculations easier.

7. You should be given two pieces of blank paper to use during the exam. You
might want to bring the paper yourself to make sure it is available. Before start-
ing the test, you should write down important equations so that you do not
have to rely on your memory. When you come to a question involving calcula-
tions, write the calculations down so you can check your work for errors. See
Table B-2 for a summary of formulas you should know for the PMP exam.

8. Read all questions carefully. A few sections of the test require that you answer
three to four questions about a scenario. These questions can be difficult; it can
seem as if two of the choices could be correct, although you can choose only
one. Read the directions for these types of questions several times to be sure
you know exactly what you are supposed to do. Also, remember important con-
cepts such as the importance of using a WBS, emphasizing teamwork, and prac-
ticing professional integrity. You might want to skip the longer or more
difficult questions and answer the shorter or easier ones first.

9. If you do not know an answer and need to guess, be wary of choices that
include words such as always, never, only, must, and completely. These
extreme words usually indicate incorrect answers because there are many
exceptions to rules.
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10. After an hour or two, take a short break to clear your mind. You might want
to bring a snack to have during your break. You might also consider bringing
earplugs if you re easily distracted by noises in the room.

TABLE B-2 Formulas to know for the PMP exam

Time-Related Formulas

Assume o 6, m 21, and p 36 for the following examples, where o optimistic,
m = most likely, and p pessimistic estimate

PERT weighted average (o 4m p)/6
Example: PERT weighted average (36 4(21) 6)/6 21

PERT standard deviation (p o)/6
Example: PERT standard deviation (36 6)/6 5

Range of outcomes using 1 std. dev. 21 5 16 days and 21 5 26 days.
Range of outcomes using 2 std. dev. 21 10 11 days and 21 10 31 days.
Range of outcomes using 3 std. dev. 21 15 6 days and 21 15 36 days.
1 std dev. 68.3% of the population
2 std dev. 95.5% of the population
3 std dev. 99.7% of the population

Cost/Earned Value Formulas

Earned Value EV

Actual Cost AC

Planned Value PV

Cost Variance CV EV AC

Schedule Variance SV EV PV

Cost Performance Index CPI EV/AC

Schedule Performance Index SPI EV/PV

BAC Budget At Completion or the planned total budget for the project
EAC Estimate At Completion BAC/CPI

Estimated time at completion estimated time/SPI

Estimate To Complete (ETC) EAC AC

(continued )
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Sample PMP Exam Questions
A few sample questions similar to those you will find on the PMP exam are provided on the
following pages. You can check your answers at the end of this appendix. If you miss seven
or less out of these 20 questions, you are probably ready to take the PMP exam. You can find
additional sample questions and their answers on the companion Web site, as well as links
to other free sample tests from various Web sites.

1. A document that formally recognizes the existence of a project is a ________
a. Gantt chart
b. WBS
c. project charter
d. scope statement

2. Decomposition is used in developing ________.
a. the management plan
b. the communications plan
c. the earned value
d. the WBS

TABLE B-2 Formulas to know for the PMP exam (continued)

Variance At Completion (VAC) BAC EAC
Remember, a negative value for a variance or equivalently an index less than 100 percent
means over budget/behind schedule.

Communications Formulas

Number of communications channels (n(n 1))/2
Example: Assume n 5, where n number of people
Number of communications channels (5(5 1))/2 (5 * 4)/2 10

Procurement Formulas

Point of Total Assumption (PTA) (Ceiling Price Target Price)/Government Share
Target Cost

Make or Buy Analysis: Create a formula so the make option equals the buy or lease
option, and then solve for the number of days.
Example: Assume you can purchase equipment for $3,000 and it costs $100/day to oper-
ate OR you can lease the equipment for $400/day. In how many days is the lease price
equal to the purchase price? Set up an equation where the cost to lease or buy the item
is equal to the cost to purchase or make the item.
1. Let d the number of days you ll use the equipment: $400d $3,000 $100d
2. Then solve for d. Subtract $100d from both sides to get $300d $3,000
3. Then divide each side by $300 to get d 10
Therefore, if you need the equipment for more than 10 days, it would be cheaper to
buy it.
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3. The critical path on a project represents ________.
a. the shortest path through a network diagram
b. the longest path through a network diagram
c. the most important tasks on a project
d. the highest-risk tasks on a project

4. If the earned value (EV) for a project is $30,000, the actual cost (AC) is
$33,000, and the planned value (PV) is $25,000, what is the cost variance?
a. $3,000
b. $3,000
c. $5,000
d. $5,000

5. If the earned value (EV) for a project is $30,000, the actual cost (AC) is
$33,000, and the planned value (PV) is $25,000, how is the project performing?
a. The project is over budget and ahead of schedule.
b. The project is over budget and behind schedule.
c. The project is under budget and ahead of schedule.
d. The project is under budget and behind schedule.

6. What is the target goal for defects per million opportunities using Six Sigma?
a. 1
b. 3.4
c. 34
d. 100

7. Project human resource management does not include which of the following
processes?
a. acquiring the project team
b. developing the project team
c. managing the project team
d. estimating activity resources

8. If a project team goes from three to five people, how many more communica-
tions channels are there?
a. 7
b. 6
c. 5
d. 4

9. Your project team has identified several risks related to your project. You decide
to take actions to reduce the impact of a particular risk event by reducing the
probability of its occurrence. What risk response strategy are you using?
a. risk avoidance
b. risk acceptance
c. risk mitigation
d. contingency planning

10. Which type of contract provides the least amount of risk for the buyer?
a. firm fixed price
b. fixed price incentive
c. cost plus incentive fee
d. cost plus fixed fee
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11. Suppose you have a project with four tasks as follows:
Task 1 can start immediately and has an estimated duration of 1.
Task 2 can start after Task 1 is completed and has an estimated duration
of 4.
Task 3 can start after Task 2 is completed and has an estimated duration
of 5.
Task 4 can start after Task 1 is completed and must be completed when
Task 3 is completed. Its estimated duration is 8.

What is the length of the critical path for this project?

a. 9
b. 10
c. 11
d. 12

12. In which project management process group is the most time and money typi-
cally spent?
a. initiating
b. planning
c. executing
d. monitoring and controlling

13. Creating a probability/impact matrix is part of which risk management
process?
a. plan risk management
b. identify risks
c. perform qualitative risk analysis
d. perform quantitative risk analysis

14. It is crucial that your project team finish your project on time. Your team is
using a technique to account for limited resources. You have also added a proj-
ect buffer before the end date and feeding buffers before each critical task.
What technique are you using?
a. critical path analysis
b. PERT
c. critical chain scheduling
d. earned value management

15. One of your senior technical specialists informs you that a major design flaw
exists in a systems development project you are managing. You are already
testing the system and planned to roll it out to more than 5,000 users in a
month. You know that changing the design now will cause several cost and
schedule overruns. As project manager, what should you do first?
a. Issue a stop work order until you understand the extent of the flaw.
b. Notify your project sponsor immediately to see if there are additional funds

available to work on this problem.
c. Notify your senior management and let them decide what to do.
d. Hold a meeting as soon as possible with key members of your project team

to discuss possible solutions to the problem.
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16. You are a member of a large government project. You know that the contract
insists that all equipment be manufactured in the United States. You see a
senior member of your team replacing a company etching on a piece of equip-
ment that was made in a foreign country. You confront this person, and he says
he is following the project manager s orders. What should you do?
a. Nothing; the project manager made the decision.
b. Immediately report the violation to the government.
c. Update your resume and look for another job.
d. Talk to the project manager about the situation, and then decide what

to do.
17. Which of the following is not an output of the integrated change control

process?
a. project management plan updates
b. change request status updates
c. forecasts
d. project document updates

18. The ceiling price for a contract is $1.25 million, the target price is $1.1 million,
the target cost is $1 million, and the government share is 75%. What is the point
of total assumption?
a. $1.2 million
b. $1 million
c. $1.1 million
d. there is not enough information

19. Obtaining quotes, bids, offers, or proposals is part of which project procure-
ment management process?
a. plan procurements
b. conduct procurements
c. administer procurements
d. close procurements

20. Your boss believes that all of your project team members avoid work as much
as possible. He or she often uses threats and various control schemes to make
sure people are doing their jobs. Which approach to managing people does your
boss follow?

a. Maslow s hierarchy of needs
b. Theory X
c. Theory Y
d. Herzberg s motivation and hygiene factors

W H A T I S P R O J E C T + C E R T I F I C A T I O N ?

The Computing Technology Industry Association (CompTIA) is the world s largest develop-
er of vendor-neutral IT certification exams. By January 2009, more than one million people
worldwide have earned CompTIA certifications in topics such as PC service, networking,
security, and Radio Frequency Identification (RFID). In April 2001, CompTIA started offer-
ing its IT Project certification, which was purchased from Prometric-Thomson Learning,
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and recognized as the Gartner Institute Certification Program. The certification was
renamed Project in August 2004. According to CompTIA s manager of public relations,
there are more than 11,000 people with CompTIA s Project certification by the end of
2008. Detailed information about Project certification is available from CompTIA s Web
site (www.comptia.org) under certification. The following information is quoted from
CompTIA s Web site in January 2009:

CompTIA Project is a globally recognized project management certification
that provides validation of fundamental project management skills. It covers the
entire project life cycle from initiation and planning through execution, accep-
tance, support and closure. Unlike some project management certifications,
CompTIA Project can be acquired in a quick and cost-effective manner. There
are no prerequisites, and candidates are not required to submit an application
or complete additional hours of continuing education. CompTIA Project gives
project managers the skills necessary to complete projects on time and within
budget, and creates a common project management language among project
team members.7

What Are the Requirements for Earning and Maintaining Project +
Certification?
You can register to take the Project+ exam online from CompTIA s Web site. Testing sites
include Thomson Prometric and Pearson VUE. Unlike the PMP exam, there are very few
requirements you need to meet to take the Project+ exam. CompTIA does not require that
you have any work experience or formal education in project management before you can
take the Project+ exam, but they do recommend 2,000 hours of work experience. The main
requirements include paying a fee and passing the exam. Important information is summa-
rized below:

1. As of January 2009, the cost for taking the Project+ exam is $239 for non-mem-
bers in the United States.

2. To pass this 90-minute, 80-question exam, you must score at least 63 percent.
3. You do not need to renew your Project+ certification.
4. Project+ certification is one of the prerequisites or equivalents to Novell s Certi-

fied Novell Engineer (CNE), Certified Novell Administrator (CNA), and Certi-
fied Novell Instructor (CNI) certifications. CompTIA s Project+ certification is
also a Continuing Certification Requirement (CCR) to maintaining a Master
CNE certification.

5. You can earn college credit with the Project+ certification. For example, Comp-
TIA s Web site says that Capella University will provide six credit hours to
someone with the Project+ certification. Many colleges and universities will
grant credit based on your experience or other certifications. There is usually
some fee involved, but it s often much less than the cost of taking the courses.
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Additional Information on the Project+ Exam
Because there are no experience or education requirements for taking the Project+ exam,
you might want to take it very early in your career. Once you have enough experience
and education to take the PMP exam, you might want to earn and maintain PMP
certification.

As stated already, the Project exam consists of 80 questions. Table B-3 shows the
approximate breakdown of questions on the Project exam by four domain areas. Candi-
dates should review updated exam information on CompTIA s Web site to make sure they
are prepared for the exams. For example, CompTIA provides a detailed list of objectives you
should understand before taking the Project exam. Studying information in this book will
also help you prepare for the Project exam. You might also want to purchase an exam
guide to get specific information and access to more sample questions.

Much of the advice for taking the PMP exam also applies to taking the Project exam.
Many people find the questions to be similar on both exams, although the PMP exam is lon-
ger and more comprehensive. Below are some of the main differences between the content
and types of questions you will find on the Project exam:

The Project exam includes some scenarios and content specific to the infor-
mation technology industry. For example, you should understand the various
systems development life cycles and issues that often occur on information
technology projects.
You should understand the various roles of people on information technology
projects, such as business analysts, database analysts, programmers, and so
on.
Although many of the questions are multiple-choice like the PMP exam ques-
tions, several questions involve choosing two or more correct answers. Several
questions also involve matching or putting items in order, called drag-and-drop
questions.
The Project exam is not based on the PMBOK® Guide, so you do not need
to know the processes involved in the various knowledge areas. However, much
of the terminology, concepts, tools, and techniques are the same on both
exams.

TABLE B-3 Breakdown of questions on the Project exam by domain areas

Domain Area Percent of Questions
on Project Exam

Project Initiation and Scope Definition 20

Project Planning 30

Project Execution, Control, and,
Coordination

43

Project Closure, Acceptance, and Support 7
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Sample Project+ Exam Questions
A few sample questions similar to those you will find on the Project exam are provided
below. CompTIA also provides sample questions on their Web site at http://certification.
comptia.org/resources/practice_test.aspx. You can check your answers at the end of this
appendix.

1. Two software developers on your project disagree on how to design an impor-
tant part of a system. There are several technologies and methodologies they
could use. What should be the primary driver in deciding how to proceed?
a. following corporate standards
b. following industry standards
c. meeting business needs
d. using the lowest-cost approach

2. Match the following items to their descriptions:
Stakeholder a. Acts as a liaison between the business area and

developers
Project manager b. Writes software code
Business analyst c. Person involved in or affected by project activities
Programmer d. Responsible for managing project activities

3. For a project to be successful, the project manager should strive to understand
and meet certain goals. What are the three main project goals to meet? Select
three answers.
a. scope or performance goals
b. time goals
c. political goals
d. cost goals
e. stock price goals

4. You have received an incomplete project scope definition. Put the following
actions in order of how you should proceed to complete them.
a. Incorporate additional changes to the scope definition document.
b. Review the draft scope definition document with your project team.
c. Get signatures on the completed scope definition document.
d. Rewrite the draft scope definition document with your users and project

team.
5. What term is used to describe the process of reaching agreement on a collective

decision?
a. collaboration
b. cooperation
c. coordination
d. consensus

6. What is a variance?
a. a buffer in a duration estimate
b. a small amount of money set aside for contingencies
c. a form of risk management
d. a deviation from the project plan
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7. Which of the following would be legitimate reasons for a vendor to request a
delay in delivering a product? Select two answers.
a. The vendor may have underestimated the amount of time required to pro-

duce and deliver the product.
b. The project contact from the vendor s organization may be going on

vacation.
c. The vendor might be able to provide a better product by delivering the

product late.
d. The vendor might lose money by delivering the product late.

8. When should you involve stakeholders in the change control process on infor-
mation technology projects?
a. before a change is submitted
b. after a change is submitted
c. when a change is submitted
d. throughout the life of a project

9. Which of the following techniques can be used to help manage requirements?
Select three answers.
a. prototyping
b. use case modeling
c. JAD
d. worst case modeling

10. Match the following items to their descriptions:

Lessons learned a. Leave a clear and complete history of a project
Project audits b. Review project progress and results
Project archives c. Document what went right or wrong on a project

W H A T O T H E R E X A M S O R C E R T I F I C A T I O N S
R E L A T E D T O P R O J E C T M A N A G E M E N T A R E
A V A I L A B L E ?

In recent years, several organizations have been developing more certifications related to
project management and information technology project management, in particular. Some
involve taking exams while others require coursework or attendance at workshops. Below
are brief descriptions of other existing exams or certifications related to project
management:

Microsoft provides certification as a Microsoft Office Specialist (MOS) to recog-
nize proficiency in using its software products. In October 2006, Microsoft
Learning launched a new Microsoft Office Project 2007 Certification program.
You can become a Microsoft Certified Technology Specialist (MCTS) in either
Managing Projects with Microsoft Office Project 2007 or Enterprise Project
Management with Microsoft Office Project Server 2007. You can also earn a
Microsoft Certified IT Professional (MCITP) in enterprise Project Management
with Microsoft Office Project Server 2007. Its purpose is to help advance proj-
ect management as a profession and maximize value for its customer base of
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nearly 20 million Microsoft Office Project user licenses. 8 Microsoft is using the
PMI s PMBOK® Guide as a foundation for supporting specific Project 2007
competencies. See Microsoft s Web site (www.microsoft.com) for more
details.
The International Project Management Association (IPMA) offers a four-level
certification program. The main requirements for each level are derived from
typical activities, responsibilities, and requirements from practice. The IPMA
four-level certification system, in descending order, includes the Certified Proj-
ect Director, Certified Senior Project Manager, Certified Project Manager, and
Certified Project Management Associate. More than 50,000 people worldwide
had earned IPMA certifications, according to IPMA s Web site in January
2007. See www.ipma.ch for more details.
Certified IT Project Manager (CITPM): In 1998, the Singapore Computer Socie-
ty collaborated with the Infocomm Development Authority of Singapore to
establish an Information Technology Project Management Certification Pro-
gram. PMI signed a Memorandum of Understanding with the Singapore Com-
puter Society to support and advance the global credentialing of project
management and information technology expertise. In January 2007, the Sin-
gapore Computer Society s Web site listed three levels of the CITPM Certifica-
tion: CITPM (Senior), CITPM, and CITPM (Associate). For more details
consult their Web site (www.scs.org.sg/about_certprog.php).
PMI s additional certifications. As mentioned earlier, as of January 2009, PMI
also offers certification as a Certified Associate in Project Management (CAPM),
a PMI-Scheduling Professional (PMI-SP), a PMI-Risk Management Professional
(PMI-RMP), and a Program Management Professional (PgMP). Check PMI s Web
site for updated information on their certification programs.
Many colleges, universities, and corporate training companies now provide
their own certificate programs or entire degrees in project management. Typing
project management certificate into www.google.com in January 2009

resulted in 58,400 hits. Some of the certificate courses apply toward bachelor s
or advanced degrees, while many do not. Like any other educational program,
it is important to research the quality of the program and find one that will
meet your specific needs. The December 2006 issue of the Project Management
Institute s PMI Today included a supplement that said they had identified over
284 project management degree programs at 235 institutions worldwide. See
the author s Web site for a summary of more than 120 U.S. graduate programs
created as part of a class project in 2006 (www.kathyschwalbe.com, under
Project Management Info). Also see sites like www.gradschools.com to find
more information on graduate programs in project management throughout the
world.
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Discussion Questions

1. What is PMP certification, and why do you think the number of people earning it has grown
so much in the past 10 years?

2. What do you need to do before you can take the PMP exam? What is the exam itself like?
What do you need to do to maintain PMP certification? What do you need to do to take the
Project exam? How does the Project exam differ from the PMP exam? Do you need to
renew Project certification?

3. What is the difference between conceptual, application, and evaluative questions? Which
project management process groups have the most questions on the PMP exam? What are
the four domain areas tested on the Project exam?

4. Which tips for taking the PMP exam do you think would be most helpful for you?
5. If you plan to take the Project or PMP exam soon, what should you do to prepare?
6. Briefly describe project management certification programs other than the PMP or Project

certifications.

Exercises

1. Go to PMI s Web site and review the information about taking the PMP exam. Write a two-
page paper summarizing what you found.

2. Go to CompTIA s Web site and review the information about taking the Project exam. Write
a two-page paper summarizing what you found.

3. Answer the 20 sample PMP questions in this text or take another sample test, and then score
your results. Summarize how you did and areas you would need to study before you could
take the PMP exam.

4. Interview someone who has PMP or Project certification. Ask him or her why he or she
earned the certification and how it has affected his or her career. Write your findings in a
two-page paper.

5. Do an Internet search on earning PMP or Project certification. Be sure to search for Yahoo!
groups or similar sites related to these topics. What are some of the options you found to
help people prepare for either exam? If you were to take one of the exams, what do you think
you would do to help study for it? Do you think you would need additional information beyond
what is in this text to help you pass? Write a two-page paper describing your findings and
opinions.

6. Read a recent issue of PMI s PM Network magazine. You can access a free sample copy
from PMI s Web site. Summarize all of the ads you find in the magazine related to earning
PMP or other project management related certification in a two-page paper. Also, include
your opinion on which ad, course, book, CD-ROM, or other media appeals to you the most.
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Answers to Sample PMP Exam Questions

1. c 11. b
2. d 12. c
3. b 13. c
4. b 14. c
5. a 15. d
6. b 16. d
7. d 17. c
8. a 18. a
9. c 19. b

10. a 20. b

Answers to Sample Project+ Exam Questions

1. c 6. d
2. c, d, a, b 7. a, c
3. a, b, d 8. d
4. b, d, a, c 9. a, b, c
5. d 10. c, b, a

End Notes

1 Project Management Institute, PMI® Certification Programs, (www.pmi.org/) (January 2007).
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3 Becky Nagel, CertCities.com s 10 Hottest Certifications for 2006, CertCities.com, (December

14, 2005).
4 Global Knowledge, 2003 Certification Salary by Certmag, Global Knowledge E-Newsletter,

Issue #56 (March 2003).
5 Adrienne Rewi, The Rise of PMP, PM Network, (October 2004), p. 18.
6 The Project Management Institute, PMI Today, (February 2009).
7 CompTIA Web site (http://certification.comptia.org/project) (January 2009).
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A P P E N D I X C
ADDITIONAL RUNNING
CASES AND SIMULATION
SOFTWARE

I N T R O D U C T I O N

This appendix provides two additional running cases as well as information about using sim-
ulation software. The first case includes tasks ordered by each of the nine knowledge areas
discussed in Chapters 4 through 12 of this text. The second case includes tasks based on the
five project management process groups. There is also information about using Fissure's
project management simulation software. Additional running cases, including the Video
Game Delivery Project case that was in the fifth edition of this text, and suggestions for
finding more cases or having students do real projects are available on the companion
Web site.

The purpose of these cases is to help you practice and develop the project management
skills learned from this text. Several of the tasks involve using templates provided on the
companion Web site (www.cengage.com/mis/schwalbe) and the author s personal Web site
(www.kathyschwalbe.com). Instructors can download the suggested solutions for these
cases from the password-protected section on Course Technology s Web site. Contact a sales
rep at www.cengage.com/coursetechnology.

A D D I T I O N A L C A S E 1 : G R E E N C O M P U T I N G
R E S E A R C H P R O J E C T

Part 1: Project Integration Management
You are working for We Are Big, Inc., an international firm with over 100, 000 employees
located in several different countries. A strategic goal is to help improve the environment
while increasing revenues and reducing costs. The Environmental Technologies Program
just started, and the VP of Operations, Natalie, is the program sponsor. Ito is the program
manager, and there is a steering committee made up of ten senior executives, including
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Natalie, overseeing the program. There are several projects underneath this program, one
being the Green Computing Research Project. The CIO and project sponsor, Ben, has given
this project high priority and plans to hold special interviews to hand-pick the project man-
ager and team. Ben is also a member of the program steering committee. Before coming to
We Are Big, Inc., Ben sponsored a project at a large computer firm to improve data center
efficiency. This project, however, is much broader than that one was. The main purpose of
the Green Computing Research Project is to research possible applications of green comput-
ing including:

Data center and overall energy efficiency
The disposal of electronic waste and recycling
Telecommuting
Virtualization of server resources
Thin client solutions
Use of open source software, and
Development of new software to address green computing for internal use and
potential sale to other organizations

The budget for the project was $500, 000, and the goal was to provide an extensive report,
including detailed financial analysis and recommendations on what green computing tech-
nologies to implement. Official project request forms for the recommended solutions would
also be created as part of the project.

Ben decided to have a small group of people, five to be exact, dedicated to working on
this six-month project full-time and to call on people in other areas on an as-needed basis.
He wanted to personally be involved in selecting the project manager and have that person
help him to select the rest of the project team. Ben wanted to find people already working
inside the company, but he was also open to reviewing applications for potential new
employees to work specifically on this project as long as they could start quickly. Since
many good people were located in different parts of the world, Ben thought it made sense
to select the best people he could find and allow them to work virtually on the project. Ben
also wanted the project manager to do more than just manage the project. He or she would
also do some of the research, writing, editing, and the like required to produce the desired
results. He was also open to paying expert consultants for their advice and purchasing books
and related articles, as needed.

Tasks
1. Research green computing and projects that have been done or are being done

by large organizations such as IBM, Dell, HP, and Google. See www.greener-
computing.com and similar sites provided on the companion Web site or that
you find yourself. Include your definition of green computing to include all of
the topics listed in the background scenario. Describe each of these areas of
green computing, including a detailed example of how at least one organization
has implemented each one, and investigate the return on investment. Summa-
rize your results in a two- to three-page paper, citing at least three references.

2. Prepare a weighted decision matrix using the template from the companion
Web site (wtd_decision_matrix.xls) for Ben to use to evaluate people applying
to be the project manager for this important project. Develop at least five
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criteria, assign weights to each criterion, assign scores, and then calculate the
weighted scores for four fictitious people. Print the spreadsheet and bar chart
with the results. Write a one-page paper describing this weighted decision
matrix and summarize the results.

3. Prepare the financial section of a business case for the Green Computing
Research Project. Assume this project will take six months to complete (done
in Year 0) and cost $500,000, and costs to implement some of the technologies
would be $2,000,000 for year one and $600,000 for years two and three. Esti-
mated benefits are $500,000 the first year after implementation and $2.5 mil-
lion the following two years. Use the business case spreadsheet template from
the companion Web site (business_case_financials.xls) to help calculate the
NPV, ROI, and the year in which payback occurs. Assume a 7 percent discount
rate, but make sure it is an input that is easy to change.

4. Prepare a project charter for the Green Computing Research Project. Assume
the project will take six months to complete and the budget is $500,000. Use
the project charter template (charter.doc) and examples of project charters in
Chapters 3 and 4 as guidelines. Assume that part of the approach is to select
the project team as quickly as possible.

5. Since people will request changes to the project, you want to make sure you
have a good integrated change control process in place. You will also want to
address change requests as quickly as possible. Review the template for a
change request form provided on the companion Web site (change_request.
doc). Write a two-page paper describing how you plan to manage changes on
this project in a timely manner. Address who will be involved in making change
control decisions, what paperwork or electronic systems will be used to collect
and respond to changes, and other related issues.

Part 2: Project Scope Management
Congratulations! You have been selected as the project manager for the Green Computing
Research Project. The company s CIO, Ben, is the project sponsor, and Ito is the program
manager for the larger Environmental Technologies Program that this project is part of. Now
you need to put together your project team and get to work on this high-visibility project.
You will work with Ben to hand-pick your team. Ben had already worked with the HR
department to advertise these openings internally as well as outside the company. Ben had
also used his personal contacts to let people know about this important project. In addition,
you are encouraged to use outside consultants and other resources, as appropriate. Initial
estimates suggest that about $300,000 budgeted for this project will go to internal staffing
and the rest to outside sources. The main products you ll produce will be a series of research
reports one for each green computing technology listed earlier plus one final report includ-
ing all data plus formal project proposals for at least four recommendations for implement-
ing some of these technologies. Ben also suggested that the team come up with at least 20
different project ideas and then recommend the top four based on extensive analysis. Ben
thought some type of decision support model would make sense to help collect and analyze
the project ideas. You are expected to tap into resources available from the Environmental
Technologies Program, but you will need to include some of those resources in your project
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budget. Ben mentioned that he knew there had already been some research done on
increasing the use of telecommuting. Ben also showed you examples of what he considered
to be good research reports. You notice that his examples are very professional, with a lot
of charts and references, and most are 20 30 pages long, single-spaced. Ben has also shown
you examples of good formal project proposals for We Are Big, Inc., and you are surprised
to see how detailed they are, as well. They often reference other research and include a
detailed business case.

Tasks
1. Document requirements for your project so far, including a requirements trace-

ability matrix. Use the template provided (reqs_matrix.xls). Also include a list
of questions you would like to ask the sponsor about the scope.

2. Develop a scope statement for the project using the template provided
(scope_statement.doc). Be as specific as possible in describing product charac-
teristics and deliverables. Make assumptions as needed, assuming you got
answers to the questions you had in Task 1.

3. Develop a work breakdown structure (WBS) for the project. Break down the
work to level 3 or level 4, as appropriate. Use the template on the companion
Web site (wbs.doc) and samples in the text as guides. Print the WBS in list form
as a Word file. Be sure to base your WBS on the project scope statement, stake-
holder requirements, and other relevant information. Remember to include the
work involved in selecting the rest of your project team and outside resources
as well as coordinating with the Environmental Technologies Program. Use the
project management process groups as level 2 WBS items or include project
management as a level 2 WBS item to make sure you include work related to
managing the project.

4. Use the WBS you developed in Task 3 above to create a Gantt chart for the
project in Microsoft Project 2007. Use the outline numbering feature to display
the outline numbers (click Tools on the menu bar, click Options, and then click
Show outline number). Do not enter any durations or dependencies. Print the
resulting Gantt chart on one page, being sure to display the entire Task Name
column.

Part 3: Project Time Management
As project manager, you are actively leading the Green Computing Research Project team
in developing a schedule. You and Ben found three internal people and one new hire to fill
the positions on the project team as follows:

Matt was a senior technical specialist in the corporate IT department located
in the building next to yours and Ben s. He is an expert in collaboration tech-
nologies and volunteers in his community helping to organize ways for resi-
dents to dispose of computers, printers, and cell phones.
Teresa was a senior systems analyst in the IT department in a city 500 miles
away from your office. She just finished an analysis of virtualization of server
resources for her office, which has responsibility for the company s data
center.
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James was a senior consultant in the strategic research department in a city
1,000 miles away from your office. He has a great reputation as being a font of
knowledge and excellent presenter. Although he is over 60, he has a lot of
energy.
Le was a new hire and former colleague of Ben s. She was working in Malaysia,
but she planned to move to your location, starting work about four weeks after
the project started. Le has a lot of theoretical knowledge in green computing,
and her doctoral thesis was on that topic.

While waiting for everyone to start working on your project, you talked to several
people working on other projects under the Environmental Technologies Program and did
some research on green computing. You can use a fair amount of the work already done
on telecommuting, and you have the name of a consulting firm to help with that part of your
project, if needed. Ito and Ben both suggested that you get up to speed on available collabo-
ration tools since much of your project work will be done virtually. They knew that Matt
would be a tremendous asset for your team in that area. You have also contacted other IT
staff to get detailed information on your company s needs and plans in other areas of green
computing. You also found out that there is a big program meeting in England next month
that you and one or two of your team members should attend. It is a three-day meeting, plus
travel. Recall that the Green Computing Research Project is expected to be completed in six
months, and you and your four team members are assigned full-time to this project. Your
project sponsor, Ben, has made it clear that delivering a good product is most important, but
he also thinks you should have no problem meeting your schedule goal. He can authorize
additional funds, if needed. You have decided to hire a part-time editor/consultant, Deb,
whom you know from a past job to help your team produce the final reports and project pro-
posals. Your team has agreed to add a one-week buffer at the end of the project to ensure
that you finish on time or early.

Tasks
1. Review the WBS and Gantt chart you created for Tasks 3 and 4 in Part 2. Pro-

pose three to five additional activities you think should be added to help you
estimate resources and durations. Write a one-page paper describing these new
activities.

2. Identify at least four milestones for this project. Write a one-page paper
describing each milestone using the SMART criteria.

3. Using the Gantt chart created for Task 4 in Part 2, and the new activities and
milestones you proposed in Tasks 1 and 2 above, estimate the task durations
and enter dependencies as appropriate. Remember that your schedule goal for
the project is six months. Print the Gantt chart and network diagram.

4. Write a one-page paper summarizing how you would assign people to each
activity. Include a table or matrix listing how many hours each person would
work on each task. These resource assignments should make sense given the
duration estimates made in Task 3 above.

5. Assume that your project team starts falling behind schedule. In several cases,
it is difficult to find detailed information on some of the green computing
technologies, especially financial data. You know that it is important to meet
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or beat the six-month schedule goal, but quality is most important. Describe
contingency strategies for making up lost time and avoiding schedule slips in
the future.

Part 4: Project Cost Management
Your project sponsor has asked you and your team to refine the existing cost estimate for
the project so that there is a solid cost baseline for evaluating project performance. Recall
that your schedule and cost goals are to complete the project in six months or less for
under $500, 000. Initial estimates suggested that about $300,000 for this project would go
toward internal labor. You mistakenly thought that travel costs would be included in that
$300,000, but now you realize that it is a separate cost item. The one trip to England early
in the project cost $6,000, which you had not expected.

Tasks
1. Prepare and print a one-page cost estimate for the project, similar to the one

provided in Chapter 7. Use the WBS categories you created earlier, and be sure
to document assumptions you make in preparing the cost estimate. Assume a
burdened labor rate of $100/hour for the project manager, $90 for Teresa,
James, and Le, and $80/hour for Matt. Assume about $200/hour for outsourced
labor.

2. Using the cost estimate you created in task 1, prepare a cost baseline by allocat-
ing the costs by WBS for each month of the project.

3. Assume you have completed three months of the project and have actual data.
The BAC was $500,000 for this six-month project. Also assume the following:

PV $160,000
EV $150,000
AC $180,000

Using this information, write a short report that answers the following questions.

a. What is the cost variance, schedule variance, cost performance index
(CPI), and schedule performance index (SPI) for the project?

b. Use the CPI to calculate the estimate at completion (EAC) for this project.
Use the SPI to estimate how long it will take to finish this project. Sketch
an earned value chart using the above information, including the EAC
point. See Figure 7-6 as a guide. Write a paragraph explaining what this
chart shows.

c. How is the project doing? Is it ahead of schedule or behind schedule? Is
it under budget or over budget? Should you alert your sponsor or other
senior management and ask for assistance?

4. You notice that several of the tasks that involve getting inputs from consultants
outside of your own company have cost more and taken longer to complete
than planned. You have talked to the consultants several times, but they say
they are doing the best they can. You also underestimated travel costs for this
project. Write a one-page paper describing corrective action you could take to
address these problems.
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Part 5: Project Quality Management
The Green Computing Research Project team is working hard to ensure their work meets
expectations. The team has a detailed project scope statement, schedule, and so on, but as
the project manager, you want to make sure you ll satisfy key stakeholders, especially Ben,
the project sponsor, and Ito, the program manager. You have seen how tough Ito can be
on project managers after listening to his critiques of other project managers at the monthly
program review meeting. He was adamant on having solid research and financial analysis
and liked to see people use technology to make quick what-if projections. You were
impressed to see that several other project teams had developed computer models to help
them perform sensitivity analysis and make important decisions. Most of the models were
done using Excel, which Ito preferred, and you were glad that you were an expert with
Excel, as was Matt. Ito was pretty easy on you at your first monthly review because things
were just getting started, but he did give you a list of items to report on next month. You had
Ben there to help answer some of the tough questions, but you wanted to be able to hold
your own at future monthly meetings.

Tasks
1. Develop a list of at least five quality standards or requirements related to meet-

ing the stakeholder expectations especially for Ben and Ito. Also provide a brief
description of each standard or requirement. For example, a requirement
might be related to the computer model (that the computer model you create
to analyze the 20 or more technologies be done in Excel 2007). Other stan-
dards or requirements might be related to the quality of the financial analysis
and research you use.

2. Review the Seven Basic Tools of Quality. Pick one and make up a scenario
related to this project where it would be useful. Document the scenario and tool
in a one-to-two page paper.

3. Find a high quality research report related to the green computing. Summarize
the report and why you think it is of high quality in a one-to-two page paper.

Part 6: Project Human Resource Management
You are five weeks into the Green Computing Research Project, and all of the full-time team
members are together face-to-face for the first time. Recall that you, Ben, Matt, and Le all
work in the same location, but Teresa and James are based out of town and will do most
of their work virtually. Le is also new to the company and just moved to the U.S. She is cur-
rently staying in a hotel and looking for a place to live. She d like to buy her first home, but
she wants to make sure it s a good investment and somewhere she d like to stay for at least
five years. You get along very well with your project sponsor, Ben, and Matt is a great
resource, even though he is extremely reserved. Le is also very quiet, and you quickly dis-
cover that she is an excellent researcher and writer, but she is not comfortable speaking
in public. Teresa and James are much more talkative and are excited to be working on this
project. However, James seems to be reluctant to use much technology to share ideas and
really enjoys face-to-face meetings and discussions. You have made preliminary agreements
with two outside consultants to assist you with editing and the teleconferencing topic for
your research. You have to prepare a monthly progress report and presentation for Ito, the

C.7

Additional Running Cases and Simulation Software

      Copyright 2011 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). 

Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Licensed to:



program manager. You also have short meetings as needed with Ben, your sponsor, and send
him a weekly progress report.

Tasks
1. Before this first face-to-face meeting, you asked everyone to send a brief

introductory e-mail, including links to their personal Web sites, LinkedIn site,
etc. You also asked everyone to take a short version of the Meyers-Briggs Type
Indicator (MBTI) online and share their results with everyone else. Take this
test yourself from www.humanmetrics.com and research how different MBTI
types respond to work environments, especially for research projects and virtu-
al teams. Summarize your findings in a one-to-two page paper. Also document
what you would write in an e-mail to introduce yourself, assuming you are the
project manager for this project. Be creative in your response.

2. Prepare a responsibility assignment matrix in RACI chart format based on the
WBS you created earlier and the information you have on project team mem-
bers and other stakeholders. Use the template (ram.xls) and samples in the
text. Document key assumptions you made in preparing the chart.

3. Since everyone will be in town for most of the week, you want to make sure
they develop good working relationships. You also want everyone to work
together efficiently. You asked Matt to review collaboration tools he recom-
mends the team use for this project. As Matt starts demonstrating some of these
tools, including webcams and wikis, you notice that a couple of team members
seem uncomfortable, especially James. He thought that he would be in charge
of certain aspects of the research reports and didn t know how he d feel about
any team member being able to change what he wrote in a wiki. Le did not like
the idea of using a Webcam. She d rather not have her face on video when com-
municating virtually. Discuss these human resource-related concerns and
others that you think would be common in this situation. Include strategies for
addressing them as well.

Part 7: Project Communications Management
Several communications issues have arisen on the Green Computing Research Project.
Three months have passed since the project started. Your team had agreed to post all of
their work on a shared site, but a couple of team members don t seem to like using that site
and prefer to use e-mails and attachments. When they do that, other team members cannot
easily see what work is done in one place or provide feedback using the wiki tools. It is also
clear that some team members are better researchers and writers than others. When you
have weekly conference calls with the Webcams, at least a couple of people don t have the
Webcam working and just use the audio. You also find that these meetings rarely end on
time as some team members get very talkative. You also got grilled by Ito at the last monthly
program review meeting. He thought you d be much further along in the project than you
are and expects you to have one recommendation on a green computing project that looks
very promising by next month. You haven t seen any great ideas yet. You want to start hav-
ing face-to-face meetings at least twice a month, but you know it will make your project go
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over budget even more. At least the Excel model is going well. You and Matt have put a good
deal of time into developing it. If only you had enough good data to put into it.

Tasks
1. Create an issue log for the project using the template provided (issue_log.doc).

List at least four issues and related information based on the scenario presented.
2. Research the use of wikis and address the concerns several team members have

about using them, especially their fear of having others mess up their work.
Document your findings in a one- to two-page paper.

3. Write a two-page paper describing how you might approach two of the conflicts
described above.

Part 8: Project Risk Management
Since several problems have been occurring on the Green Computing Research Project (see
the case information in Part 7), you decide to be more proactive in managing risks. You also
want to address positive and negative risks.

Tasks
1. Create a risk register for the project, using the template (risk_register.xls).

Identify six potential risks, including at least two positive risks.
2. Plot the six risks on a probability/impact matrix, using the template

(prob_impact_matrix.ppt) and print it out. Assign a numeric value for the prob-
ability of each risk, and its impact on meeting the main project objectives. Use
a scale of 1 to 10 to assign the values, with 1 being lowest and 10 being highest.
For a simple risk factor calculation, multiply these two values (the probability
score and the impact score). Document the results in a one-page paper, includ-
ing your rationale for how you determined the scores for one of the negative
risks and one of the positive risks.

3. Develop a response strategy for one of the negative risks and one of the positive
risks. Enter the information in the risk register and print out your complete
risk register. Also write a one-page paper describing what specific tasks would
need to be done to implement these two strategies. Include time and cost esti-
mates for each strategy.

Part 9: Project Procurement Management
After a monthly program management review meeting four months into your project, Ito
and Ben approved adding $100,000 and one additional month to the project. You provided
strong rationale for the need for additional travel funds and more money for outside consul-
tants to help you in finding good research information. You decided to have James go back
to his old job since he didn t seem open to sharing ideas with others. It would be best to have
a consulting firm, one you were already using, pick up the work he was supposed to do, even
though it would cost a lot more. The lead consultant, Anne, had done a great analysis of
improving overall energy efficiency for the company that would save millions of dollars each
year. Ben, your project sponsor, was disappointed that you couldn t meet the original time
and cost goals, but he wanted to make sure the final results were of high quality.
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Tasks
1. Draft a contract to have Anne s consulting firm perform the work that James

was supposed to do for this project. Assume that the contract would last for
three months and that Anne herself would be working about half-time, earning
$200/hour. She would also have some other consultants do up to 100 hours of
work at $150/hour. They would do most of the work virtually, but Anne would
come in town at least once a month for face-to-face meetings. Limit the con-
tract to two or three pages, and be sure to address specific personnel and travel
requirements. Also make sure that all work produced would be owned and
copyrighted by your company exclusively.

2. Deb, the editor you hired for this project, has asked for your assistance in orga-
nizing the final comprehensive research report. Draft a one-page executive
summary and a table of contents for this report.

3. Although this is not really a procurement task, it is provided here for conve-
nience purposes. Prepare a lessons-learned report for what you may have
learned so far as project manager for this project. Use the template provided
on the companion Web site (lessons_learned_report.doc) and be creative in
your response.

A D D I T I O N A L C A S E 2 : P R O J E C T
M A N A G E M E N T V I D E O S P R O J E C T

Part 1: Initiating
You and several of your classmates are taking a project management class, and your instruc-
tor suggested a project to find or create good video clips to illustrate various concepts relat-
ed to the class. For example, the Oceans 11, 12, and 13 movies all include great planning
and execution clips. Apollo 13 provides a great example of scope management and creative
problem solving when the team has to figure out how to keep the astronauts alive. The Office
television show includes many examples of poor motivation techniques. In addition to pro-
viding the clips on DVD, you will write a summary of them, including the length and source
of the clip, introductions for each clip, discussion questions that you can pose before and
after each clip, and suggested answers to those questions. Your instructor has suggested that
teams find or create at least two good clips per team member. If several teams in your class
work on this project, you will have to coordinate with them to avoid duplicating clips and
to share resources. Everything your team creates for the project should fit on one DVD that
will run on your instructor s computer. The DVD will be for educational use only, so there
should not be any copyright issues.

Tasks
1. To become more familiar with finding short video clips, do some preliminary

research. Go to sites like youtube.com and search for videos related to project
management concepts. Also search for articles related to project management
in the movies, and visit sites such as imdb.com to see movie trailers. Find other
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sites that have legitimate movie and television clips. Also discuss movies or
television shows that you and your teammates are familiar with that could be
used for this project. Write a two- to three-page paper with your findings, citing
all references.

2. To become familiar with creating or editing short video clips, research how to
take short segments of an existing DVD and put it on a computer. Also research
the devices and software needed to create, edit, and post your own videos (such
as theFlip.com and youtube.com). Summarize at least three options, including
price information. Write a two- to three-page paper with your findings, citing all
references.

3. Prepare a team contract for this project. Use the team_contract.doc template
provided on the companion Web site, and review the sample in the text.

4. Prepare a draft project charter for the Project Management Videos Project.
Assume the project will be completed by the last day of class, and costs will
include an estimate of hours (unpaid) your team will work on this project plus
the cost of any necessary hardware/software you would like for the project (such
as DVDs, a camcorder, video editing software, etc.). Use the charter.doc tem-
plate provided on the companion Web site, and review the sample in the text.

5. Prepare a draft schedule for completing all of the tasks for this project. Include
columns that list each task by process group; estimated start and end dates for
each task; who has the main responsibility for each task; estimated hours for
each task by person; and actual hours for each task by person that you ll com-
plete as you have the information.

6. Write a brief summary of your team's MBTI types and how they might
affetct your team dynamics. You can take a version of the test from
www.humanmetrics.com.

7. Prepare a 10-minute presentation that summarizes results from the above
initiating tasks. Assume the presentation is for a review with your class and
instructor. Be sure to document notes of any feedback received during the
presentation and hand in hard copies of everything you produced.

Part 2: Planning
Work with your teammates and instructor to perform several planning activities for this
project.

Tasks
1. Develop a scope statement for the project. Use the scope_statement.doc tem-

plate provided on the companion Web site, and review the sample in the text.
Be as specific as possible in describing product characteristics and require-
ments, as well as key deliverables. Determine which video clips your team will
provide and what resources you think you will need (DVDs, camcorders, etc.).
Be sure to coordinate the clips with your instructor and other teams and get
feedback before handing in your scope statement.

2. Develop a WBS for the project. Use the wbs.doc template provided on the com-
panion Web site, and review the samples in the text. Print the WBS in list form
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as a Word file. Be sure the WBS is based on the project charter, scope state-
ment, draft schedule, and other relevant information.

3. Create a milestone list for this project, and include at least ten milestones and
estimated completion dates for them. Note that your instructor should have
input for several of these milestones and completion dates. Use the
milestone_report.doc template.

4. Develop a cost estimate for the project. Estimate hours needed to complete
each task (including those already completed) and the costs of any items you
would like to purchase for the project. Assume a rate of $10 per hour for all
labor. Use the cost_estimate.xls template.

5. Use the WBS and milestone list you developed in numbers 2 and 3 above and
the draft schedule you created earlier to create a Gantt chart and network dia-
gram in Project 2007 for the project. Estimate task durations and enter depen-
dencies, as appropriate. Print the Gantt chart and network diagram. Also
update the draft schedule you created under Initiating, Task 5.

6. Create a quality checklist for ensuring that the project is completed
successfully. Also define at least two quality metrics for the project.

7. Create a RACI chart for the main tasks and deliverables for the project.
8. Develop a communications management plan for the project. Use the

comm_plan.doc template and sample provided.
9. Create a probability/impact matrix and list of prioritized risks for the project.

Include at least ten risks. Use the prob_impact_matrix.ppt template and sample
provided.

10. Prepare a ten-minute presentation that you would give to summarize results
from the above planning tasks. Assume the presentation is for a review with
your class and instructor. Be sure to document notes of any feedback received
during the presentation and hand in hard copies of everything you produced.
Plan to show one video clip along with the discussion questions to get
feedback.

Part 3: Executing
Work with your teammates and instructor to perform several executing activities for this
project.

Tasks
1. Find or create your video clips and put them on one DVD. Be sure it runs on

your instructor s computer.
2. Write the clip summaries, introductions, discussion questions, and suggested

answers to those questions.
3. Document any change requests you have during project execution and get

sponsor approval, if needed.

Part 4: Monitoring and Controlling
Work with your teammates and instructor to perform several monitoring and controlling
activities for this project.
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Tasks
1. Review the Seven Basic Tools of Quality. Pick one of these tools and create a

chart or diagram to help you solve problems you are facing. Use the available
templates and samples provided. Note: There is only a template for the Pareto
chart called pareto_chart.xls.

2. Create and update, as required, an issue log. Use the issue_log.doc template and
sample provided.

3. As described in the last task for the initiating and planning sections, be ready
to show progress you have made as part of a project review. Also be sure to
document actual hours on each task in the draft schedule you first created for
Task 5 under Initiating and updated for Task 5 under Planning.

Part 5: Closing
Work with your teammates and instructor to perform several closing activities for this
project.

Tasks
1. Prepare a 20-minute final project presentation to summarize the results of the

project. Describe the initial project goals, planned versus actual scope, time,
and cost information, challenges faced, lessons-learned, and key products pro-
duced. Be sure to list all of the clips your team found and show at least two of
them along with the discussion questions.

2. Prepare a final project report. Include a cover page and detailed table of con-
tents, getting feedback from your instructor on information required. Be sure
to include all of the documents and products you have prepared as
appendices.

3. Get feedback from your sponsor in the form of a customer acceptance/project
completion form (see the template called client_acceptance.doc) or in some
other fashion. Also get feedback from your classmates.

4. If you are comfortable doing so, send a copy of your final project report and
feedback on this case to the author of this text at schwalbe@augsburg.edu.

F I S S U R E S I M U L A T I O N S O F T W A R E

Introduction
Another way to practice your project management skills is by using simulation software.
This text can be purchased so that it is bundled with Fissure s project management simula-
tion software, or you can buy it separately at www.ichapters.com for about $12. Search for
Fissure from the site. The version provided is the correct one.

Fissure s project management simulation software is based on the SimProject Alliance
Prototype project. The demo version of the simulation software includes a fairly simple,
11-week project consisting of only seven tasks and ten potential team members. Fissure esti-
mates that it takes about three to four hours to run the demo simulation. To participate in
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this simulated project, you are expected to read about the company, project, and people
available to work on this project. You plan your project and make typical project decisions
each week, such as when to assign staff, when to hold meetings, and when to send staff to
various training opportunities. You run your project a week at a time, analyzing your results
each week, referring to your weekly reports, and making your decisions for the next week.
As you run the simulation each week, you are presented with communications from people
within the company, team members, or other stakeholders related to the project. You
choose how to respond to these communications, and all the decisions you make impact
how your project progresses. You can close the simulation at any time and save your work,
if desired. You can also run the simulation as many times as you like, and the results vary
based on your decisions. You can use the software for 120 days.

Instructions

N O T E

It often works best if students can do this assignment as a small team or in pairs, if
possible.

Run the Fissure simulation software at least two different times. Summarize key decisions
and results from each week for each run, and print out the final earned value chart as well
as any other information you think is valuable. Write a two- to three-page single-spaced
report summarizing what you thought about using this simulation software. Be honest, spe-
cific, and thorough in your report.
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GLOSSARY

5 whys A technique where you repeat-
edly ask the question Why? (five is a
good rule of thumb) to help peel away the
layers of symptoms that can lead to the
root cause of a problem.

acceptance decisions Decisions that
determine if the products or services pro-
duced as part of the project will be
accepted or rejected.

activity An element of work, normally
found on the WBS, that has an expected
duration and cost, and expected resource
requirements; also called a task.

activity attributes Information about
each activity, such as predecessors, suc-
cessors, logical relationships, leads and
lags, resource requirements, constraints,
imposed dates, and assumptions related
to the activity.

activity list A tabulation of activities
to be included on a project schedule.

activity-on-arrow (AOA) A network
diagramming technique in which activi-
ties are represented by arrows and con-
nected at points called nodes to illustrate
the sequence of activities; also called
arrow diagramming method (ADM).

actual cost (AC) The total of direct and
indirect costs incurred in accomplishing
work on an activity during a given
period.

adaptive software development (ASD)
A software development approach used
when requirements cannot be clearly
expressed early in the life cycle.

agile software development A method
for software development that uses new
approaches, focusing on close collabora-
tion between programming teams and
business experts.

analogous estimates A cost
estimating technique that uses the
actual cost of a previous, similar project
as the basis for estimating the cost of the
current project, also called top-down
estimates.

analogy approach Creating a WBS by
using a similar project s WBS as a starting
point.

appraisal cost The cost of evaluating
processes and their outputs to ensure
that a project is error-free or within an
acceptable error range.

arrow diagramming method (ADM) A
network diagramming technique in
which activities are represented by
arrows and connected at points called
nodes to illustrate the sequence of
activities; also called activity-on-arrow
(AOA).

backward pass A project network
diagramming technique that determines
the late start and late finish dates for each
activity in a similar fashion.

balanced scorecard A methodology
that converts an organization s value dri-
vers to a series of defined metrics.

baseline The original project plan plus
approved changes.
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baseline dates The planned schedule dates
for activities in a Tracking Gantt chart.

benchmarking A technique used to gen-
erate ideas for quality improvements by
comparing specific project practices or
product characteristics to those of other
projects or products within or outside the
performing organization.

best practice An optimal way recognized
by industry to achieve a stated goal or
objective.

bid Also called a tender or quote (short
for quotation), a document prepared by sell-
ers providing pricing for standard items that
have been clearly defined by the buyer.

blogs Easy to use journals on the Web
that allow users to write entries, create
links, and upload pictures, while readers can
post comments to journal entries.

bottom-up approach Creating a WBS by
having team members identify as many spe-
cific tasks related to the project as possible
and then grouping them into higher level
categories.

bottom-up estimates A cost estimating
technique based on estimating individual
work items and summing them to get a proj-
ect total.

brainstorming A technique by which a
group attempts to generate ideas or find a
solution for a specific problem by amassing
ideas spontaneously and without judgment.

budget at completion (BAC) The original
total budget for a project.

budgetary estimate A cost estimate used
to allocate money into an organization s
budget.

buffer Additional time to complete a task,
added to an estimate to account for various
factors.

burst When a single node is followed by
two or more activities on a network
diagram.

business service management (BSM) tools
Tools that help track the execution of

business process flows and expose how the
state of supporting IT systems and resources
is impacting end-to-end business process
performance in real time.

Capability Maturity Model Integration
(CMMI) A process improvement
approach that provides organizations with
the essential elements of effective
processes.

capitalization rate The rate used in dis-
counting future cash flow; also called the
discount rate or opportunity cost of capital.

cash flow Benefits minus costs or income
minus expenses.

cash flow analysis A method for deter-
mining the estimated annual costs and ben-
efits for a project.

cause-and-effect diagram A diagram that
traces complaints about quality problems
back to the responsible production opera-
tions to help find the root cause. Also known
as fishbone diagram or Ishikawa diagram.

champion A senior manager who acts as
a key proponent for a project.

change control board (CCB) A
formal group of people responsible for
approving or rejecting changes on a
project.

change control system A formal, docu-
mented process that describes when and
how official project documents may be
changed.

closing processes Formalizing acceptance
of the project or project phase and ending
it efficiently.
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coercive power Using punishment,
threats, or other negative approaches to get
people to do things they do not want to do.

collaborating mode A conflict-handling
mode where decision makers incorporate
different viewpoints and insights to develop
consensus and commitment.

communications management plan
A document that guides project
communications.

compromise mode Using a give-and-take
approach to resolving conflicts; bargaining
and searching for solutions that bring some
degree of satisfaction to all the parties in a
dispute.

configuration management A process
that ensures that the descriptions of the pro-
ject s products are correct and complete.

conformance Delivering products that
meet requirements and fitness for use.

conformance to requirements The proj-
ect processes and products meet written
specifications.

confrontation mode Directly facing a con-
flict using a problem-solving approach that
allows affected parties to work through their
disagreements.

constructive change orders Oral or writ-
ten acts or omissions by someone with actu-
al or apparent authority that can be
construed to have the same effect as a writ-
ten change order.

contingency allowances Provisions held
by the project sponsor or organization to
reduce the risk of cost or schedule overruns
to an acceptable level; also called contingen-
cy reserves.

contingency plans Predefined actions
that the project team will take if an identi-
fied risk event occurs.

contingency reserves Provisions held by
the project sponsor or organization to
reduce the risk of cost or schedule overruns
to an acceptable level; also called contingen-
cy allowances.

contract A mutually binding agreement
that obligates the seller to provide the spec-
ified products or services, and obligates the
buyer to pay for them.

control chart A graphic display of data
that illustrates the results of a process over
time.

controlling costs Controlling changes to
the project budget.

cost management plan A document that
describes how cost variances will be man-
aged on the project.

cost baseline A time-phased budget that
project managers use to measure and moni-
tor cost performance.

cost of capital The return available by
investing the capital elsewhere.

cost of nonconformance Taking responsi-
bility for failures or not meeting quality
expectations.

cost of quality The cost of conformance
plus the cost of nonconformance.

cost performance index (CPI) The ratio
of earned value to actual cost; can be used
to estimate the projected cost to complete
the project.

cost variance (CV) The earned value
minus the actual cost.

cost plus award fee (CPAF) contract A
contract in which the buyer pays the
supplier for allowable performance
costs plus an award fee based on the
satisfaction of subjective performance
criteria.
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cost plus fixed fee (CPFF) contract A con-
tract in which the buyer pays the supplier
for allowable performance costs plus a fixed
fee payment usually based on a percentage
of estimated costs.

cost plus incentive fee (CPIF) contract A
contract in which the buyer pays the suppli-
er for allowable performance costs along with
a predetermined fee and an incentive bonus.

cost plus percentage of costs (CPPC)
contract A contract in which the buyer
pays the supplier for allowable performance
costs along with a predetermined percent-
age based on total costs.

cost-reimbursable contracts Contracts
involving payment to the supplier for direct
and indirect actual costs.

crashing A technique for making cost and
schedule trade-offs to obtain the greatest
amount of schedule compression for the
least incremental cost.

critical chain scheduling A method of
scheduling that takes limited resources into
account when creating a project schedule
and includes buffers to protect the project
completion date.

critical path The series of activities in a
network diagram that determines the earliest
completion of the project; it is the longest
path through the network diagram and has
the least amount of slack or float.

critical path method (CPM) or critical path
analysis A project network analysis tech-
nique used to predict total project
duration.

decision tree A diagramming analysis
technique used to help select the best
course of action in situations in which
future outcomes are uncertain.

decomposition Subdividing project deli-
verables into smaller pieces.

defect Any instance where the product
or service fails to meet customer
requirements.

DMAIC (Define, Measure, Analyze, Improve,
Control) A systematic, closed-loop pro-
cess for continued improvement that is sci-
entific and fact based.

definitive estimate A cost estimate that
provides an accurate estimate of project
costs.

deliverable A product or service, such
as a technical report, a training session, a
piece of hardware, or a segment of software
code, produced or provided as part of a
project.

Delphi technique An approach used to
derive a consensus among a panel of
experts, to make predictions about future
developments.

dependency The sequencing of pro-
ject activities or tasks; also called a
relationship.

deputy project managers People who fill
in for project managers in their absence and
assist them as needed, similar to the role of
a vice president.

design of experiments A quality tech-
nique that helps identify which variables
have the most influence on the overall out-
come of a process.

determining the budget Allocating the
overall cost estimate to individual work
items to establish a baseline for measuring
performance.

direct costs Costs that can be directly
related to producing the products and ser-
vices of the project.

directives New requirements imposed by
management, government, or some external
influence.
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discretionary dependencies Sequencing
of project activities or tasks defined by the
project team and used with care since they
may limit later scheduling options.

discount factor A multiplier for each year
based on the discount rate and year.

discount rate The rate used in discount-
ing future cash flow; also called the capitali-
zation rate or opportunity cost of capital.

dummy activities Activities with no dura-
tion and no resources used to show a logical
relationship between two activities in the
arrow diagramming method of project net-
work diagrams.

duration The actual amount of time
worked on an activity plus elapsed time.

early finish date The earliest possible
time an activity can finish based on the
project network logic.

early start date The earliest possible time
an activity can start based on the project
network logic.

earned value (EV) An estimate of the val-
ue of the physical work actually completed.

earned value management (EVM) A proj-
ect performance measurement technique
that integrates scope, time, and cost data.

effort The number of workdays or work
hours required to complete a task.

empathic listening Listening with the
intent to understand.

enterprise or portfolio project management
software Software that integrates infor-
mation from multiple projects to show the
status of active, approved, and future pro-
jects across an entire organization.

estimate at completion (EAC) An esti-
mate of what it will cost to complete the
project based on performance to date.

estimating costs Developing an approxi-
mation or estimate of the costs of the
resources needed to complete the project.

ethics A set of principles that guide our
decision making based on personal values
of what is right and wrong.

executing processes Coordinating people
and other resources to carry out the project
plans and produce the products, services,
or results of the project or project phase.

executive steering committee A group of
senior executives from various parts of the
organization who regularly review important
corporate projects and issues.

expectations management matrix A tool
to help understand unique measures of suc-
cess for a particular project.

expected monetary value (EMV) The
product of the risk event probability and the
risk event s monetary value.

expert power Using one s personal knowl-
edge and expertise to get people to change
their behavior.

extrinsic motivation Causes people to do
something for a reward or to avoid a
penalty.

external dependencies Sequencing of
project activities or tasks that involve rela-
tionships between project and non-project
activities.

external failure cost A cost related to all
errors not detected and corrected before
delivery to the customer.

fallback plans Plans developed for
risks that have a high impact on meeting
project objectives, to be implemented if
attempts to reduce the risk are not
effective.

fast tracking A schedule compression
technique in which you do activities in
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parallel that you would normally do in
sequence.

features The special characteristics that
appeal to users.

feeding buffers Additional time added
before tasks on the critical path that are
preceded by non-critical-path tasks.

fishbone diagram Diagram that traces
complaints about quality problems back to
the responsible production operations to help
find the root cause. Also known as cause-
and-effect diagram or Ishikawa diagram.

fitness for use A product can be used as
it was intended.

finish-to-start dependency A relationship
on a project network diagram where the
from activity must be finished before the
to activity can be started.

fixed-price contract Contract with a fixed
total price for a well-defined product or ser-
vice; also called a lump-sum contract.

float The amount of time a project activi-
ty may be delayed without delaying a suc-
ceeding activity or the project finish date;
also called slack.

flowchart Graphic display of the logic and
flow of processes that helps you analyze how
problems occur and how processes can be
improved.

forecasts Used to predict future project
status and progress based on past informa-
tion and trends.

forcing mode Using a win-lose approach
to conflict resolution to get one s way.

forward pass A network diagramming
technique that determines the early start
and early finish dates for each activity.

free slack (free float) The amount of time
an activity can be delayed without delaying

the early start of any immediately following
activities.

functionality The degree to which a sys-
tem performs its intended function.

functional organizational structure An
organizational structure that groups people
by functional areas such as information
technology, manufacturing, engineering,
and human resources.

Gantt chart A standard format for display-
ing project schedule information by listing
project activities and their corresponding
start and finish dates in a calendar format;
sometimes referred to as bar chart.

Google Docs Online applications offered
by Google that allow users to create, share,
and edit documents, spreadsheets, and pre-
sentations online.

green IT or green computing Developing
and using computer resources in an efficient
way to improve economic viability, social
responsibility, and environmental impact.

groupthink Conformance to the values
or ethical standards of a group.

hierarchy of needs A pyramid structure
illustrating Maslow s theory that people s
behaviors are guided or motivated by a
sequence of needs.

histogram A bar graph of a distribution
of variables.

human resources frame Focuses on pro-
ducing harmony between the needs of the
organization and the needs of people.

indirect costs Costs that are not directly
related to the products or services of the
project, but are indirectly related to per-
forming the project.

influence diagram Diagram that repre-
sents decision problems by displaying essen-
tial elements, including decisions,
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uncertainties, and objectives, and how they
influence each other.

initiating processes Defining and autho-
rizing a project or project phase.

intangible costs or benefits Costs or bene-
fits that are difficult to measure in monetary
terms.

integrated change control Identifying,
evaluating, and managing changes through-
out the project life cycle.

integration testing Testing that occurs
between unit and system testing to test
functionally grouped components to ensure
a subset(s) of the entire system works
together.

interface management Identifying and
managing the points of interaction between
various elements of a project.

internal failure cost A cost incurred to
correct an identified defect before the cus-
tomer receives the product.

internal rate of return (IRR) The dis-
count rate that results in an NPV of zero for
a project.

interviewing A fact-finding technique
that is normally done face-to-face, but can
also occur through phone calls, e-mail, or
instant messaging.

intrinsic motivation Causes people to
participate in an activity for their own
enjoyment.

Ishikawa diagram Diagram that traces
complaints about quality problems back to
the responsible production operations to
help find the root cause. Also known as
cause-and-effect diagram or fishbone
diagram.

ISO 9000 A quality system standard
developed by the International Organization

for Standardization (ISO) that includes a
three-part, continuous cycle of planning,
controlling, and documenting quality in an
organization.

issue A matter under question or dispute
that could impede project success.

issue log A tool to document and monitor
the resolution of project issues.

IT governance Addresses the authority
and control for key IT activities in organiza-
tions, including IT infrastructure, IT use,
and project management.

Joint Application Design (JAD) Using
highly organized and intensive workshops
to bring together project stakeholders the
sponsor, users, business analysts, program-
mers, and so on to jointly define and
design information systems.

kick-off meeting A meeting held at the
beginning of a project so that stakeholders
can meet each other, review the goals of the
project, and discuss future plans.

known risks Risks that the project team
have identified and analyzed and can be
managed proactively.

known unknowns Dollars included in a
cost estimate to allow for future situations
that may be partially planned for (sometimes
called contingency reserves) and are included
in the project cost baseline.

late finish date The latest possible time
an activity can be completed without delay-
ing the project finish date.

late start date The latest possible time
an activity may begin without delaying the
project finish date.

leader A person who focuses on long-
term goals and big-picture objectives,
while inspiring people to reach those
goals.
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learning curve theory A theory that states
that when many items are produced repeti-
tively, the unit cost of those items normally
decreases in a regular pattern as more units
are produced.

legitimate power Getting people to do
things based on a position of authority.

lessons-learned report Reflective state-
ments written by project managers and
their team members to document important
things they have learned from working on
the project.

life cycle costing Considers the total cost
of ownership, or development plus support
costs, for a project.

lump-sum contract Contract with a fixed
total price for a well-defined product or ser-
vice; also called a fixed-price contract.

maintainability The ease of performing
maintenance on a product.

make-or-buy decision When an organiza-
tion decides if it is in its best interests to
make certain products or perform certain
services inside the organization, or if it is
better to buy them from an outside
organization.

Malcolm Baldrige National Quality
Award An award started in 1987 to recog-
nize companies that have achieved a level
of world-class competition through quality
management.

management reserves Dollars
included in a cost estimate to allow for
future situations that are unpredict-
able (sometimes called unknown
unknowns).

manager A person who deals with the
day-to-day details of meeting specific goals.

mandatory dependencies Sequencing of
project activities or tasks that are inherent

in the nature of the work being done on the
project.

matrix organizational structure An orga-
nizational structure in which employees are
assigned to both functional and project
managers.

maturity model A framework for helping
organizations improve their processes and
systems.

mean The average value of a population.

measurement and test equipment
costs The capital cost of equipment used
to perform prevention and appraisal
activities.

merge When two or more nodes precede
a single node on a network diagram.

methodology Describes how things
should be done.

metric A standard of measurement.

milestone A significant event that
normally has no duration on a project;
serves as a marker to help in
identifying necessary activities,
setting schedule goals, and monitoring
progress.

mind mapping A technique that uses
branches radiating out from a core idea to
structure thoughts and ideas.

mirroring Matching certain behaviors of
the other person.

Monte Carlo analysis A risk quantifica-
tion technique that simulates a model s out-
come many times, to provide a statistical
distribution of the calculated results.

monitoring and controlling processes
Regularly measuring and monitoring prog-
ress to ensure that the project team meets
the project objectives.
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multitasking When a resource works on
more than one task at a time.

Murphy s Law Principle that if something
can go wrong, it will.

Myers-Briggs Type Indicator (MBTI) A
popular tool for determining personality
preferences.

net present value (NPV) analysis A meth-
od of calculating the expected net monetary
gain or loss from a project by discounting all
expected future cash inflows and outflows to
the present point in time.

network diagram A schematic display of
the logical relationships or sequencing of
project activities.

node The starting and ending point of an
activity on an activity-on-arrow diagram.

normal distribution A bell-shaped curve
that is symmetrical about the mean of the
population.

offshoring Outsourcing from another
country.

organizational breakdown structure (OBS)
A specific type of organizational chart

that shows which organizational units are
responsible for which work items.

organizational culture A set of shared
assumptions, values, and behaviors that
characterize the functioning of an
organization.

organizational process assets Formal and
informal plans, policies, procedures,
guidelines, information systems, financial
systems, management systems, lessons
learned, and historical information that
can be used to influence a project s
success.

opportunities Chances to improve the
organization.

opportunity cost of capital The rate used
in discounting future cash flow; also called
the capitalization rate or discount rate.

outsourcing When an organization
acquires goods and/or sources from an out-
side source.

overallocation When more resources
than are available are assigned to perform
work at a given time.

overrun The additional percentage or
dollar amount by which actual costs exceed
estimates.

parametric modeling A cost-estimating
technique that uses project characteristics
(parameters) in a mathematical model to
estimate project costs.

Pareto analysis Identifying the vital few
contributors that account for most quality
problems in a system.

Pareto chart Histogram that helps identi-
fy and prioritize problem areas.

Parkinson s Law Principle that work
expands to fill the time allowed.

payback period The amount of time it
will take to recoup, in the form of net cash
inflows, the total dollars invested in a
project.

performance How well a product or ser-
vice performs the customer s intended use.

PERT weighted average optimistic time
4 * most likely time pessimistic time

planned value (PV) That portion of the
approved total cost estimate planned to be
spent on an activity during a given period.

planning processes Devising and main-
taining a workable scheme to ensure that
the project addresses the organization s
needs.
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phase exit or kill point Management
review that should occur after each project
phase to determine if projects should be
continued, redirected, or terminated.

Point of Total Assumption (PTA) The
cost at which the contractor assumes total
responsibility for each additional dollar of
contract cost in a fixed price incentive fee
contract.

political frame Addresses organizational
and personal politics.

politics Competition between groups or
individuals for power and leadership.

power The potential ability to influence
behavior to get people to do things they
would not otherwise do.

Precedence Diagramming Method
(PDM) A network diagramming tech-
nique in which boxes represent activities.

predictive life cycle A software develop-
ment approach used when the scope of the
project can be clearly articulated and the
schedule and cost can be accurately
predicted.

prevention cost The cost of planning and
executing a project so that it is error-free or
within an acceptable error range.

probability/impact matrix or chart A
matrix or chart that lists the relative proba-
bility of a risk occurring on one side of a
matrix or axis on a chart and the relative
impact of the risk occurring on the other.

probabilistic time estimates Duration
estimates based on using optimistic, most
likely, and pessimistic estimates of activity
durations instead of using one specific or
discrete estimate.

problems Undesirable situations that pre-
vent the organization from achieving its
goals.

process A series of actions directed
toward a particular result.

process adjustments Adjustments made
to correct or prevent further quality pro-
blems based on quality control
measurements.

procurement Acquiring goods and/or ser-
vices from an outside source.

profit margin The ratio between revenues
and profits.

profits Revenues minus expenses.

program A group of projects managed in
a coordinated way to obtain benefits and
control not available from managing them
individually.

Program Evaluation and Review Technique
(PERT) A project network analysis tech-
nique used to estimate project duration
when there is a high degree of uncertainty
with the individual activity duration
estimates.

program manager A person who provides
leadership and direction for the project
managers heading the projects within a
program.

progress reports Reports that describe
what the project team has accomplished
during a certain period of time.

project A temporary endeavor undertaken
to create a unique product, service, or result.

project acquisition The last two phases
in a project (implementation and close-out)
that focus on delivering the actual work.

project archives A complete set of orga-
nized project records that provide an accu-
rate history of the project.

project buffer Additional time added
before the project s due date.
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project charter A document that formal-
ly recognizes the existence of a project
and provides direction on the project s
objectives and management.

project cost management The processes
required to ensure that the project is com-
pleted within the approved budget.

project feasibility The first two phases in
a project (concept and development) that
focus on planning.

project integration management
Processes that coordinate all project man-
agement knowledge areas throughout a pro-
ject s life, including developing the project
charter, developing the preliminary project
scope statement, developing the project
management plan, directing and managing
the project, monitoring and controlling the
project, providing integrated change con-
trol, and closing the project.

project life cycle A collection of project
phases, such as concept, development,
implementation, and close-out.

project management The application of
knowledge, skills, tools, and techniques to
project activities to meet project
requirements.

Project Management Institute (PMI) An
international professional society for project
managers.

project management knowledge areas
Project integration management, scope,
time, cost, quality, human resource, com-
munications, risk, and procurement
management.

Project Management Office (PMO) An
organizational group responsible for coordi-
nating the project management functions
throughout an organization.

project management plan A document
used to coordinate all project planning

documents and guide project execution and
control.

project management process groups The
progression of project activities from initia-
tion to planning, executing, monitoring and
controlling, and closing.

Project Management Professional
(PMP) Certification provided by PMI that
requires documenting project experience
and education, agreeing to follow the PMI
code of ethics, and passing a comprehensive
exam.

project management tools and
techniques Methods available to assist
project managers and their teams; some pop-
ular tools in the time management knowl-
edge area include Gantt charts, network
diagrams, and critical path analysis.

project manager The person responsible
for working with the project sponsor, the
project team, and the other people involved
in a project to meet project goals.

project organizational structure An orga-
nizational structure that groups people by
major projects, such as specific aircraft
programs.

project procurement management The
processes required to acquire goods and ser-
vices for a project from outside the perform-
ing organization.

project portfolio management (portfolio
management) When organizations group
and manage projects as a portfolio of invest-
ments that contribute to the entire enter-
prise s success.

project quality management Ensuring
that a project will satisfy the needs for
which it was undertaken.

project scope management The processes
involved in defining and controlling what
work is or is not included in a project.
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project scope statement A document that
includes, at a minimum, a description of the
project, including its overall objectives and
justification, detailed descriptions of all
project deliverables, and the characteristics
and requirements of products and services
produced as part of the project.

PRojects IN Controlled Environments
(PRINCE2) A project management meth-
odology developed in the U.K. that defines
45 separate sub-processes and organizes
these into eight process groups.

project sponsor The person who provides
the direction and funding for a project.

project time management The processes
required to ensure timely completion of a
project.

proposal A document prepared by sellers
when there are different approaches for
meeting buyer needs.

prototyping Developing a working replica
of the system or some aspect of the system
to help define user requirements.

quality The totality of characteristics of
an entity that bear on its ability to satisfy
stated or implied needs or the degree to
which a set of inherent characteristics fulfill
requirements.

quality assurance Periodically evaluating
overall project performance to ensure that
the project will satisfy the relevant quality
standards.

quality audit Structured review of specif-
ic quality management activities that helps
identify lessons learned and can improve
performance on current or future projects.

quality circles Groups of nonsupervisors
and work leaders in a single company depart-
ment who volunteer to conduct group studies
on how to improve the effectiveness of work
in their department.

quality control Monitoring specific project
results to ensure that they comply with the
relevant quality standards and identifying
ways to improve overall quality.

quality planning Identifying which quali-
ty standards are relevant to the project and
how to satisfy them.

RACI charts Charts that show Responsi-
bility, Accountability, Consultation, and
Informed roles for project stakeholders.

rapport A relation of harmony, conformi-
ty, accord, or affinity.

rate of performance (RP) The ratio of
actual work completed to the percentage of
work planned to have been completed at
any given time during the life of the project
or activity.

Rational Unified Process (RUP) An itera-
tive software development process that
focuses on team productivity and delivers
software best practices to all team
members.

referent power Getting people to do
things based on an individual s personal
charisma.

reliability The ability of a product or ser-
vice to perform as expected under normal
conditions.

Request for Proposal (RFP) A document
used to solicit proposals from prospective
suppliers.

Request for Quote (RFQ) A document
used to solicit quotes or bids from prospec-
tive suppliers.

required rate of return The minimum
acceptable rate of return on an investment.

requirement A condition or capability
that must be met or possessed by a system,
product, service, result, or component to

G.12

Glossary

      Copyright 2011 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). 

Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Licensed to:



satisfy a contract, standard, specification,
or other formal document.

requirements management plan A plan
that describes how project requirements
will be analyzed, documented, and
managed.

requirements traceability matrix A table
that lists requirements, various attributes of
each requirement, and the status of the
requirements to ensure that all require-
ments are addressed.

reserves Dollars included in a cost esti-
mate to mitigate cost risk by allowing for
future situations that are difficult to
predict.

residual risks Risks that remain after all
of the response strategies have been
implemented.

resource breakdown structure A
hierarchical structure that identifies
the project s resources by category and
type.

resource histogram A column chart that
shows the number of resources assigned to
a project over time.

resource leveling A technique for resolv-
ing resource conflicts by delaying tasks.

resource loading The amount of individu-
al resources an existing schedule requires
during specific time periods.

resources People, equipment, and
materials.

responsibility assignment matrix
(RAM) A matrix that maps the work of
the project as described in the WBS to the
people responsible for performing the work
as described in the organizational break-
down structure (OBS).

return on investment (ROI) (Benefits
minus costs) divided by costs.

reward power Using incentives to induce
people to do things.

rework Action taken to bring rejected
items into compliance with product require-
ments or specifications or other stakeholder
expectations.

risk An uncertainty that can have a nega-
tive or positive effect on meeting project
objectives.

risk acceptance Accepting the conse-
quences should a risk occur.

risk-averse Having a low tolerance for
risk.

risk avoidance Eliminating a specific
threat or risk, usually by eliminating its
causes.

risk breakdown structure A hierarchy of
potential risk categories for a project.

risk enhancement Changing the size of
an opportunity by identifying and maximiz-
ing key drivers of the positive risk.

risk events Specific uncertain events that
may occur to the detriment or enhancement
of the project.

risk exploitation Doing whatever you can
to make sure the positive risk happens.

risk factors Numbers that represent over-
all risk of specific events, given their proba-
bility of occurring and the consequence to
the project if they do occur.

risk management plan A plan that docu-
ments the procedures for managing risk
throughout a project.

risk mitigation Reducing the impact of a
risk event by reducing the probability of its
occurrence.

risk-neutral A balance between risk and
payoff.
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risk owner The person who will take
responsibility for a risk and its associated
response strategies and tasks.

risk register A document that contains
results of various risk management process-
es, often displayed in a table or spreadsheet
format.

risk-seeking Having a high tolerance for
risk.

risk sharing Allocating ownership of the
risk to another party.

risk tolerance The amount of satisfaction
or pleasure received from a potential payoff;
also called risk utility.

risk transference Shifting the conse-
quence of a risk and responsibility for its
management to a third party.

risk utility The amount of satisfaction or
pleasure received from a potential payoff;
also called risk tolerance.

Robust Design methods Methods that
focus on eliminating defects by substituting
scientific inquiry for trial-and-error
methods.

rough order of magnitude (ROM) estimate
A cost estimate prepared very early in the life
of a project to provide a rough idea of what a
project will cost.

runaway projects Projects that have sig-
nificant cost or schedule overruns.

run chart Chart that displays the history
and pattern of variation of a process over
time.

scatter diagram Diagram that helps to
show if there is a relationship between two
variables; also called XY charts.

schedule baseline The approved planned
schedule for the project.

schedule performance index (SPI) The
ratio of earned value to planned value; can
be used to estimate the projected time to
complete a project.

schedule variance (SV) The earned value
minus the planned value.

scope All the work involved in creating
the products of the project and the process-
es used to create them.

scope baseline The approved project
scope statement and its associated WBS and
WBS dictionary.

scope creep The tendency for project
scope to keep getting bigger.

secondary risks Risks that are a direct
result of implementing a risk response.

sellers Contractors, suppliers, or provi-
ders who provide goods and services to oth-
er organizations.

sensitivity analysis A technique used to
show the effects of changing one or more
variables on an outcome.

seven run rule If seven data points in a
row on a quality control chart are all below
the mean, above the mean, or are all
increasing or decreasing, then the process
needs to be examined for nonrandom
problems.

SharePoint portal Allows users to create
custom Web sites to access documents and
applications stored on shared devices.

six 9s of quality A measure of quality
control equal to 1 fault in 1 million
opportunities.

Six Sigma A comprehensive and flexible
system for achieving, sustaining, and max-
imizing business success that is uniquely
driven by close understanding of customer
needs, disciplined use of facts, data, statis-
tical analysis, and diligent attention to
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managing, improving, and reinventing
business processes.

Six Sigma methodologies DMAIC (Define,
Measure, Analyze, Improve, and Control) is
used to improve an existing business pro-
cess and DMADV (Define, Measure, Analyze,
Design, and Verify) is used to create new
product or process designs.

slack The amount of time a project activi-
ty may be delayed without delaying a suc-
ceeding activity or the project finish date;
also called float.

slipped milestone A milestone activity
that is completed later than planned.

SMART criteria Guidelines to help define
milestones that are specific, measurable,
assignable, realistic, and time-framed.

smoothing mode Deemphasizing or
avoiding areas of differences and emphasiz-
ing areas of agreements.

software defect Anything that must be
changed before delivery of the program.

Software Quality Function Deployment
(SQFD) model A maturity model that
focuses on defining user requirements and
planning software projects.

staffing management plan A document
that describes when and how people will be
added to and taken off a project team.

stakeholder management strategy An
approach to help increase the support of sta-
keholders throughout the project.

stakeholder register A document that
includes details related to the identified
project stakeholders.

stakeholders People involved in or affect-
ed by project activities.

standard Describes best practices for
what should be done.

standard deviation A measure of how
much variation exists in a distribution of
data.

start-to-finish dependency A relationship
on a project network diagram where the
from activity cannot start before the to

activity is finished.

start-to-start dependency A relationship
on a project network diagram in which the
from activity cannot start.

statement of work (SOW) A description
of the work required for the procurement.

statistical sampling Choosing part of a
population of interest for inspection until
the to activity starts.

status reports Reports that describe
where the project stands at a specific point
in time.

strategic planning Determining long-term
objectives by analyzing the strengths and
weaknesses of an organization, studying oppor-
tunities and threats in the business environ-
ment, predicting future trends, and projecting
the need for new products and services.

structural frame Deals with how the orga-
nization is structured (usually depicted in
an organizational chart) and focuses on dif-
ferent groups roles and responsibilities to
meet the goals and policies set by top
management.

subproject managers People responsible
for managing the subprojects that a large
project might be broken into.

sunk cost Money that has been spent in
the past.

SWOT analysis Analyzing Strengths,
Weaknesses, Opportunities, and Threats;
used to aid in strategic planning.

symbolic frame Focuses on the symbols,
meanings, and culture of an organization.
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synergy An approach where the whole is
greater than the sum of the parts.

system outputs The screens and reports
the system generates.

systems Sets of interacting components
working within an environment to fulfill
some purpose.

systems analysis A problem-solving
approach that requires defining the scope
of the system to be studied, and then divid-
ing it into its component parts for identify-
ing and evaluating its problems,
opportunities, constraints, and needs.

systems approach A holistic and analyti-
cal approach to solving complex problems
that includes using a systems philosophy, sys-
tems analysis, and systems management.

systems development life cycle
(SDLC) A framework for describing the
phases involved in developing and maintain-
ing information systems.

systems management Addressing the
business, technological, and organizational
issues associated with creating, maintaining,
and making changes to a system.

systems philosophy An overall model for
thinking about things as systems.

system stakeholder register A public doc-
ument that includes details related to the
identified project stakeholders.

systems thinking Taking a holistic view
of an organization to effectively handle com-
plex situations.

tangible costs or benefits Costs or
benefits that can be easily measured in
dollars.

task An element of work, normally found
on the WBS, that has an expected duration
and cost, and expected resource require-
ments; also called an activity.

team development Building individual
and group skills to enhance project
performance.

termination clause A contract clause that
allows the buyer or supplier to end the
contract.

testing Testing the entire system as one
entity to ensure that it is working properly.

Theory of Constraints (TOC) A manage-
ment philosophy that states that any
complex system at any point in time often
has only one aspect or constraint that is
limiting its ability to achieve more of
its goal.

three-point estimate An estimate that
includes an optimistic, most likely, and pes-
simistic estimate.

time and material (T&M) contracts
A hybrid of both fixed-price and cost-reim-
bursable contracts.

top-down approach Creating a WBS by
starting with the largest items of the project
and breaking them into their subordinate
items.

top-down estimates A cost estimating
technique that uses the actual cost of a pre-
vious, similar project as the basis for esti-
mating the cost of the current project, also
called analogous estimates.

Top Ten Risk Item Tracking A qualitative
risk analysis tool for identifying risks and
maintaining an awareness of risks through-
out the life of a project.

total slack (total float) The amount of
time an activity may be delayed from its
early start without delaying the planned
project finish date.

Tracking Gantt chart A Gantt chart that
compares planned and actual project sched-
ule information.
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triggers Indications for actual risk
events.

triple constraint Balancing scope, time,
and cost goals.

Tuckman model Describes five stages of
team development: forming, storming,
norming, performing, and adjourning.

unit pricing An approach in which the
buyer pays the supplier a predetermined
amount per unit of service, and the total val-
ue of the contract is a function of the quan-
tities needed to complete the work.

unit test A test of each individual compo-
nent (often a program) to ensure that it is
as defect-free as possible.

unknown risks Risks that have not been
identified and analyzed so they cannot be
managed proactively.

unknown unknowns Dollars included in
a cost estimate to allow for future situations
that are unpredictable (sometimes called
management reserves).

use case modeling A process for identify-
ing and modeling business events, who initi-
ated them, and how the system should
respond to them.

user acceptance testing An independent
test performed by end users prior to accept-
ing the delivered system.

variance The difference between planned
and actual performance.

virtualization Hiding the physical charac-
teristics of computing resources from their

users, such as making a single server, oper-
ating system, application, or storage device
appear to function as multiple virtual
resources.

virtual team A group of individuals who
work across time and space using communi-
cation technologies.

watch list A list of risks that are low prior-
ity, but are still identified as potential risks.

WBS dictionary A document that
describes detailed information about each
WBS item.

weighted scoring model A technique that
provides a systematic process for basing
project selection on numerous criteria.

wiki A Web site that has a page or pages
designed to enable anyone who accesses it
to contribute or modify content.

withdrawal mode Retreating or withdraw-
ing from an actual or potential
disagreement.

workarounds Unplanned responses to
risk events when there are no contingency
plans in place.

work breakdown structure (WBS) A
deliverable-oriented grouping of the work
involved in a project that defines the total
scope of the project.

work package A task at the lowest level
of the WBS.

yield The number of units handled cor-
rectly through the development process.
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Note: Page numbers in boldface type indi-
cate key terms and their definitions.

A

Accept software, 181 182
achievement, as motivator,

346 347
acquired-needs theory, 346 347
ACs. See actual costs (ACs)
activity attributes, 215, 215 216
activity duration, estimating, 213 214,

223, 236
activity list, 213, 215, 216
activity-on-arrow approach (AOA), 218,

218 219
sample, 218

activity resources, estimating 213, 222
activity sequencing, 217 220
actual costs (ACs), 273

Microsoft Project 2010, A.52 A.57
actual times, Microsoft Project 2010,

A.52 A.57
Adaptive Software Development (ASD) life

cycle, 60, 60 61
Addeman, Frank, 229
ADM. See arrow-diagramming method

(ADM)
affiliation, as motivator, 346 347
AgenciaClick, 86
agile methodologies, 85
Allied Signal/Honeywell, 309
Alpha Project Managers: What the Top 2%

Know That Everyone Else Does Not
(Crowe), 80

Ameritrade, 294
analogous estimates, 263

AOA. See activity-on arrow approach
(AOA)

analogy approach, WBD development, 192
arrow-diagramming method (ADM), 218,

218 219
ASD. See adaptive software development

(ASD) life cycle
Athens Olympic Games, 213
Axelrod, David, 272

B

BAC. See budget at completion (BAC)
BAFO. See best and final offer
balanced scorecard, 146, 146 147
Balanced Scorecard Institute, 146
Bank of America, 294
Basecamp, 33
baseline, 159, 159 160

saving files with or without in Microsoft
Project 2010, A.24

scope, 194 195
baseline plans, Microsoft Project 2010,

A.51 A.52
The Bases of Social Power (French and

Raven), 349
basic productivity software, 32
Belbin, Meredith, 368
benchmarking, 299
benefits

intangible, 270
tangible, 270

best and final offer (BAFO), 479
Best Companies to Work For , 359

best practices, 19
bids, 475, 477 478
blogs, 411
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Boots Company PLC, 467
bottom-up approach, WBD development,

192 193
bottom-up estimates, 264
Briggs, Katherine C., 364 365
broad organizational needs, as method for

selecting projects, 138
Brooks, Frederick, 394
BSM tools. See business service

management (BSM) tools
budget at completion (BAC), 275, 275 276
buffers, 235
Bullock, Fraser, 160
bursts, in AOA diagrams, 219
business cases, 83, 88 91

contents, 88
sample, 89 91

Business Process Reengineering (BPR), 308
business service management (BSM)

tools, 165 166
Butrick, Robert, 19

C

Calendar view, Microsoft Project 2010,
A.13

Capability Maturity Model Integration
(CMMI), 323

capital, opportunity cost of, 141
CAPM. See Certified Associate in Project

Management (CAPM) certification
Carlyle, Thomas, 12
Carr, Nicholas, 6
cash flow analysis, 259
cause-and-effect diagrams, 300, 300 301

sample, 301
Cavanaugh, Roland, 307, 309, 312
CCB. See change control board (CCB)
certifications, 29 32

CAPM, B.2, B.18
CITPM, B.18
CNE, B.14
CNI, B.14
CompTIA, B.13
IPMA, B.18

MCITP, B.17
MCTS, B.17
MOS, B.17
PgMPSM, B.2, B.18
PMP, 30, 56, 356, 477, 479, B.1 B.10

Certified Associate in Project Management
(CAPM) certification, B.2, B.18

Certified IT Project Manager
(CTPM) certification, B.18

Certified Project Manager, B.18
Certified Project Management

Associate, B.18
Certified Novell Engineer (CNE)

certification, B.14
Certified Novell Instructor (CNI)

certification, B.14
Certified Senior Project Manager, B.18
champions, 54
change control board (CCB), 162,

162 163
change control system, 162, 162 163
change requests, 14, 160 161
CHAOS Report, 3 4, 16
checklists, 295, 436
Chemical Bank, 294
CITPM. See Certified IT Project Manager

(CITPM) certification
close-out phase of projects, 59, 164
closing processes, 79, 82, 114
CNE. See Certified Novell Engineer (CNE)

certification
CNI. See Certified Novell Instructor (CNI)

certification
code of ethics, 31 32
Cohen, Dennis, 139
collaborating mode, 400
collecting requirements, 179 182
Comair, 432
commitment of top management,

54 55, 62
communications

formal versus informal 390
group communication needs, 394 396
individual communcation needs,

394 396
team size, 395 396
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communications management, 12, 13,
382 412

appropriate medium, 390 394,
405 406

best practices, 405 406
channels, 395 396
improving, 399 400
information distribution, 388 396
managing stakeholders, 385 386,

396 398
mapping process groups to, 84
Microsoft Project 2010, A.66 A.68
performance reporting, 398 399
updating business procedures, 388 389

communications management plans, 386,
386 388

communications management planning,
386 388

plans, 386 388
communications media, 392 393
compromise mode, 400
computer viruses, 321
Computing Technology Industry

Association (CompTIA)
certification, B.13

concept stage of project(s), 57 58
configuration management, 163
conflict management, 399 400
conformance to requirements, 294
confrontation mode, 400
constructive change orders,

479, 479 480
contingency plans, 429
contingency reserves (allowances), 430
contracts, 464, 469 473

administration, 479 480
cost-reimbursable, 470 473
fixed price (lump-sum), 469 470
procurement, 477 479
risk-related, 472 473
time-and-material, 472

contract statements of work (SOWs), 474,
474 475

control charts, 301, 301 302
sample, 302

Cooper, Robert, 137

Copper, 33
core projects, 20
corrective actions, 159 161
cost, 255

direct, 260
estimating, 261 270
indirect, 260
intangible, 259
tangible, 259
sunk, 260

cost, viewing in Microsoft Project 2010,
A.49 A.51

cost baselines, 271
cost budgeting, 270 271
cost estimates, 261 270

analogous estimates, 263
bottom-up estimates, 264
budgetary estimate, 261
definitive estimate, 261
parametric modeling, 264
problems, 264 265
rough order of magnitude (ROM), 261
sample, 265 270

cost estimates, Microsoft Project 2010,
A.43 A.45

cost management, 12, 13, 257 280
best practices, 279
controlling, 272 278
cost baseline, 271
cost budgeting, 270 272
mapping process groups to, 84
Microsoft Project 2010, 280,

A.42 A.49
cost management planning, 256 257, 262
cost performance index (CPI), 275
cost-reimbursable contract, 470 473
cost table, Microsoft Project 2010,

A.43, A.67
cost table view, Microsoft Project 2010,

A.12, A.67
cost variance, (CV), 275
Cottrell, Bill, 85
Covey, Steven, 350 351, 400
CPI. See cost performance index (CPI)
CPM. See critical path method (CPM)
crashing, 233
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critical chain scheduling, 233, 233 236
critical path, 27, 228 229, 236
critical path calculation, 228 233

importance of updating data, 233
Microsoft Project 2010, 231,

A.40 A.42
schedule trade-offs, 230 233
understanding, 229 230

critical path method (CPM),
228, 228 233

Critical Tasks report, A.40 A.42
Crosby, Philip B., 316 317
Crosstab Report dialog box, Microsoft

Project 2010, A.49, A.50
Crowe, Andy, 80
Cruise Control, 66
cultural differences, 212, 322 323
Customer Relationship Management (CRM)

Excellence Awards, 56
customer satisfaction, 9 10, 15
Custom Reports, in Mircosoft Project

2010, A.67
CV. See cost variance
cyberslackers, 401 402

D

D Agostinho, Fabiano, 86
decision tree, 442, 442 444
deliverables, 57

accepted and unaccepted, 179
Dell, Michael, 259
Delphi Technique, 435
Demers, Clement, 111
Deming, W. Edwards, 315 316
dependencies, 217, 217 220
development phase of projects, 58
DFAS. See U.S. Defense Finance and

Accounting Services (DFAS)
Digital Suplly Chain, 6
directives, 139
DISC Profile, 367 368
discount factor, 142
discount rate, 141
discretionary dependencies, 217

DMADV (Define, Measure, Analyze, Design,
Verify) methodology, 86

DMAIC (Define, Measure, Analyze,
Improve, Control) methodology,
307 308

DOD. See U. S. Department of Defense
(DOD)

Does IT Matter? Information Technology
and the Corrosion of Competitive
Advantage (Carr), 6

duration, 222
estimating, 222 223

E

EAC. See estimate at completion
earned value (EV), 273
earned value management (EVM), 273,

273 278, 398 399
actual cost, 273
cost performance index, 275
cost variance, 275
estimate at completion, 275
Microsoft Project 2010, 277 278,

A.57 A.59
planned value, 273
schedule performance index, 275
schedule variance, 275

Earned Value view, Microsoft Project 2010,
A.12, A.67

effort, 222
e-mail, 403 406
empathic listening, 350, 350 351, 390
enterprise resource planning (ERP), 48
Entry table, assigning resources in

Microsoft Project 2010, A.14
Entry Table view, Microsoft Project 2010,

A.7 A.8, A.11
ERP. See enterprise resource planning

(ERP)
estimate at completion (EAC), 275
ethics, 31, 31 32
EV. See earned value (EV)
EVM. See earned value management

(EVM)
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exams
PMP certification, B.4 B.13
Project certification, B.14 B.17

executing processes, 79, 81 82, 106 110
communications managaement, 388 398
human resource management, 357 368
integration management, 156 158
procurement management, 477 479
project quality management, 298 299
summary of tasks and outputs, 158 159

executing projects, 156 159
executive steering committee, 62
expectations management matrix, 397,

397 398
sample, 398

expected monetary value, 442, 442 444
sample, 443

external dependencies, 217
extreme programming, 85
extrinsic motivation, 344
Extrovert/Introvert (E/I) psychological

type, 364

F

fallback plans, 429
fast tracking, 233
Federal Bureau of Investigation (FBI),

216 217
feeding buffers, 235
Feigenbaum Armand, V., 318
firm-fixed price (FFP) contracts, 470
fishbone diagrams. See cause-and-effect

diagrams
fitness for use, 294
fixed costs, entering in Microsoft Project

2010, A.43, A.49
fixed-price contracts, 469, 469 470
float, 228, 230
flowcharts, 305

sample, 305
forcing mode, 400
forecasts, 398, 398 399
Form views, Microsoft Project 2010,

A.11, A.12

formal communications, 390
FoxMeyer Drug, 197
frames of organizations, 47 48
Freud, Sigmund, 344
functional organizational structure, 48 49,

50 51

G

Gantt charts, 14, 27, 224 228
Microsoft Project 2010, 27, 224 225,

240, A.36 A.38
sample, 28, 189, 224, 227
tracking, 226 228

Gantt Chart view, Microsoft Project 2010,
A.6, A.7, A.12, A.14, A.40, A.47, A.67

Gartner, Inc., 56
Genesys Telecommunications

Laboratories, 181
Gertner Institute Certification Program,

B.13 B.14
globalization, effect on IT projects, 65 68
Global Positioning Systems, 6
Goldratt, Eliyah M., 233
Google, 359
Google Docs, 404, 404 405
Gottron, Joe, 62 63
Government Accountability Office (GAO),

81, 255
Graham, Robert, 139
Graphical views, Microsoft Project 2010,

A.11, A.12, A.13
Greenbaum, Joshua, 198
Ground Zero, 53 54
groupthink, 400
Groves, Leslie R., 27
guidelines, WBD development, 191 192

H

Harley-Davidson, 63
Herzberg, Frederick, 345 346

motivation-hygiene thoery, 345 346
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Hewlett Packard, 137, 356
hierarchy of needs, 344 345
Hillson, David, 424 425
histograms, 304

sample, 304
holistic thinking. See systems thinking
human resource costs, entering in

Microsoft Project 2010,
A.43 A.44

human resource management, 12, 13,
342 370

effectiveness research, 344 352
influence bases, 348
mapping process groups to, 84
Microsoft Project 2010, 368,

A.60 A.66
motivation, 344 352
resource loading and leveling, 359 362
reward and recognition systems, 368
team acquisition, 357 359
team development, 362 368
team management tools and techniques,

368 370
team performance assessment, 368

human resource management planning,
352 357

organizational charts, 352 353
RAMs, 354
resource histograms, 357
staffing management plans, 356 357
work definition and assignment,

353 354
Human Side of Enterprise, The

(McGregor), 347
hyperlinks, inserting with Microsoft Project

2010, A.68 A.71

I

Ibbs, William, 423
IBM Global Business Services,

356 357, 467
identifying risk, 434 438
implementation phase of projects,

58 59

influence bases, 348
informal communication, 351
information distribution, 388 396
information technologies, 4 6, 56 57,

338 339
business strategy, 136 137
communication, 389 390,

403 405
IT governance, 55
projects, 63 68

initiating processes, 79, 81, 87, 89 96
example, 89 91
pre-initiation, 87 88

Insert Hyperlink dialog box, Microsoft
Project 2010, A.67, A.69

integrated change control, 161,
161 164

integration management. See project
integration management

integration management planning,
151 155

project management plans,
151 155

team contracts, 147 148
interface management, 131 132
internal rate of return (IRR), 143
Internal Revenue Servies (IRS),

80 81, 255
International Organization for

Standardization (ISO), 294, 298,
318 319

International Project Management
Association (IPMA) certification
program, B.18

intrinsic motivation, 344
IPMA. See International Project

Management Association (IPMA)
certification program

IRR. See internal rate of return
(IRR)

Ishikawa diagrams. See cause-and-effect
diagrams

Ishikawa, Kaoru, 317
issues, 369
issue logs, 369
IT governance, 55
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IT Governance: How Top Performers
Manage Decision Rights for Superior
Results (Weill and Ross), 55

J

Jackson, Peter, 82
JAD. See joint application design
Jehn, Karen, 400
Johnson, Jim, 62
Joint application design ( JAD), 60
JPMorgan Chase, 465
Judgement/Perception (J/P) psychological

type, 365
Juran, Joseph M., 316

K

Kanter, Rosabeth Moss, 19
Kaplan, Robert, 146
kick-off meetings, 14, 95

purpose, 95 96
sample, 96

kill points. See management reviews
knowledge areas, mapping process groups

to, 83 84
known unknowns, 260
Kwak, Young H., 423

L

lag time, Microsoft Project 2010, A.33 A.36
Lang, Paul, 181
lead time, Microsoft Project 2010, A.33 A.36
leadership, 24, 157, 319 320

contrasted with management, 24
skills, 24 25

learning curve theory, 260
Lehman, Matthew, 160
Lencioni, Patrick, 369 370
lessons-learned report, 409
Liew, Lawrence, 159
lump-sum contracts, 469, 469 470

M

make-or-buy analysis, 468, 468 470
sample, 469 470

Malcolm Baldridge National Quality
Award, 318

management, 24
compared with leadership, 24
skills, 22 24

management by walking around
(MBWA), 369

management reserves, 260
management reviews, 61 62
mandatory dependencies, 217
Manhattan Project, 27
Marche, Sunny, 48
Marston, William Moulton, 367
Maslow, Abraham, 344 345

hierarchy of needs, 344 345
matrix organized structure, 50 51
maturity models, 323, 323 325

Capability Maturity Model Integration,
323 324

Software Function Deployment
Model, 323

MBTI. See Myers-Briggs Type Indicator
(MBTI)

MBWA. See management by walking
around (MBWA)

McClelland, David, 346 347
acquired-needs theory, 346 347

McDonald s, 197
McGregor, Douglas, 347

Theory X and Theory Y, 347
MCITP. See Microsoft Certified IT

Professional (MCITP) certification
McNeally, Scott, 464
MCTS. See Microsoft Certified Technology

Specialist (MCTS) certification
meetings, 14, 95, 96, 402 403
merges in AOA diagrams, 219
Merril, David, 366
methodology, 85

development, 85 86
metrics, 295, 299

quality, 295, 299
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Microsoft Certified IT Professional (MCITP)
certification, B.17

Microsoft Certified Technology Specialist
(MCTS) certification, B.17

Microsoft Excel, 32 33, 446 447, A.8,
A.21, A.31, A.58

Microsoft Office Enterprise Project
Management (EPM) Solution,
409 410, 412

Microsoft Office Project Portfolio Server
2010, 33

Microsoft Office Project Professional 2010.
See Microsoft Project 2010

Microsoft Office Project Server 2010, A.2
Microsoft Office Specialist (MOS)

certification, B.17 B.18
Microsoft Project 2010

actual costs and times, A.52 A.57
assigning resources to tasks, A.45 A.49
baseline plans, A.51 A.52
communications management,

A.66 A.68
cost estimates, A.43 A.45
cost management, 280, A.42 A.59
creating new project file, A.17 A.19
critical path analysis, A.40 A.42
customizing Ribbon, A.18
earned value management, A.57 A.59
entering task durations, 114, A.25 A.30
evaluation copy, 33
filters, A.15 A.17
functions of features, A.67
Gantt charts, 240, A.6, A.36 A.38
human resource management, 370,

A.60 A.66
main screen elements, A.7 A.11
network diagrams, A.38 A.40
new features, A.3 A.4
Project Guide feature, A.5 A.6
reports, A.66 A.68
resource calendars, A.60 A.61
resource histograms, 360, A.61 A.63
resource leveling, 361, A.63 A.65
saving files, A.24, A.52
scope management, A.17 A.24
starting, A.5

task dependencies, 220, A.30 A.33
template files, A.8 A.11
templates, A.68 A.71
time management, 240, A.24 A.42
views, A.11 A.15
WBSs, 192, A.10, A.20 A.24

Microsoft Solution Framework, 441
Microsoft Word, 32, 102
milestones, 33, 215, 225 226

list, 213 217
milestone reports, 107 110

Milestones filter, in Microsoft Project
2010, A.16

MindManager, 135
mind mapping, 134, 134 135

sample, 135, 194
WBD development, 193 194

Minuteman, 33
mirroring, 351
Mittal Steel Poland, 239
monitoring and controlling processes,

79, 82
monitoring and controlling projects,

111 114
communications management, 398 399
cost management, 272 279
human resource management, 368 370
integration management, 159 164
procurement management, 479 480
quality management, 299 315
risk management, 450
scope management, 196 202
summary of outputs, 111 112
time management, 237 239

Monte Carlo analysis, 444, 444 445, 450
sample, 445

MOS. See Microsoft Office Specialist (MOS)
certification

motivation, 344 352
acquired-needs theory, 346 347
influences bases, 348
intrinsic versus extrinsic, 344
Maslow s hierarchy of needs, 344
motivation-hygiene theory, 345 346
Theory X and Theory Y, 347

Motorola, 309
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Mueller, Robert, 217
multitasking, 234, 234 235
Murphy s Law, 235
Myers, Isabel B., 364
Myers-Briggs Type Indicator (MBTI),

364, 364 366

N

NASP. See U. S. National Aerospace Plane
(NASP) project, 446

needs
achievement, 346 347
affiliation, 346 347
Maslow s hierarchy, 344
McClelland s acquired-needs theory,

346 347
McGregor s Theory X and Theory Y, 347
power, 346 349

Nelsestuen, Rodney, 425
net present value analysis, 139,

139 142
network diagrams, 27 28, 218, 218 220

Microsoft Project 2010, A.38 A.40
sample, 28

Network Diagram view, Microsoft Project
2010, A.9, A.12, A.13, A.67

Neuman, Robert, 307, 309, 312
New Line Cinema, 82
new product development (NPD), 137
NHS. See U. K. National Health Service.
nodes, in AOA diagrams, 218
Northrop Grumman, 197
Northwest Airlines, 263
Norton, David, 146
notes, inserting with Microsoft Project

2010, A.70
NPD. See new product development (NPD)
NPV. See net present value analysis

O

Obama, Barack, 271 272
Obermiller, Elizabeth, 56

OBS. See organizational breakdown
structure (OBS)

Olympic Games, 160, 213
One More Time: How Do You Motivate

Your Employees? (Herzberg), 346
OPM3. See Organizational Project

management Maturity Model (OPM3)
Oppenheimer, Robert, 27
opportunities, 139
opportunity cost of capital, 141
oral communication, 390 392, 394 396
organizations

four frames of, 467, 52 53
standards, 56 57
structures, 49 51

organizational breakdown structure
(OBS), 354

organizational charts, 49, 152, 352 357
sample, 353

organizational culture, 51 52, 157
organizational needs, project selection

based on, 138 139
Organizational Project Management

Maturity Model (OPM3), 19, 324 325
organizational standards, 56 57
Ouchi, William, 347 348
outsourcing, 66 68, 462 465
overallocation of resources, 360
overrun, 254, 254 256

P

Pande, Peter, 307, 309, 312
parametric modeling, 264
Pareto charts, 305, 305 306

sample, 305
Parkinson s Law, 235
payback analysis, 143 144
payback period, 143, 143 144
PDM. See precedence diagraming method

(PDM)
Pell, Philip, 80 81
people skills. See soft skills
performance assessment, 368 369
performance reporting, 398 399
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PERT. See Program Evaluation and Review
Technique (PERT)

Petroske, John, 405
PgMPSM. See Program Management

Professional (PgMPSM) certification
phase exits. See management reviews
phases, 57 58, 61 62
planned value (PV), 273
planning. See also project planning

for project selection, 135
strategic, 133 134
summary of tasks and outputs, 79, 81

planning processes, 79, 81, 96 106
PMBOK Guide, 83 84, 85, 148, 425

mapping process groups to knowledge
areas, 83 84

PMO. See project management offices
PMP Certification. See Project Management

Professional (PMP) certification
point of total assumption (PTA), 470
portfolio management, 18, 18 21, 278 278

categories, 19 20
contrasted with project management, 18

power, as factor in motivation, 346 349
precedence diagraming method (PDM),

219, 219 220
predictive life cycle, 60
Pricewaterhouse Coopers, 4
Primavera, 160
PRINCE2. See PRojects IN Controlled

Environments
Prior, Derek, 239
priority, project selection based on,

138 139
probabilistic time estimates, 236
probability/impact matrices, 438 439

sample, 439
problems, 138, 138 139
processes, 79, 79 82
procurement documents, 475 477
procurement management, 12, 13,

462 483
best practices, 480
contract administration, 479 481
contracts, 469 473
mapping process groups to, 84

procurement documents, 475 477
requesting seller lists, 465
source selection, 478 479

procurement management plans, 473 477
checklist, 473

procurement management planning,
466 477

contracts, 469 473
make-or-buy analyses, 468 469
plans, 473 477
requests for proposal or quote, 475 476
statements of work, 474 475
supplier evaluation, 478 479

product life cycles, 59 61
programs, 17
Program Evaluation and Review Technique

(PERT), 236, 236 237
program managers, 17, 17 18
Program Management Professional

(PgMPSM) certification, B.2, B.18
progress reports, 14, 398

sample, 113, 408
progressive elaboration, 7, 215 216
projects, 4, 4 10

attributes, 7 8
examples, 4 5
phases, 57 62

Project 2010. See Microsoft Project 2010
project buffers, 235
Project certification

exam, B.15
requirements for earning and

maintaining, B.14
sample exam questions, B.16 B.17

project charters, 94, 147, 147 150
checlist, 148 149
PMBOK Guide information, 148
sample, 149 150, 183

project communications management.
See communications management

project cost management. See cost
management

project files, creating with Microsoft Project
2010, A.17 A.19

project human resource management.
See human resource management
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Project Information dialog box, Microsoft
Project 2010, A.17 A.19

project integration management, 12, 13,
130, 130 133

best practices, 137
change requests, 162 163
deliverables, 130
integrated change control, 161 164
mapping process groups to, 83
monitoring and controlling project work,

159 161
software, 165 166

Project Kickstart, 33
project management, 10, 10 14, 21 34

history of, 27 31
project portfolio management

compared, 18
skills, 22 27
value, 2 4

Project Management Center (website), 32
Project Management Institute (PMI), 19,

23, 29 31
code of ethics, 31 32
Guide to the Project Management Body

of Knowledge, 22 23
OPM3, 19
PMP certification, 30 31
Practice Standard for Work Breakdown

Structure, Second Edition, 187, 188
website, 23, 30

project management knowledge areas, 12,
13, 83

project management offices, (PMOs), 29
project management plans, 151, 151 156

contents, 151 154
sample, 155

project management process groups, 79,
79 84

mapping to knowledge areas, 83 84
organizational standards, 85
methodology, 85 86

Project Management Professional (PMP)
Certification, 30, 30 32

exam structure and content, B.5 B.6
overview, B.1 B.2
preparing for exam, B.6 B.7

requirements for earning and
maintaining, B.3 B.5

sample exam questions, B.10 B.13
tips for taking exam, B.7 B.10
useful formulas for exam, B.9 B.10

project management tools and techniques,
12 14

project organizational charts.
See organizational charts

project organizational structure, 49, 50 51
project planning, 96 98

communications management, 261 272
cost management, 261 272
human resource management, 352 357
integration management, 151 156
procurement management, 466 477
purpose, 79
quality management, 296 298
risk management, 428 449
scope management, 181 196
summary of planning tasks and

outputs, 81
time management, 214 237

project portfolios
creating, sample approach, 19 20

project portfolio management. See portfolio
management

project quality management. See quality
management

project risk management. See risk
management

project scope management. See scope
management

project selection, 135 147
balanced scorecard, 146 147
financial projection methods,

139 144
focusing on competitive strategy and

broad organizational needs, 138
four-stage planning process, 135
problems, opportunities and directives

method, 138 139
project priority, 138 139
weighted scoring model, 144 146

project selection methods, 138 147
project sponsors, 7 8
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project teams
acquisition, 357 359
development, 362 368
performance assessment, 369
team management tools and techniques,

367 370
team-building activities, 364
training, 363 364
virtual teams, 67 68

project time management. See time
management

project web sites, 409 410
PRojects IN Controlled Environments

(PRINCE2), 85
proposals, 475
proposal evaluation, 478

sample, 478 479
PV. See planned value

Q

qualitative risk analysis, 438 447
quality, definition, 294
quality assurance, 295, 298, 299
quality audits, 299
quality control, 299 306

acceptance decisions, 299 300
measurement samples, 306 307
process adjustments, 300
rework, 300
Seven Basic Tools of Quality,

300 306
Quality Is Free (Crosby), 316
quality management, 12, 13, 295 325

best practices, 325
improving project quality, 319 325
mapping process groups to, 84
metrics, 295
quality checklists, 295
quality-control measurement samples,

306 307
quality planning and, 296 298
scope aspects and, 297 298
testing, 313 315
zero defects, 316 317

quality management plans, 296 298
quality planning, 295, 296

R

RACI charts, 353
sample, 356

RAD. See Rapid Application Development
(RAD)

RAM. See responsibility assignment
matrices (RAM)

Rapid Application Development (RAD), 60
rapport, 351
rate of performance (RP), 273
Rational Unified Process (RUP) framework,

85, 199
recognition systems, 368
recurring tasks, Microsoft Project 2010,

A.26, A.27, A.28
recruiting teams. See acquisition under

project teams
Reinke, Josh, 56
reports, Microsoft Project 2010,

A.14 A.15, A.66 A.68
request for proposal (RFP), 475, 475 476

sample, 476
request for quote (RFQ), 475
required rate of return, 142, 142 143
requirements, 179 192, 200 202
requirements traceability matrix, 182

sample, 183
reserves, 260

contingency, 260
management, 260

resources(s), assigning to tasks with
Microsoft Project 2010, A.45 A.49

resource calendars, Microsoft Project
2010, A.60 A.61

resource cost(s), adjusting in Microsoft
Project 2010, A.44 A.45

Resource Form view, Microsoft Project
2010, A.12

resource histograms, 357
Microsoft Project 2010, A.61 A.63
sample, 357, 360
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resource lending, 360
resource leveling, 361, 361 362

Microsoft Project 2010, A.63 A.65, A.67
Resource Sheet, Microsoft Project 2010,

A.43 A.44, A.67
responsibility assignment matrices (RAM),

152, 354, 355
sample, 355

return on investment (ROI), 142,
142 143

reward systems, 368
RFP. See request for proposal
RFQ. See request for quote
Ribbon interface, Microsoft Project

2010, A.7
Richard, Luc, 226
risk, 425, 425 428, 430 447
risk breakdown structure, 432, 432 434

sample, 433
risk events, 436
risk management, 12, 13, 422 450

mapping process groups to, 84
risk management planning, 428 450

analyzing risk, 438 447
best practices, 426
contracts, 449
identifying risk, 434 438
probability/impact matrices,

438 439
risk responses, 447 449

risk management plans, 428,
428 430

risk registers, 436, 436 438
sample, 437

risk register update samples, 442
risk tolerance, 426
ROI. See return on investment (ROI)
rolling wave planning. See progressive

elaboration
Ross, Jeanne, 55
RP. See rate of performance (RP)
runaway projects, 432
run chart, 302, 302 303

sample, 303
RUP. See Rational Unified Process (RUP)

framework

S

Salt Lake Organizing Committee, 160
Sanderson, Peter, 471
Sarbanes-Oxley, 63
saving files, Microsoft Project 2010, A.24,

A.52
scatter diagrams, 303

sample, 303
schedule control, 237 239
schedule development, 223 237
schedule performance index

(SPI), 275
Schedule Table view, Microsoft Project

2010, A.12, A.40 A.42, A.67
schedule variance (SV), 275
scheduling, 213 214

critical chain, 233 236
in Microsoft Project 2010,

A.24 A.25
Schlumberger, 278
scope, 8, 12, 13

defining, 183
scope baseline, 196
scope control, 198 199
scope creep, 197
scope management, 12, 13, 178 204

best practices, 199
mapping process groups to, 83
Microsoft Project 2010, A.17 A.24

scope management planning 179 196
scope definition, 183 186
work breakdown structure. See work

breakdown structures (WBS)
scope statements, 202, 183 186

contents, 101
sample sections, 101 103

scope verification, 196 198, 198
SDLC. See systems development life cycle

(SDLC)
sellers, selecting, 477 479
Sensation/Intuition (S/N) psychological

type, 364 365
sensitivity analysis, 446 447

sample, 447
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Set Baseline dialog box, Microsoft Project
2010, A.67

7 Habits of Highly Effective People, The
(Covey), 350 351

SharePoint portal, 404
simulation. See Monte Carlo analysis
Six Sigma, 86, 307 312, 364
slack, 228, 230
slipped milestones, 227, 227 228
SMART criteria, 226
smoothing mode, 400
Sobey s, 48
Social Styles Profile, 366 367
soft skills, 23 25, 382 383, 390, 400 401
software, 28 29, 32 34. See also specific

software packages
business service management (BSM)

tools, 165 166
communications management, 410 412
cost management, 279 280
human resource management, 370 371
procurement management, 481 482
project integration management,

165 166
quality management, 326
risk management, 450 451
scope management, 202 203
time management, 240 241

Software Function Deployment Model
(SQFD), 323

Sorel, Tom, 471
SOWs. See statements of work (SOWs)
SPI. See schedule performance index (SPI)
split window, assigning resources in

Microsoft Project 2010, A.47 A.48
staffing management plans, 356, 356 358
stakeholders, 10, 10 12

analysis, 385 388
identifying and understanding, 92 93
managing, 23 25, 52 53, 93, 368 370,

385 386, 396 398
register, 385
sample communication analysis, 387
sample management strategy, 386

standards, 85
Standish Group, 3 4, 14, 62, 254, 430 432

statements of work (SOWs), 474,
474 475

status reports, 398
Stewart, Branndon, 279
strategic planning, 133, 133 135
Students of Project Management Specific

Interest Group (SIG) web site, 30
success, 3, 14 17
summary tasks, Microsoft Project

2010, A.16
suppliers

qualified sellers list, 478 479
requesting responses, 475

SV. See schedule variance (SV)
SWOT analysis, 134, 435
synergy, 350, 350 351
systems, 45
systems development life cycle (SDLC),

60, 60 61
systems management, 45, 45 46

T

Table: Schedule view, Microsoft Project
2010, A.14, A.67

Taguchi, Genichi, 317 318
task(s)

assigning resources in Microsoft Project
2010, A.45 A.49

numbering using Microsoft Project
2010, A.23

task dependencies, Microsoft Project 2010,
A.30 A.33

Task Details Form view, Microsoft Project
2010, A.12

task durations
entering in Microsoft Project 2010,

A.25 A.30
Task Sheet views, Microsoft Porject 2010,

A.11, A.12
TAT. See Thematic Apperception Test

(TAT)
teams. See project teams
team contracts, 99

sample, 100

I.14

Index

      Copyright 2011 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). 

Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Licensed to:



Team Planner feature, Microsoft Project
2010, A.65 A.66, A.67

templates, 118 121, 406 410
testing and quality control, 313 315
Text Styles dialog box, Microsoft Project

2010, A.37
Thamhain, H. J., 348. See also influence

bases
Thematic Apperception Test (TAT), 347
Theory of Constraints (TOC), 233, 236
Theory X, 347
Theory Y, 347
Theory Z, 347 348
Thinking/Feeling (T/F) psychological

type, 365
three-point estimates, 223, 236
time-and-material contracts, 472
time management, 12, 13, 213 242

mapping process groups to, 83 84
Microsoft Project 2010, A.24 A.42

time management plans
activity definition, 214 217
activity duration estimation, 222 223
activity list and attributes, 215
activity resource estimation, 221 222
activity sequencing, 217 220
best practices, 226
critical chain scheduling, 233 236
critical path analysis, 228 233
milestone list, 225 226
network diagrams, 218 220, 228
schedule development, 223 237

TOC. See Theory of Constraints (TOC)
toolbar, assigning resources in Microsoft

Project 2010, A.46 A.47
top-down approach to WBD development,

192 193
top-down estimates, 263
Top Ten Risk Item Tracking, 441 442
Total Quality Management (TQM), 308, 323
TRAC, 66
tracking Gantt charts, 226 228

Microsoft Project 2010, 27,
224 225, 240

Tracking Table view, Microsoft Project
2010, A.12

Tracking toolbar, Microsoft Project 2010,
A.52

training project teams, 363 364
triggers, 437
Trilogy project, 216
triple constraint, 8, 8 10
Tuckman model, 363

U

U. K. National Health Service, 255
U. S. Air Force, 294, 467
U.S. Defense Finance and Accounting

Services (DFAS), 146 147
U. S. Department of Defense (DOD), 191
U. S. National Aerospace Plane (USAP)

project, 446
uncertainty, 8, 9
unit pricing, 472
unknown unknowns, 260
Update Tasks dialog box, Microsoft Project

2010, A.53, A.55
updating critical path data, 233
user input, 200

V

VCS web site, 32
Venue Integrated Planning

Schedule, 160
Visual Reports dialog box, Microsoft

Project 2010, A.59
VoIP, 6
VPMi Express, 32, 33

W

Wal-Mart, 463
Walt Disney Imagineering, 229
Walton, Jane, 278
WBS. See work breakdown structures
WBS dictionary, 194, 194 196
WebEx, 66
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web sites
communications management planning,

389 396
weighted scoring model, 144, 144 146

sample, 144
Weill, Peter, 55
wikis, 404, 404 406
Wilemon, D. L., 348. See also influence

bases
Williams, David J, 216
Wilson Learning Social Styles Profile,

364, 366
withdrawl mode, 400
Work and the Nature of Man

(Herzberg), 346
work breakdown structures (WBS), 57,

8, 104, 153, 186 196, 202, 353 354,
388, 432

developing, 191 196

sample, 105, 188 189
WBS dictionary, 194 196

work packages, 153, 188, 188 189
workarounds, 450
Workload Reports, in Microsoft Project

2010, A.67
World Trade Center, 53 54
Wyatt, Kerryann, 402

X

XPlanner, 65

Z

zero defects, 316 317

Index
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